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About This Guide
The STEP'n'design User Guide contains information about the STEP’n’design component.

The guide assumes that users have:

l A working knowledge of InDesign

l A working knowledge of the STEP workbench

l A working knowledge of STEP Flatplanner (if using this component)

l A working knowledge of STEP AutoPage (if using this component)

l An assigned STEP user name and password in order to connect to the STEP database

Note: The guide only contains information about the STEP’n’design component. For more information about
STEP, see the STEP User Guide and theOnline Help. For more information about Flatplanner, see STEP
Flatplanner User Guide. For more information about AutoPage, see STEP AutoPage User Guide.

About STEP’n’design
This section provides general information about the STEP’n’design plug-in and how it is used in connection with
Adobe InDesign, the STEPWorkbench, STEP Flatplanner, and STEP AutoPage components.

Note: Supported versions of Adobe InDesign are CS6, CC 2015 (CC11), CC 2015.4 (CC11.4.0, June 2016
release), and CC 2017.

Businesses producing printed collateral—including catalogs, brochures, and sales flyers—face a rapidly changing
set of challenges in producing frequent publications, often for multiple brands. In addition, complexity has
increased with the requirement for marketing in multiple languages, price versions, and to specific customer
segments. The final challenge—creativity in page design, even for themost unadventurous product ranges—is a
must if a promotion is to catch the attention of the customer.

Using STEP’n’design allows you to connect to the STEP database and work with InDesign documents as
dynamic documents, greatly simplifying (and even fully or partially automating) the production of printed collateral.
The benefits of using STEP'n'design include:

l Use of pre-built InDesign page layout templates that can be used repeatedly ('create once, usemany')

l Instant availability (via STEP) of text, tables, and images for placement ('mounting') on pages

l Ability for creative users to access content in STEP without having to log in to the workbench (all tasks can
be performed fromwithin InDesign, including picking up pages asworkflow tasks)

l One-click capabilities to update previouslymounted pageswith the latest content updates fromSTEP (for
example, updates to prices, product availability, andmarketing text)

l Ability to write data frommounted pages back to STEP

l Ability to save InDesign documents to STEP, not onlymaking the documents available to users in multiple
geographical locations, but bringing information about product placement and space usage into STEP that
can later be used for data export and reporting purposes

l Ability to dynamically create indexes and tables of contents
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l Integration with publishing workflows, easing communication between departments in production
environments (only available with the Flatplanner and STEPWorkflow components)

This documentation assumes that users have a basic understanding of STEP and a working knowledge of
InDesign. Instructions on how to use InDesign itself are outside the scope of this documentation, except where
required to explain how InDesign's standard functionality interacts with the STEP'n'design plugin.

Topics covered in this documentation include:

l STEP'n'design template creation

l Mounting (paginating) pages

l Saving Documents to STEP

l Index generation

Though the STEP Flatplanner and STEP AutoPage publishing components arementioned in various places
throughout this documentation / user guide, full details of these components are covered in their own sections:

l STEP Flatplanner user guide
l STEP AutoPage user guide

Additionally, limited STEP'n'design functionality—including print on demand—is available in theWebUI. For more
information, see theSTEP Publishing Web UI section of theWeb User Interfaces documentation.

Mounting (Paginating)
STEP’n’design provides creative users with a view of text, tables, and imageswithin STEP. Mounting of product
data can be done by dragging and dropping objects from the STEP Structure View palette onto the InDesign
page. More information on this palette is available in theSTEP Structure View topic.

Templates
To reduce the time needed to build pages, ensure style consistency, and improve accuracy, STEP’n’design
enables you to create templates to roughly plan the page layout beforemounting.

For more information, see the Templates in STEP'n'design topic.

Saving Documents to STEP
Another feature in STEP’n’design is the ability to save InDesign documents back to STEP. Both templates and
finalized documents can be saved to STEP. The advantages of saving documents back to STEP include:

l They become visible in STEP

l It is possible to see which pages a product is used on and how much space it uses on themounted page

l It is possible to reuse product layouts

l It is possible to create indexes

For more information, see the following topics:
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l Storing and Editing Product Templates

l Storing and Editing Publication Templates

l Saving Finalized InDesign Documents to STEP

Updating Documents and Writing Back Data to STEP
A key feature in STEP’n’design is the ability to update previously created page(s) with the latest content changes
fromSTEP. This functionality allows the page-building process to begin even when product data is not yet
complete or approved. The update featureswithin STEP'n'design ensure that the contents of your pages always
match the corresponding content in STEP.

You can also work the other way around and update the STEP database with the latest changes from content on
your mounted pages.

For more information about updating documents and writing information back to STEP, see the following topics:

l Updating Documents From InDesign

l Updating Documents From theWorkbench

l Writing Data Back to STEP

Creating Indexes
Because STEP’n’design enables documents to be saved back to STEP with page numbers, publication indexes
can be created by using the STEP Export Manager to export the indexwords in an XML file. The file can then be
imported into InDesign to create an index, as pictured in the below screenshot. For more information, see the
Creating Document Indexes topic.
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Publications and Versions
Because STEP can storemultiple 'views' of the same data in different contexts and workspaces, STEP'n'design
allows for these different contexts to be represented in publications by versions. Versions aremodeled around
specific language and country views of data. Versions can also be created to support currency zones, vertical
markets, or types of catalog. Individual publication versions are typicallymounted on separate layers within the
STEP'n'design document (publication template, or mounting page).
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The advantages of using different versions and layers include:

l Viewing proof views of individual layers

l Savingmoney on printing costs by using 'fifth black' plate change (placing all black textual content on
different layers with all images on a single layer)

For more information about creating versions, see thePublication Versions topic in thePublication
Maintenance documentation. For more information about working with versions, see theWorking With Version
Layers topic.

Publishing (Flatplanner) Workflows
Publishing workflows—known asFlatplanner workflows—can be implemented on systems that utilize both the
STEP Flatplanner and STEPWorkflow components. Flatplanner workflows enable creative staff to pick up
workflow tasks—in the form of Flatplanner planned pages—fromwithin InDesign. Flatplanner workflows link
together all of the tasks involved in the process of planning and approving the pages that comprise Flatplanner
publications. In addition, these workflows greatly ease and streamline communication between different
departments in production environments.

For more information about Flatplanner workflows, see the Flatplanner Workflows section of the Flatplanner
documentation.
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Installing STEP’n’design
This section contains information about installing the STEP’n’design plug-in(s) on your local computer and logging
on to STEP fromwithin InDesign. This topic assumes the following:

l You have InDesign installed on your computer

l You have been assigned a STEP user name and password

l A publication containing at least one publication version has already been created in your STEP system. A
publication version is required to define the workspace and context in which you will be working. For more
information about creating a publication version, see thePublication Versions topic in thePublication
Maintenance documentation.

Installing the STEP’n’design Plug-in
To log onto STEP fromwithin InDesign, youmust first install the STEP’n’design plug-in that is associated with the
STEP system that you are trying to access.

Note: It is strongly recommended that InDesign is closed while you install the plug-in. If InDesign is open when
you install the plug-in, you will need to close and reopen InDesign before the plug-in can be registered.

Once the STEP'n'design plug-in is successfully installed, you will see a STEPmenu option across the top of the
InDesign interface. If you do not see this option, then the plug-in installation was unsuccessful.

The following instructions are written for theWindows platform, but the overall process of downloading and
installing the plug-in is equivalent for Mac users.

1. In your browser, navigate to theWebStart page for your STEP system and locate the STEP'n'design icon at
the bottom of the screen.

2. Click on the 'STEP'n'Design' icon to display the supported plug-ins for your STEP system. The selection of
plug-insmay be different depending on the release version and/or patch level of your system.
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3. Select the plug-in that matches the version and platform of InDesign that you are running. For Windows users,
the plug-in is contained within a .ZIP file. For Mac users, the plug-in is contained within a .dmg file. The file
should download automatically, though the file may download differently depending on your browser settings.
The following screenshot shows how the downloaded .ZIP file appears at the bottom of a browser window in
Chrome.

4. Locate the ZIP file in its download location (such as your Downloads folder or other default download location),
thenmove it into your Adobe InDesignPlug-Ins folder. For Windows platforms, the file path format is as
follows. ('Adobe InDesign CC 2015' will be replaced with the specific version of InDesign that you are using.)

C:\ProgramFiles\Adobe\Adobe InDesign CC 2015\Plug-Ins

5. Unzip the file directly into the Plug-Ins folder. Optionally, you can create your own folder within the Plug-Ins
folder to store the STEP'n'design plug-in (for example, 'STEPplugins'), but this is not necessary.

6. Once unzipped, your Plug-Ins folder should resemble the following. The ZIP file may be deleted at this point,
though it is not required to do so.
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7. The contents of the unzipped file will look as follows. Nothing should be deleted form this folder once unzipped.

For Mac systems, only the two plug-in files will be available; the resources folders will not be present.
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8. After installing the plug-in in the Plug-Ins folder, open your InDesign client to complete the installation process
and log onto STEP.

Logging on to STEP from InDesign
After installing the STEP'n'design plug-in and opening InDesign, you will have the ability to connect to STEP from
InDesign.

1. When InDesign opens, aConnect to DB dialog box displays.

2. In theUsername field, type your user name.
3. In thePassword field, type your password.
4. In theServer field, type the name of the server (STEP database) you want to connect to.

5. If you need to connect to STEP through a proxy server, checkUse Proxy. Once the Use Proxy box is checked,
the fields that are required to connect to the proxy server are displayed (Server, Port, Username, and
Password).

© Stibo Systems - Confidential - STEP Trailblazer 8.2 15



Note: If using http://, by default the systemwill connect using a port number. If SSL is enabled and you are
using https://, then the systemwill connect using a different port number for the same server. For more
information, please contact Stibo support staff.

6. ClickLogon.
7. For first-time logins, a warning dialog displays that saysWarning: Asset path is not set. The error message

will display every time you log in until an asset path is specified in the STEP > Preferencesmenu. ClickOK to
continue.

For information on setting an asset path and disabling this warning, see the Linking to an Asset Location
topic.

8. After clickingOK, theChange Version dialog displays. A versionmust be selected in order to define the
workspace and context to be used.
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9. Navigate to the relevant publication, then click the black arrow to the left of the publication icon to display the
available versions for the publication.

10. Select a version, then clickOK.
11. To use a different display language than that of your publication version for object names and attribute names

in the STEP palettes, choose a context from theDisplay names in context option before clicking OK. This
option allows you to choose a different display context so you can, for example, view all product and attribute
names in English if you are working with a French publication. For more information on this option, see the
Description of the InDesign Interface topic.
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Reinstalling the STEP'n'design Plug-in After System Patches and Upgrades
The STEP'n'design plug-in must be reinstalled every time your STEP system is upgraded and/or every time a
patch is applied to your system that impacts the STEP'n'design component. In these instances, the STEP'n'design
plug-in in your Plug-Ins folder must be deleted and a brand-new plug-in must be redownloaded and installed from
theWebStart page of your STEP system.

If the build level of your STEP'n'design plug-in does not match the build level of your STEP system, you will
receive a warning such as the below after you connect to your STEP server from InDesign:
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Though you will still be connected to STEP after clicking 'OK,' it is not recommended to work with amismatched
plug-in. For example, theremight have been bugs in the system that were fixed with a patch. If your InDesign client
is running an older build of the plug-in that was released before the patch, your systemmay not function properly.

Description of the InDesign Interface
This section contains a description of the InDesign interface, with a focus on the STEPmenus and palettes that
are specific to STEP'n'design. These options are available after you have installed the STEP’n’design plug-in.
(For more information on the plug-in, see Installing STEP’n’design.)
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STEP Menu
The STEPmenu is located in the application bar across the top of the InDesign interface. A number of
STEP’n’design functions are available from the STEPmenu that allow you to perform a range of operations on the
active InDesign page.

Below you will find a brief description of the commands available from theSTEPmenu.

Connect to DB
Use this command to connect your InDesign client to the STEP database. For more information about connecting
to STEP, see the Installing STEP’n’design topic.

Reload
Use this command to reload STEP data to ensure that the current view in InDesign is up to date.
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Change Version
Use this command to change the publication version that you are working in and/or the context in which object
names are displayed in the STEP palettes. A publication version defines the workspace and context fromwhich
mounted data is being pulled fromSTEP. For more information about creating a publication version, see the
Publication Versions topic in thePublication Maintenance documentation.

Display names in context
At the bottom of the Change Version dialog is the 'Display names in context:' dropdownmenu, which allows you to
choose the display language for object names and attribute names in the following STEP palettes: STEP
Structure View, STEP Template Content, STEP Images, and STEP Publication View. See theSTEP'n'design
Multi-Language Support topic for more information.
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Preferences
Launches the STEP Preferencesmenu. SeeConfiguring the STEP Preferences Menu in theSTEP'n'design
documentation for full details on thismenu.
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Template Type
Click to select the type of template that you would like to create. See the Templates in STEP'n'design topic for
more information.
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Update Document Data
Launches theDocument Update dialog. See theUpdating Documents From InDesign topic for information
on this functionality.

Layer Version Update
Use this command to switch context / workspace for an InDesign version layer of your own choice. See the
Working With Version Layers topic for more information.
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Check DB Update
Use this command to check the page against the STEP database and list all the caseswhere a newer version of
the data exists in STEP. For more information, see the Updating Documents From InDesign topic.

Relink Assets
See theRelinking Assets in STEP'n'design topic for information on this functionality.

Cleanup Mount Tags
Use this command to remove STEPXML tags from the XML structure after deleting amounted object from the
page. Not required if you use theUnplace selected object option in the STEP Structure View palette.
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For more information, see theMounting Products topic.

Table Settings
Launches the Table Settings dialog. See theConfiguring Table Styles in Publication Templates topic in the
Tables documentation for more information.

Save Document to DB
Launches theSave Document to STEP Database dialog. Use this command to save your InDesign templates
and page(s) back to the STEP database instead of (or in addition to) storing them only on your local hard drive.
See theSaving Finalized InDesign Documents to STEP topic for more information.
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Writeback to DB
Launches theWriteback to DB dialog. Use this command to write backmounted attribute content from InDesign
to STEP. This feature allows you tomake changes to data on your mounted InDesign page, thenmake the same
change to the data in STEP without having to open the workbench.

For more information, see theWriting Data Back to STEP topic.

Dump Document Data
Use this command to save an XML file containing information about the document, such as context, workspace,
mounted objects, layers, and page information. This file is used for troubleshooting.

STEP Palettes
The STEP palettes / panels are accessed from theWindowmenu on the application bar across the top of the
InDesign interface. For more information, seeSTEP Palettes in InDesign.
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STEP'n'design Multi-Language Support
Adobe InDesign CS6 and CC clients natively support the display of different languages in all menus, dialog
prompts, and panels. The STEPmenu and all STEP'n'design palettes (panels) also conform to these language
changes.

The following languages are currently supported:

l Chinese (zh_CN)

l Danish (da_DK)

l English (en_US)

l Finnish (fi_FI)

l French (fr_FR)

l German (de_DE)
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l Norwegian (nb_NO)

l Portuguese (pt_BR)

l Spanish (es_ES)

l Swedish (sv_SE)

To change the language display within InDesign, two folders that appear within the Presets folder must be
renamed. The typical locations of these folders on aWindows platformwithin the US are:

l C:\ProgramFiles\Adobe\Adobe InDesign CC 2015\Presets\InDesign Shortcut Sets\us_EN
l C:\ProgramFiles\Adobe\Adobe InDesign CC 2015\Presets\InDesignWorkspaces\us_EN

Note: Changing the names of these folders on your computer may require administrator permissions.

In both folders, there should only be a single folder with the language currently being used by InDesign. Simply
rename this folder to the desired language using the Alpha 2 ISO standard shown in the bullet list above. For
example, to view themenu items in Danish instead of English, change the folder names from en_US to da_DK as
illustrated below.
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Restart InDesign and the new language will appear throughout the program and on the STEPmenus. The
following screenshots show examples of STEP'n'designmenus and palettes, in English on the left and Danish on
the right.

l Connect To DB dialog:

l STEPmenu:
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l Window menu, with STEP palettes:

l STEP Template Content palette:
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Changing the Display Language of STEP Objects in InDesign
To display the names of STEP objects in a different language within the STEP palettes (i.e. folders in the product
hierarchy in the STEP Structure View and attributes / attribute groups in the STEP Template Content palette), a
display languagemust be chosen from the 'Display names in context' dropdown on the 'Change Version' dialog
within InDesign (accessed via STEP > Change Version ...).

The 'Display names in context' dropdownmenu allows you to choose the display language for object names and
attribute names in the following STEP palettes: STEP Structure View, STEP Template Content, STEP Images,
and STEP Publication View.
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This feature is intended for users who need to view the names of names of attributes, attribute groups, products,
classifications, entities, and publication hierarchy objects in a different language than that of the publication version
they are currently working with. For example, DTP operators in the US who only speak Englishmay have no
understanding of what objects they aremounting if working in a French publication version and all object and
attribute names are displaying in French in the STEP Structure View palette, as pictured in the following
screenshot.
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To remedy this situation, the English speakers would select 'English US' from the 'Display names in context'
dropdownmenu. The following screenshot shows the same object in the STEP Structure View palette while
working with a French publication version but with English chosen as the display language. The object and
attribute names display in English but the attribute values display in French and the content mounted on the page
is in French.

For more information about creating a publication version, see thePublication Versions topic in thePublication
Maintenance documentation.

Configuring the STEP Preferences Menu
The STEP Preferencesmenu in STEP'n'design contains settings that control much of the behavior of the STEP
palettes within InDesign aswell as how tables aremounted, where hi-res images aremounted from, the location
of product templateswhenmounting pages through 'drag and drop' operations, andmore.
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The Preferencesmenu is accessed by navigating to STEP > Preferences ... from the InDesign application bar
across the top of the InDesign interface.
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The following list describes the settings contained within the Preferencesmenu:

l Multi-place Gap: The distance added here is the distance that STEP’n’design will add between objects when
mountingmultiple objects in the same drag and drop operation.

l Multi drop commit: The number added here is the frequency of mount that should take place before a commit
ismade, whenmountingmultiple objects in the same drag and drop operation.

This option is only intended for use with an InDesign script that enables themounting of many products at one
time. It otherwise serves no purpose to standard users and should always be left as zero (0).

l Structure Tree view options:Controls the visibility of attributeswhen viewing objects in theSTEP Structure
View panel. Options areShow all Attributes in Tree, Show Attributes with Values in Tree, and Don't
show Attributes in Tree. Showing attributes makes them available for pagemounting and for converting
sample documents into product templates.

l The following screenshot shows a sample STEP Structure View withShow all Attributes in Tree
selected:
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l This screenshot shows a sample STEP Structure View withShow Attributes with Values in Tree
selected. This option reduces the number of attributes displayed in the tree, making it easier to locate the
relevant attributes for mounting.
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l This screenshot shows a sample STEP Structure View withDon't show Attributes in Tree selected.
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l Show Tables in Tree:Check this box to display the tables that are linked to products and classifications in the
STEP Structure View panel, thusmaking them available for pagemounting and for converting sample
documents into product templates.
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l Show Asset References in Tree:Check this box to display the STEP asset references linked to Products
and Classifications in the STEP Structure View panel, thusmaking them available for pagemounting and
converting sample documents into product templates.
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l Show ID after name:Check this box to display both object IDs and Names in the different STEP palettes. The
following screenshot shows an example using the STEP Structure View palette.
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l Place in Galley: Selecting this checkbox allows you tomount the contents of a Galley product template into the
text frame of a Galley page template by using drag and drop. This option does not allow themounting of an
entire galley page (including images), which can only be done using STEP Flatplanner. For more information,
see theGalley Product Templates section of the Flatplanner documentation.

l Place in Free Space:Check this box tomake STEP’n’design place your element in the first available free
space on the page when you drag and drop it onto the publication template or mounting page. If not selected,
the object will be placed in the specific location where you drop it.

l Fit Calculated Table Width to Frame Width:Check this box to adjust the width of calculated table columns
(starting with the widest column) until the width is identical to the width of the frame if a table width is not defined
in STEP.

l Process Folder: This is the path in the directory structure in which STEP'n'design stores information. This
folder may contain a number of items: inSTEPLogOptions.xml to control logging and sub-folders for logs
(default destination for logging), tmp (where any temporary files are stored), comms (where communications
trace information is stored for diagnostic), and scripts (JavaScript event handler[s], when applicable). The
systemwill use the default path (C:\Users\[User_Name]\step-dtp\indesign\) if not set by the user.

l Template Path: This is the path to the folder / directory where your product templates are stored.
l Template Cache size: Increases performance when working with templates saved in STEP. Size is defined in
MB and a setting of 2 to 5MB is normally suitable for most users.

l Server Presentation:Defineswhich product template should be used for mounting objects. ChooseNone to
use the product template specified in theSTEP Structure View panel. ChooseProduct default to use the
default product template assigned to the object in STEP. ChoosePublication rules to use the product
template(s) specified by theObject Layout pagination rules specified in STEP.

l Use Default Asset Path: If checked, a default asset push path will be used tomount images. A default asset
path is typically configured by Stibo Systems. Do not check if an Asset Location is specified in the Asset
Location field.

l Asset Location: If a system has been set up to use asset push, then a path to the location of the images is
specified here. This field should be left empty if your system has not been set up to use asset push. If the Asset
Location is left empty, the original image will be downloaded fromSTEP. The asset path will not work for
images stored locally other than the asset push location. See the Linking to an Asset Location topic for more
information.

l Note Layer: (Only relevant for Flatplanner) Type the name of the layer in which the Notes from the Flatplanner
should be shown.

l Note Colour: (Only relevant for Flatplanner) Select a background shading color for Flatplanner Noteswhen
mounted on the InDesign page.

l Don't mount Done Notes: (Only relevant for Flatplanner)Check this box to prevent any Flatplanner Notes
marked 'Done' frommounting on the InDesign page.

l Prompt for Version: Check this box to have STEP'n'design prompt you to select a publication version every
time youmount an object onto a page.
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l Auto Show Version Update: Check this box to automatically show theChange Version dialog box
whenever your version has been redefined in STEP (e.g., if the workspace on a version has been changed
fromMain to Approved).

l Auto Save before save to DB: Check this box to automatically save your documents (templates and actual
pages) locally before saving them to STEP. Since documentsmust be saved locally anyway before they can be
saved to STEP, checking this boxwill eliminate the clicks needed to save the documentsmanually.

l Automatically Relink Assets when Opening Documents:Check this box to enable automatic relinking of
assets when documents are opened that contain broken asset links. Image links become broken when a
document contains images that are no longer linked to the original location of the actual image files, and can
also occur in environments that use amixture of PC andMac platforms tomount InDesign pages. See the
Relinking Assets in STEP'n'design topic for more information.

l SOAP Timeout: Enter a configurable timeout for SOAP (Simple Object Access Protocol) operations in order
to improve performance on slow systems. Default is 900 seconds (15minutes).

l cURL Timeout: Enter a configurable timeout for cURL operations in order to improve performance on slow
systems. Default is 900 seconds (15minutes).

l Export: Click this button to save your STEP'n'design preferences into a text file. This file can be used by Stibo
support personnel to help troubleshoot issues.

Linking to an Asset Location
This topic describes a common setup for users of STEP'n'design when connecting to anAsset Location from
within the InDesign client. The asset location is specified in the STEP Preferences menu in InDesign. Typically,
the asset location contains the path to high-resolution images that have been pushed fromSTEP onto the DTP
(InDesign) server through an asset push event queue.
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In many scenarios, the images on the InDesign server are pushed again from the InDesign server to a local file
location using a third-party file synchronization application such as rsync. But, even when using such an
application, the file path placed into the Asset Location field in STEP Preferencesmust be an exact match to the
file path of the image location on the InDesign server. This ensures that the image links remain unbroken between
themounted pages, the InDesign server, and STEP. (If these links become broken, they can be fixed using the
asset relink features of STEP'n'design. See the next topic in this documentation,Relinking Assets in
STEP'n'design, for information on how to repair broken image links.)

Assumptions
This topic does not cover the following and assumes that the applicable steps have been taken prior to users
connecting to an asset location in InDesign:
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l How to configure Asset Push event queues. For information on Asset Push, see theAsset Push Overview
section of theExporting Data and Images / STEP Asset Push User Guide documentation.

l How to set up an InDesign server. For more information, contact Stibo Systems.

l How to remotely connect to an InDesign server. Themethod of connection will vary depending on your
operating system and server setup. For more information, contact Stibo Systems.

l Alternate ('non-standard') setups for connecting to an asset location, such as connecting to an external
image storage platform such as Scene7. For information on non-standard setups, contact Stibo Systems.

l How to share folders andmap network drives. As these processes are standardWindows andMac
functionality, they are outside the scope of this documentation.

About the InDesign Server
An InDesign server is used in conjunction with STEP for the following Publisher-related capabilities:

l Proof View

l Creating documents via AutoPage

l Flatplanner planned page previews

l Creating documents from a Flatplan via a Flatplanner workflow

l Generating PDFs from documents in STEP

l Including actual pageswhen duplicating publications

l Import of Publication Transfer Packages

l Document-Asset Re-link

An InDesign server is not required for 'standard' STEP'n'design functionality ('drag-and-drop'), as users can
manually create publications by dragging and dropping objects onto pages, thenmanually saving the pages back
to STEP. However, an InDesign server is required to autogenerate pages, and it unlocksmuch of the functionality
of STEP'n'design and its associated components, as listed above.

How the InDesign Server Locates an Image
In a 'standard' setup, asset push will push high-resolution images out to a folder on the InDesign server (though
images can be pushed to any server within the STEP landscape, based on user needs). When the InDesign
server application automaticallymounts pages based on requests fromSTEP, it is 'told' where to locate high-
resolution images by piecing together information that exists in the following locations:

1. dtp-server.properties: This file is located on the InDesign server and contains the 'stem' file path of the image
location, for example, E\:\\step\\assetpush\\images
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2. Asset ID: The ID of the image

3. sharedconfig.properties: This file is located on the STEP application server and contains configuration
entries that tell the InDesign server the ID of the Asset Push Configuration (created in the workbench in
SystemSetup) to use based on the workspace that is currently in use. For this example, the 'DTP Queue'
event queue contains two asset push configurations, 'raw-approved' and 'raw-main.'

Configuration entries in the sharedconfig.properties file point the InDesign server to the appropriate queue.
AssetPush.DTPConfiguration is the default queue to use when the workspace isMain, and
AssetPush.DTPConfiguration.Approved is the default queue to use when the workspace is Approved.
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Note: It is possible to configure these entries to pull images from a different workspace than the publication
version that you are working in. For example, if you need to pull textual content from the Approved workspace but
images from theMain workspace, then raw-main would bemapped to AssetPush.DTPConfiguration.Approved in
the below screenshot, overriding the publication's workspace for images.

The combination of numbers 2 and 3 above (Asset ID plus Configuration ID) enable the InDesign server to obtain
the 'STEP path' of the image. For example, raw-main/00/51/110051.png. The path is the result of the setup of the
Relative Path Template. (For information on the Relative Path Template, see theRelative Path Template
section of theAsset Push documentation.)

When this 'STEP Path' is combined with number 1 above, the 'stem' path, the InDesign server can now locate the
external image by its complete path and file name. For example, E:\step\assetpush\images\raw-approved\00\51.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 47



Setting an Asset Location in InDesign
Whenmounting documents from InDesign, theAsset Location designated in the STEP > Preferencesmenu
should be the same image location accessed by the InDesign server. By default, the Asset Location field is blank.
When logging into STEP fromwithin InDesign, the error message 'Warning: Asset path is not set' displays every
time you log in until an asset path is specified.

To keep this error from appearing, a path to the high-resolution imagesmust be specified in the Asset Location
field.

Important: Though acceptable for testing purposes, the Asset Location field should never be left blank in an
actual production environment.

Determining the Asset Location
In order to connect to an asset location, youmust first know what file path to enter. The following section describes
a typical scenario in which images are located on aWindows InDesign server and the high-resolution assets have
been pushed fromSTEP into a file location on this server by use of an asset push event queue.

Instructions for Mac users are nearly identical to those for Windows except for Mac file path formats and specifics
of how to share folders on aMac operating system.

Shared File Location
On any file location where images are stored, the folder containing the imagesmust first be shared with users
before they can connect. This section assumes that your image folder has already been shared. As the steps to
share a folder are standardWindows functionality, they are not outlined in this topic.

The following screenshot shows a sample 'images' folder hierarchy containing images that have been pushed
from themain and approved workspaces in STEP (raw-main and raw-approved, respectively). To determine the
correct path to enter into theAsset Location field in the STEP Preferencesmenu:

1. On the InDesign server, navigate to the shared 'images' folder that contains the high-resolution assets pushed
fromSTEP by asset push.

2. Right-click on the 'images' folder and selectProperties from themenu.

3. In the 'images Properties' dialog, click on theSharing tab. TheNetwork Path: that is displayed in the
'Network File and Folder sharing' area is the location that should be specified in the Asset Location field.
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4. Instead of directly typing this location into the Asset Location field, however, youmust first connect to this
location bymapping a network drive to the network path. In the above screenshot, the path is \\STEP-
DTP\images.

(Instructions on how tomap to a network drive are not included in this topic, as it is standardWindows
functionality.)
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5. Once the network drive ismapped, go to STEP > Preferences... in InDesign.
6. Click the ellipsis button (…) next to theAsset Location field.

7. In the 'Select a Folder' dialog, navigate to the 'images' network drive that you just mapped in step 4.

8. The path to the high-resolution images on the InDesign server is now present in the Asset Location field. In this
example, since the path is amapped network drive, only the letter of the drive name displays.

Default Asset Path
A default asset path can be set in InDesign that allows users to connect to a client-specific asset location that
overrides the default asset push location defined in the sharedconfig.properties file (the queues pointed to by
AssetPush.DTPConfiguration and AssetPush.DTPConfiguration.Approved).

To set a default asset path, theAssetPush.DefaultDTPClientAssetLocation propertymust be inserted into the
sharedconfig.properties file, followed by the asset location, as such:

AssetPush.DefaultDTPClientAssetLocation = \\\\server/images/AssetPush_highres

If a default asset path has been set in the sharedconfig.properties file, then users should leave the Asset Location
field blank in the STEP Preferencesmenu and instead check theUse default asset path box. (If no default asset
path has been set up in sharedconfig.properties file, even if this box is checked, it will be exactly as if no image path
at all is set up.)
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Note: Default asset path cannot be used for production environments that use amix of PC andMac clients. The
environment must be either all PC or all Mac.

STEP Palettes in InDesign
TheSTEP Palettes are used for actual mounting of STEP data, including template composition and image
mounting. Six InDesign palettes (also known aspanels in InDesign terminology) are used with STEP'n'design:

l STEP Structure View

l STEP Template Frame

l STEP Template Content

l STEP Images

l STEP Tasks (Flatplanner only)

l STEP Publication View (Flatplanner only)
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The STEP palettes are accessed from theWindowmenu in InDesign (accessed from the InDesign application
bar across the top of the InDesign interface) and function like any other panels in the InDesign interface. For
example, they can be docked, stacked, resized, and collapsed.

Details on each STEP’n’design palette are addressed in the following sections of this documentation.

STEP Structure View
TheSTEP Structure View InDesign palette (or panel, in InDesign terminology) is used primarily to mount
product and classification objects to InDesign pages, though asset references and attributesmay also be
mounted. Other STEP hierarchiesmay also be accessed here if needed (for example, entities).

The STEP Structure View is essentially amirror of the Tree in the workbench. It allows InDesign (DTP) users to
access contents of the workbench fromwithin InDesign without having to log in to the workbench.
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Most of the work in STEP’n’design is carried out from the STEP Structure View, as products and other objects are
dragged from the Structure View tree onto InDesign pages.

Accessing the STEP Structure View
The STEP Structure View is accessed by navigating toWindow > STEP Structure View from the InDesign
application bar across the top of the InDesign interface.
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Navigation and Search in the STEP Structure View
The STEP Structure View can be navigated by browsing or searching. To browse, hierarchiesmay be expanded
and collapsed by clicking on the arrow signs to the left of the hierarchy levels. To search, click on themagnifying
glass search icon in the lower left corner of the panel to display theSearch dialog. (The Search dialog can also be
accessed by clicking theOptions dropdown arrow in the upper right corner of the panel.)
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TheSearch dialog enables typeahead and filtered searches in the STEP Structure View. Searches are
performed byName or ID. Searchesmay be filtered by one or more of the following object types: Product, Asset,
Classification, Publishing hierarchy, and Entity. Search is not enabled unless at least oneObject Types checkbox
is selected in the Search dialog.

Searches in the STEP Structure View may also be limited to a specific level (node) of a hierarchy by using the
Search below option.Search below is accessed through a right-click action on the chosen node.
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Configuring Character Minimums for Search
By default, typeahead searches begin when the first character is typed into the search field, and searches using
Search below have a three-character limit before typeahead search results will populate. To change these
settings, the following two configurations can be added to the inSTEPLogOptions.xml file:

<dtpDynamicConfig name="typeaheadSearchLimit" value="2" />

<dtpDynamicConfig name="typeaheadSearchBelowLimit" value="2" />

The first configuration sets the number of characters that must be entered before overall search results display.
The second configuration serves the same purpose for 'search below' results. For more information on the
inSTEPLogOptions.xml file, see the IDS Logging topic in theAdministration Portal documentation.

Additional Features of the STEP Structure View Panel

l Publication Hierarchy: Templates and actual pages that have been saved back to STEP can be opened for
editing from the Publication hierarchy. To open a template or actual page, right-click on the document and
selectOpen Document from themenu.

l Template dropdown list:Whenworking with local product templates (as opposed to using the Default
Template functionality), product templates are selected from this list. This list is populated by the product
templates that are saved into the folder specified in the Template Path in the STEP Preferences menu. See
theConfiguring the STEP Preferences Menu section of theSTEP'n'design documentation for more
information.
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l Image display area: Appears directly below the Template dropdown list. If the selected object is referenced to
a Primary Image, a thumbnail of the image will be displayed in this area. (When an attribute is selected in the
Structure View, its value appears here.)

l Scaling dropdown list: Appears in the lower left corner of the panel. Options in this list define the following
settings for the scaling of your element whenmounting attributes or asset references:

l Width: Sets the width of the text or image framewhen dragging an attribute or asset reference directly
onto a page (not into an existing frame)

l Height: Sets the height of the text or image framewhen dragging an attribute or asset reference
directly onto a page (not into an existing frame)

l Scale: Applies to images only, both when creating a frame (dragging directly onto the page) or
dragging into an existing frame. Enables you to apply a scaling factor (such as 90%) for an image. The
scaling factor will be applied to the image’s original (actual) size.

l Number of columns:Makes the text or image frame conform to the width of one or more columns
within your active document when dragging an attribute or asset reference directly onto a page (not
into an existing frame)
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l Fit to destination:Causes an image reference to scale (up or down) to fit the existing frame that it is
dragged into

l Status bar:Displays the name and version of the publication you are currently working with. For example,
'SpringWedding Catalog / English US'

Options Menu
TheOptionsmenu in the STEP Structure View is accessed by clicking in the dropdown arrow in the upper right
corner of the panel. It contains the following commands:

l URL:Use this option to enter a STEP URL pointing to a node in STEP. This way you can easily navigate to a
specific node without browsing through the Structure View.

l Search: Click to access the Search dialog
l Show mounted items:Use this option to highlight mounted items in the STEP Structure View tree

l Refresh mounted items:Use this option if you havemountedmore items (after using the Show mounted
items option) and want them to be highlighted aswell.

l Open document:Use this option to open an InDesign document saved in STEP (youmust select the relevant
document in the STEP Structure View first).

l Refresh template list:Use this option to update the product template list in the STEP Structure View.

l Clear template document type: Select this to change a template document to a standard InDesign
document. A Save As dialog will appear, prompting you to save the document as a new document. The original
template document will not be affected unless you save the new document over it with the same name.

Place Options
The options available in thePlace sub-menu enable you to set a range of parameters for themounting process, as
follows. These options are also available in amenu that appears when right-clicking on a selected object in the
STEP Structure View palette tree.
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l Snap to Column:When selected, an item dropped on an InDesign page will align itself with the nearest inside
column edge to the left of the object.

l Place in Galley:When selected, STEP’n’design will place your galley text in the same framewhenmounting
products (without using STEP Flatplanner). Option is disabled if Place in Free Space is selected.

l Place in Free Space:When selected, STEP’n’design will place your object in the first available free space on
the page, rather than placing it in the specific location where it is dropped. Option is disabled if Place in Galley
is selected.

l Unplace selected object:Use this option to unmount the object selected in the STEP Structure View tree.

l Replace selected object with template selected: Use this option to recompose / reset themounted object
according to the selected product template. Use this option if, for example, you havemanually changed the
appearance of amounted object on the page, but then decide to return to the original layout.

l Page Sel is part of Mount of Tree Sel: (Only relevant for Flatplanner)Use this option if you have items on
the page that are not part of the product template (e.g., standalone graphics that do not exist in STEP), but you
want them to be included when using a Pickup Page Layout operation in STEP Flatplanner.

Selection Options
The options available in theSelection sub-menu enable you to perform a range of operations on the element that
you have selected on your InDesign page. These options are also available by right-clicking on a selected image
frame or right-clicking within the text frame of amounted object.
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l Go To Page Selection in Structure view:When selected, the element you have selected on the page will be
shown in the STEP Structure View tree.

l Go To Page Selection in Workbench:When selected, the element you have selected on the page will be
shown in STEPWorkbench (this requires that STEPWorkbench is already running on your computer).

l Go To Structure Selection in Workbench:When selected, the element you have selected in the STEP
Structure View will be shown in STEPWorkbench (this requires that STEPWorkbench is already running on
your computer).

l Update Page Selection:When selected, the element you have selected on the page will be updated with the
latest value fromSTEP.

l Write Page Selection back to DB:When selected, the value you have selected on your page will be written
back to the attribute in STEP (privilege restrictions apply).

STEP Template Palettes
The two STEP template palettes—STEP Template Content andSTEP Template Frame—are used primarily
to create product templates in InDesign. These palettes (also known as panels in InDesign terminology) are
where elements fromSTEP—including attributes, asset references, and tables—are linked to InDesign pages in
order to build mounted pages in conjunction with publication templates. The STEP template palettes can also
be used to link these same elements to page templates and publication templates, though this is less common.

The two template palettes are detailed in the following sections of this documentation—STEP Template Content
andSTEP Template Frame.

STEP Template Content
TheSTEP Template Content palette (or panel, in InDesign terminology) is used primarily when creating
product templates in InDesign. The STEP Template Content palette is where elements fromSTEP—including
attributes, asset references, and tables—are linked to frames on InDesign pages in order to build mounted pages
in conjunction with publication templates. The STEP Template Content palette can also be used to link these
same elements to page templates and publication templates, though this is less common.
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The options on the STEP Template Content palette are used to assign the contents that go inside of frames on
InDesign templates, as opposed to theSTEP Template Frame palette, which contains the options that control
the behavior of the frames themselves.

The STEP Template Content palette can also be used to apply asset references to entire image frames, though
themajority of the settings that control the behavior of the images are applied on the STEP Template Frame
palette.

Sections of the STEP Template Content Palette
The STEP Template Content palette is composed of three panel divisions.

1. The top panel contains an attribute tree that mirrorsmany of the contents of theSystem Setup tab in the
workbench. It allows InDesign (DTP) users to access contents of the workbench fromwithin InDesign without
having to log in to the workbench. The available options vary by template type. The below screenshot shows all
available folders for product templates. Whenworking with publication templates, only the Attribute Groups
andObject Properties folders are available. For page templates, the Attribute Groups, Object Properties, and
Reference Types sections are available. (See the 'STEP Template Content Tree' section of this topic below for
more information on these folders.)

2. The bottom panel contains the parameters that can be applied to content within the frames on the page. These
options are the same regardless of what template type is being worked with.

3. The bottom bar contains the search icon and an indicator to explain what template type is currently being
worked with.

Accessing the STEP Template Content Palette
The STEP Template Content Palette is accessed by navigating toWindow > STEP Template Content.
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Navigation and Search in the STEP Template Content Palette
The STEP Template Content palette can be navigated by browsing or searching. To browse, hierarchiesmay be
expanded and collapsed by clicking on the arrow signs to the left of the hierarchy levels. To search, click on the
magnifying glass search icon in the lower left corner of the panel to display theSearch dialog.
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TheSearch dialog enables typeahead and filtered searches. Searches are performed byName or ID. Searches
may be filtered by one or more of the following object types: Attribute Group, Attribute, Table Types, Reference
Types, and Commercial data lists. Search is not enabled unless at least oneObject Types checkbox is selected in
the Search dialog.

Configuring Character Minimums for Search

By default, typeahead searches begin when the first character is typed into the search field. To change this setting,
the following configuration can be added to the inSTEPLogOptions.xml file:

<dtpDynamicConfig name="typeaheadSearchLimit" value="2" />

This configuration sets the number of characters that must be entered before search results display. For more
information on the inSTEPLogOptions.xml file, see the IDS Logging topic in theAdministration Portal
documentation.

STEP Template Content Palette Tree
The tree in the top panel of the STEP Template Content palette mirrorsmany of the contents of theSystem
Setup tab in the workbench, but also has additional entries that are specifically for template creation.
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Descriptions of each folder and its contents are as follows:

1. Attribute Groups: Expand the top-level Attribute Groups folder to see all attribute groups in STEP.

l Expand the attribute folders to access individual attributes.

2. Object Properties: This folder contains non-attribute elements that can bemounted on InDesign pages.
Each option is described in the bullet list below.
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l Asset Content: Typically used in conjunction with the 'Data Source' setting (on the STEP Template Frame
palette) to mount referenced image assets. Some examples of when this tag (stibo.asset.content) is used
include: an image frame that will displaymultiple images from amulti-valued asset reference; an image
frame that is intended to tile across the page when displayingmultiple images; or for image frames that are
grouped with text frames tomount imagemetadata captions. For more information, see theSequencing
Images in InDesign topic.

l Attribute value:Usedwhenmounting attribute groups. See theMounting Multi-Valued Attributes and
Attribute Groups topic for more information.

l Export data:Used on product templates in AutoPage publications to include indexmounting as part of the
autopagination process.

l Keyletter: Used to create Galley page templates. See theGalley Templates section of the Flatplanner
documentation for more information.

l Object ID:Used to display the STEP ID of the object beingmounted.

l Object Name: Used to display the STEP Name of the object beingmounted.

3. Commercial Types:Used tomount the following information from a selected commercial terms list: Maximum
Quantity, MinimumQuantity, Unit, and Value. Note that a Price Number must also be designated in the tag
whenmounting commercial data. For more information, see theMounting Commercial Data topic.
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4. Table Types:Used to add tags to text frames on product templates that will mount tables of the selected table
type.

5. Reference Types:Most commonly used with image frames tomount asset references, though tags for other
reference types can also be placed onto templates from here: product references, classification references,
and entity references.
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STEP Template Content Palette Parameters
The parameters available on the lower half of the STEP Template Content panel are as follows:

l Context:Use this option tomount textual content from a specific context in STEP. If left empty (which is the
default, andmost common setting), the systemwill mount data from the selected publication version onto the
page instead. One example for the use of this setting would be if your publication version is English but there are
one-off instances in your document where you need tomount the same attribute twice on the page but in a
different language, e.g. a product name should appear on the same page in both English and French, even
though the version for the entire publication pulls from an English context.

l Object: This dropdown contains three options—'Asset Reference,' 'Product Reference,' and 'Template section
object'. The default selection is Object. When Asset Reference or Product Reference is selected, the dropdown
field to the right is activated, enabling you to select the relevant asset reference or product reference from the
list.

l Delete Before + Delete After: If a mounted attribute is empty, STEP’n’design can be configured to remove a
number of characters either before or after the location where the attribute should have been placed. This is
especially useful if there are characters that should not be on the page when themounted attribute is empty.

For example: You want your page to display 'Special Offer: [PromoPrice] this week only'. If your database does
not contain a value in the 'PromoPrice' attribute for the product you aremounting, you do not want these text
strings before or after the attribute.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 67



By using theDelete Before andDelete After functions, you can eradicate them.

For this example, setting aDelete Before value of 14 will delete the 14 characters of the 'Special Offer:' string.
Setting aDelete After value of 15 will delete the 15 characters of the 'this week only' string.

Note: In most cases you do not need to count the exact number of characters to delete, as delete before / after
will not delete another attribute reference. In addition, these delete options only take effect if there is no value
for the attribute.

These options should also be used even if there is no free text before or after a value but you need the frame to
disappear if there is no content. Using a value of DB = 1 or DA = 1will remove any 'stray' XML tagging that
appears on the page if there is no content in STEP and ensures that the text frame itself will disappear when
Delete NoContent is applied to the entire frame.

l Fail Text: If an attribute does not contain a value for the product you aremounting, you can use this field to
insert text that should appear on the page instead of a blank space or frame. This field is typically used for text
replacement strings such as 'Not Applicable', 'N/A', 'Call for details', 'None', etc. A Fail Text value can also be a
blank space or an invisible character. If an attribute is empty and does not have a Fail Text configured, the
attribute will appear on the page as a STEP XML tag (unlessDB or DA values also have been configured; see
above for more information).

l Price Number: Used to designate which price break (price number) should bemounted from the values of a
commercial terms list.

l Transformation: Used to apply an attribute transformation to an attribute when beingmounted onto the
InDesign page. The STEP Name (not ID) of the transformationmust be typed into this field for it to take effect.
The name of the transformation is case sensitive. Themost common types of attribute transformations used
here are those that transform text values into images.

l Repeat Separator:This option is used in conjunction with the repeat area (STEPREPEAT) function aswell as
multi-value attributes. If not set for amulti-value, then themultisep tag (Character Tags under SystemSetup >
Tags) from the database is used.

The Repeat Separator value is a string, which is set in by STEP’n’design every time a 'Repeat Selection'
operation is performed. Often, the repeat separator is used to put in a new line character between the individual
attribute rows. In that case, the Repeat Separator is the InDesign character for new line \n.

Available Right-Click Options Inside Text Frames
Two right-click options are available for highlighted text inside of a text frame—Apply Condition to Selection
andRepeat Selection.

Though the STEP Template Content is not used to access these options, they are detailed in this topic because
they involve the setting of parameters on content inside of frames.
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Apply Condition to Selection

This option becomes available when at least one STEPXML tag is highlighted inside a text frame by using the
InDesign Text tool. Once highlighted, you can apply parameters such asDelete Before / Delete After and Fail
Text to the group of attributes at one time. Once the attribute tags are selected and the parameters chosen, click
Apply Condition to Selection to apply the selections to all the attributes at once.

When the tags are selected, right-click to display theApply Condition to Selection dialog.
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In the following screenshot, several tags have been selected and ‘1’ has been entered for Delete Before and
Delete After. If a value is entered for Delete Before or Delete After, the Fail Text field will be deactivated, as the
two options aremutually exclusive. Likewise, if content is provided for the Fail Text field, then Delete Before and
Delete After will be deactivated. If fail text appears when an attribute value is empty, there is nothing to delete.

ClickOK to see that as STEPCOND tag is now added to surround the grouping of attributes to which a DA and
DB setting of 1 should be applied:

Delete Before, Delete After, and Fail Text
Configuring these options here is identical to configuring them on the STEP Template Content palette for text. See
the STEP Template Content Palette Parameters section of this topic above for more information.

Condition requires all
Check this box if you need everything in the frame tomount. This essentiallymeans that themounting of content
inside the frame is 'all or nothing.' If the value of one of the attributes is empty, then nothing will mount here, and
the entire framewill be removed. Ticking this boxwill add the 'RA' (Requires All) abbreviation inside the
STEPCOND tag.
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Repeat Selection

If attributes, asset references, tables, or any other values from child objects of a parent must bemounted, the
repeat functionSTEPREPEAT is used.

When a product ismounted in STEP'n'design, only attributes from themounted object itself appear on the page. In
instances of product families, for example, STEPREPEAT is used to call out information that lives on child
products of the family.

The repeat function takes effect in the caseswhere you aremounting a product family with one or more child
products. Using the repeat function, you canmake STEP’n’design place specific attributes of the child products
into the page in 'repeat-mode', whichmeans that if you have children within the product family, you can have the
values for all childrenmounted as youmount the product family level. Effectively, this function can enable you to
display data for multiple products in a tabular way, without having to create a table in STEP.

As an alternative to creating a table in STEP, you canmake a range of attributes repeat for any sub-products to
the product beingmounted. This will enable you to create a simple, table-like structure on your InDesign page
where every sub-product has its own row.

Note: Amore complex presentation is to build a STEP table, as this providesmore complex formatting options.
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For more information about the repeat selection option, see theUsing the Repeat Function for Subproducts
topic.

STEP Template Frame
TheSTEP Template Frame palette (or panel, in InDesign terminology) is primarily used when creating product
templates in InDesign. This palette is where settings that apply to entire frames on templates are configured,
such as settings to adjust image scaling and text frame height. The STEP Template Frame palette also has limited
applications for publication templates and InDesign-created page templates, though these uses are less common.

The STEP Template Frame palette is blank until a frame is selected on a template. The options change depending
on what template type is selected under the STEP > Template Typemenu and what type of frame is selected—
text, asset, or grouped.

Accessing the STEP Template Frame Palette
The STEP Template Frame palette is accessed by navigating toWindow > STEP Template Frame from the
InDesign application bar across the top of the InDesign interface.
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STEP Template Frame Palette Parameters
The parameters available for options change depending on what template type is selected under the STEP >
Template Typemenu and what type of frame is selected—text, asset, or grouped.

A range of parameters are set on frames on product templates, page templates, and publication templates from
the lower half of theSTEP Template Frame palette. These parameters control the behavior of elements on the
page when pages aremounted, such as the scaling of text or images tomatch the size of their frames; allowing a
text box or table to split if it reaches the bottom of a column or a page; whether to delete a frame if there is no
content in STEP to populate it; andmanymore.

STEP Template Frame palette parameters differ depending on the type of template being configured and the type
of frame being configured. The following sections of this topic list these parameters and describe their functions.
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Parameters Available for Product Templates

Parameters for product templates in the STEP Template Frame palette are different depending on what type of
frame is being configured on the page: text frame, image frame, or grouped frame. As the list of parameters
available for each is extensive, they are covered separately in the followingSTEP'n'design topics:

l Text Frame Parameters in the STEP Template Frame Palette

l Image Frame Parameters in the STEP Template Frame Palette

l Grouped Frame Parameters in the STEP Template Frame Palette

Parameters Available for Page Templates

Only relevant when using the STEP Flatplanner component, and primarily used for Galley templates. For more
information, see the STEP Template Frame palette topicsmentioned above in the 'Parameters Available for
Product Templates' section and theGalley Templates section of the Flatplanner documentation.

Parameters Available for Publication Templates

Attributes and other framesmay be added to publication templates that are intended for use with theSTEP
Flatplanner or STEP AutoPage publishing components.

Elements added to publication templates from the STEP Template Frame palette are typically text frames that
either display description attribute values (such as page headers) or Product Continuation Notes for
AutoPage publications. Image framesmay also be added to display logos or background images, though this is
less common.

Attribute text frames and image reference frames are configured on publication templates the sameway that they
are configured for product templates.

For more information about adding Product Continuation Notes to publication templates for AutoPage
publications, see theAbout Templates in AutoPage section of theAutoPage documentation.

Options Menu
TheOptionsmenu in the STEP Template Frame palette (arrow in upper right corner) contains one option,Show
Adornments. Use this option to display the STEP ID of the asset reference type assigned to each image frame
on the product template.
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When adornments are not displayed, the asset reference type assigned to a frame can be determined by opening
theSTEP Template Content palette and selecting the frame. The attribute tree will 'jump' to the assigned asset
reference type. For more information on the STEP Template Content palette, see the STEP Template Content
section of this documentation.

Text Frame Parameters in the STEP Template Frame Palette
Below is a description of the individual parameters available when configuring text frames using theSTEP
Template Frame palette in InDesign.
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l Delete No Content: This option can be best understood as 'Delete IF NoContent.' Check this box to ensure
that empty frames do not mount on pages if there is no content in STEP available to populate the text of the
attribute(s) linked to the text frames. This setting ignores static text within the frame. If this box is left unchecked,
the framewill bemounted, either as empty or with the XML references appearing, depending on the settings
placed in 'Delete Before' and 'Delete After' (details on these settings are explained further down in this list).

l Keep With Next:When this option is selected, the selected framewill always remain with the frame directly
below it.. This setting prevents situationswhere, for example, the name of a product would be separated from
its image if the product mounts at the bottom of the page, and there is only enough room tomount the frame
containing the product name.With this box checked, both frameswill mount on the following page in order to
keep the two frames together. A framewithKeep With Next set cannot have aSplit setting ofAnywhere or
Within Spread and vice versa.

l Set Height to Content: Check this box if you want STEP’n’design to automatically adjust the height of your
text frame if the text or table content is too lengthy to fit in the frame at its original size.

l Align mount bottom: Select this to ensure that a text framewill alwaysmount at the bottom of the page. In
Flatplanner, the framewill align to the bottom of the Flatplan frame. If more than one frame is designated to
alignmount bottom, the lowermost framewill align to the bottom and the other frame(s) will mount above it,
separated by the same gap amount as on the product template.

l Split: This option applies to both individual and repeating (tiling) text frames. Three split options are available:
Never,Anywhere, andWithin Spread.
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For individual text frames, these settings control the behavior of frames that are too lengthy to fit entirely in a
column or on a page. This is typically caused by frames that contain lengthy tables, though very large blocks of
text can also cause tall frames. The options are as follows:

l SelectNever to prevent the text box from ever splitting across a column or a page.

l SelectAnywhere to allow the text box to split across columns and pages even if the split results in the
creation of a new spread. I.e., the text boxwill be permitted to split from a right-hand page onto a left-
hand page.

l SelectWithin Spread to limit the split to within a spread only, i.e., only permit the text frame to split
from a left-hand page to a right-hand page, disabling the ability to create a new spread.

Note that a text framewith a Split setting ofAnywhere orWithin Spread cannot haveKeep With
Next set on the frame, and vice versa.

For repeating text frames, these settings control the behavior of frames that have tiled to a point where they
no longer can fit entirely in a column or on a page. This would be caused in instanceswhere, for example,
textual information from numerous child objects aremounted in repeated frames, and there are toomany to fit
in a column or page. The options are as follows:

l SelectNever to prevent the series of repeating text frames from splitting across a column or page if
there are toomany frames to fit in one column or on one page.

l SelectAnywhere to allow the series of repeated frames to split across a column or onto another page,
even if the split continues from a right-hand page to a left-hand page, creating a new spread.

l CheckingWithin Spread to limit the repeated frames to continue from a left-hand page to a right-hand
page only, disabling the ability to create a new spread.

l Data source: This controls whether the frame shouldmount content from the object that is beingmounted
(Mount Object; most common), from children of themounted object (Mount Children), or from an asset or
product linked to themounted object by a reference type. By default, the data source isMount Object, which
extracts values from themounted object only.

SelectMount Children or an asset / product reference type when the text frame is intended to repeat on
the page. The text frame repeats in instanceswhere information is available frommultiple child objects or from
multiple referenced products or assets. WhenMount Children or an asset / product reference type is selected,
the following options are activated in the STEP Template Frame palette: Tile across,Max Distance, and
Gap. If Mount Children is selected, theData Filter option is also activated.
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l Data Filter:Only activated when Data Source is 'Mount Children.' Used whenmounting publication or section
objects to pull information (such asmetadata attribute values or section names) from child sections /
subsections. Available options areSections Only - Sort by Section Name andSections Only - Sort by
Page Number. This functionality is typically used in AutoPage publications to create tables of contents / section
indexes. See theCreating a Table of Contents Product Template topic for more information.

l Tile across:Check this box if repeated frames should be tiled horizontally across the page instead of stacking
vertically beneath one another.

l Max Distance: Themaximumdistance that horizontally tiled frames should repeat across the page (L-R)
before stopping and wrapping back around to begin a new row of repeated frames underneath

l Gap: The amount of space to place between repeated frameswhen tiled horizontally

Text Frame Parameters for InDesign-created Page Templates

The below screenshot shows the available text frame parameters for InDesign-created page templates, which are
only applicable for Flatplanner publications and typically areGalley templates. The options are Frame Type and
Frame ID.

For information on how to use these options, see theGalley Templates section of the Flatplanner
documentation.
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Text Frame Parameters for Publication Templates

A 'Frame Type' dropdown list is available for text frameswhen working with publication templates. These two
options (Product Continuation Note Before Split and Product Continuation Note After Split) only apply to
publication templates that will be used in AutoPage publications. See About Templates in AutoPage in the
AutoPage documentation for more information.

Image Frame Parameters in the STEP Template Frame Palette
Below is a description of the individual parameters available when configuring image frames on product templates
using theSTEP Template Frame palette in InDesign. For information on the parameters available for page
templates and publication templates, see the bottom sections of this topic ('Image Frame Parameters for
InDesign-created Page Templates' and 'Image Frame Parameters for Publication Templates').

l Delete No Content: This option can be best understood as 'Delete IF NoContent.' Check this box to ensure
that empty image frames do not mount on pages if there is no image of the asset reference type linked to the
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mounted product.

l Keep With Next:Check this box to ensure that the selected frame remainswith the frame that follows it
(resides directly below) on the page. This setting prevents situationswhere, for example, the name of a product
would be separated from its image if the product weremounted at the bottom of the page, and there is only
enough room tomount the image frame.With this box checked, both the image and the text box below it
containing the product namewill mount on the following page in order to keep the elements together. A frame
withKeep With Next set cannot have aSplit setting ofAnywhere orWithin Spread and vice versa.

l Align mount bottom: Select this to ensure that an image framewill alwaysmount at the bottom of the page. In
Flatplanner, the framewill align to the bottom of the Flatplan frame. If more than one frame is designated to
alignmount bottom, the lowermost framewill align to the bottom and the other frame(s) will mount above it,
separated by the same gap amount as on the product template.

l Split: (For repeating grouped frames) For repeating grouped frames, the three split options areNever,
Anywhere, andWithin Spread.

SelectNever to prevent a series of repeating image frames from splitting across a column or page if there are
toomany frames to fit in one column or on one page. SelectAnywhere to allow the series of repeated frames
to split across a column or onto another page, even if the split continues from a right-hand page to a left-hand
page, creating a new spread. SelectWithin Spread to only permit the repeated frames to continue from a left-
hand page to a right-hand page, disabling the ability to create a new spread.

l Context: TheContext option allows for the selection of a STEP context fromwhich to select the image. If left
empty, the systemwill mount the image from your version into the page instead. Normally, you will only choose
a specific context here if you are building amulti-versioned document and need to determine exactly which
context goes into a certain layer version. The quickest andmost flexible solution is to leave the context selection
empty.

l Asset Content:Used to assign an asset reference type to the frame.

l Asset Sizing:Dropdown list containing the following options:
l Import Asset at Scale: Image will be scaled according to theScale value entered in the STEP
Template Frame palette. By default, the Scale field is blank, meaning that the image will bemounted at
actual size unless a percentage below or above 100% is entered.

l Scale Asset to Frame: Image will be scaled proportionally until either width or height fit into the box,
unless aMax Scale limit is set (see below)

l Fit Asset to Frame Width: Image will be scaled proportionally until the width is identical to the width
of the frame, unless aMax Scale limit is set (see below)
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l Fit Asset to Frame Height: Image will be scaled proportionally until the height is identical to height of
the frame, unless aMax Scale limit is set (see below)

l Scale:Only active when Import Asset at Scale is selected. Using this option, images can be scaled with a
certain percentage, calculated on the basis of their original scanned size.

l Max Scale: Only active whenScale Asset to Frame, Fit Asset to Frame Width, or Fit Asset to Frame
Height are selected. Max Scale can be set from 5% to 500%.

The ability to constrain the image scale for the frame-fitting options usingMax Scale prevents issueswhere
scaling too high results in a poor image that is not acceptable when printed. For example, if the actual size of the
image in STEP ismuch smaller than the frame to which it is beingmounted, theMaxScale option will prevent
this small image from scaling up to such a large size that its resolution is too low for print.

Note that if the actual size of the image is larger than the frame, it will still scale down to fit the frame, regardless
of whether theMaxScale value is set above 100%. If Max Scale is left blank, imageswill scale up or down to fit
the frame, framewidth, or frame height.

l Size Frame to Asset: Automatically sizes the image frame tomatch the size of the image(s) linked inside. I.e.,
if the imagemounts smaller than the image frame on the product template, the framewill shrink to fit the size of
the image, and vice versa for images that mount at a larger size than the original image frame.

l Asset Alignment:Defineswhether the images should be aligned left, center, or right within the image frame.

l Data Source: This controls whether the frame shouldmount content from the object that is beingmounted
(Mount Object; most common), from children of themounted object (Mount Children), or from an asset or
product reference type. By default, the data source isMount Object, whichmounts the object only.
SelectMount Children or a product / asset reference type when the image frame is intended to repeat on the
page. The image frame repeats in instanceswhere information is available frommultiple child objects or from
multiple referenced assets. When selected, the following options are activated in the STEP Template Frame
palette:Data Filter,Multi Asset Across,Max Distance,Gap, andSplit. (If anything other than 'Mount
Object' is selected for Data Source, the checkbox is labeled Tile Across instead of Multi Asset Across.)

l Data Filter:Only activated when Data Source is 'Mount Children.' Used whenmounting publication or sections
objects to pull information from child sections / subsections. Available options areSections Only - Sort by
Section Name andSections Only - Sort by Page Number. This functionality currently does not exist for
images, but the dropdown exists for image frames in the instance that a future customer needmay arise.

This functionality is typically used in AutoPage publications to create tables of contents / section indexes. See
the Creating Tables of Contents in AutoPage section of theAutoPage documentation for more
information.
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l Multi Asset Across: Is activated when Data Source is 'Mount Object.' When there aremultiple images linked
to a single product using the same asset reference type. this setting allowsmultiple images to be placed inside a
single frame and tiled horizontally. If not selected, the imageswill bemounted vertically.

l Tile across:Check this box if repeated frames should be tiled horizontally across the page instead of stacking
vertically beneath one another. Activated if anything other than 'Mount Object' is selected for Data Source.

l Max Distance: Themaximumdistance that horizontally tiled frames should repeated across the page (L-R)
before stopping and wrapping back around to begin a new row of repeated frames underneath

l Gap: The amount of space to place between repeated frameswhen tiled horizontally

Image Frame Parameters for InDesign-created Page Templates

The below screenshot shows the available image parameters for InDesign-created page templates, which are
only applicable for Flatplanner publications and typically areGalley templates. The options exclusive to page
templates are Frame Type and Frame ID. The remainder of the options (Context, Asset Content, Asset Sizing,
Max Scale, Size Frame to Asset, and Asset Alignment) are identical to those available for product templates.

For information on how to use these options, see theGalley Templates section of the Flatplanner
documentation.

Image Frame Parameters for Publication Templates

Though a 'Frame Type' dropdown list is available for image frameswhen working with publication templates, the
options are grayed out, as they are not applicable to image frames. The dropdown exists, however, in the instance
that it might have a future use if a customer need arises.
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These two options (Product Continuation Note Before Split and Product Continuation Note After Split) only apply
to text frames on publication templates that will be used in AutoPage publications. See About Templates in
AutoPage in theAutoPage documentation for more information.

Grouped Frame Parameters in the STEP Template Frame Palette
Below is a description of the individual parameters available when configuring grouped frames using the STEP
Template Frame palette in InDesign. One common use for grouped frames is to group an image frame together
with a text frame in order to mount a linked asset and ametadata attribute connected to the asset (for example, an
image caption).

l Delete No Content: This option can be best understood as 'Delete IF NoContent.' Check this box to ensure
that the group of frames does not mount on pages if no content exists in STEP for all of the individual frames
included in the group.
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l Keep With Next:Check this box to ensure that the grouped frame remainswith the frame that follows it
(resides directly below) on the page. A framewithKeep With Next set cannot have aSplit setting of
Anywhere orWithin Spread, and vice versa.

l Align mount bottom: Select this to ensure that a grouped framewill alwaysmount at the bottom of the page.
In Flatplanner, the framewill align to the bottom of the Flatplan frame. If more than one frame is designated to
alignmount bottom, the lowermost framewill align to the bottom and the other frame(s) will mount above it,
separated by the same gap amount as on the product template.

l Split: The three split options areNever,Anywhere, andWithin Spread.

SelectNever to prevent a series of repeating grouped frames from splitting across a column or page if there
are toomany frames to fit in one column or on one page. SelectAnywhere to allow the series of repeated
grouped frames to split across a column or onto another page, even if the split continues from a right-hand
page to a left-hand page, creating a new spread. CheckingWithin Spread only permits the repeated grouped
frames to continue from a left-hand page to a right-hand page, disabling the ability to create a new spread.

l Data Source: This controls whether the grouped frames shouldmount content from the object that is being
mounted (Mount Object; most common), from children of themounted object (Mount Children), or from an
asset or product linked to themounted object by a reference type. By default, the data source isMount Object,
which extracts values from themounted object only.

SelectMount Children or a product / asset reference type when the grouped frame is intended to repeat on
the page. The frame repeats in instanceswhere information is available frommultiple child objects or from
multiple referenced products or assets. When selected, the following options are activated in the STEP
Template Frame palette:Data Filter, Tile across,Max Distance, andGap.

l Data Filter:Only activated when Data Source is 'Mount Children.' Used whenmounting publication or section
objects to pull information (such asmetadata attribute values or section names) from child sections /
subsections. Available options areSections Only - Sort by Section Name andSections Only - Sort by
Page Number. This functionality is typically used in AutoPage publications to create tables of contents / section
indexes. See theCreating a Table of Contents Product Template topic for more information.
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l Tile across:Check this box if repeated frames should be tiled horizontally across the page instead of stacking
vertically beneath one another

l Max Distance: Themaximumdistance that horizontally tiled frames should repeat across the page (L-R)
before stopping and wrapping back around to begin a new row of repeated frames underneath

l Gap: The amount of space to place between repeated frameswhen tiled horizontally
l Group Align: Three options are available in the Group Align dropdownmenu that enable you to set additional
parameters for grouped frames.

l Distance to Left Edge: Same distance as if itemswere not grouped.
l Horizontal Spacing: If there is text is to the right of the image with a 5mmgap and the image changes
size, the text still ends up 5mm from the image.

l Distance to Right Edge: If the group grows or shrinks due to image size, the boxesmaintain their
distance to the right edge.

Grouped Frame Parameters for InDesign-created Page Templates

The below screenshot shows the available grouped frame parameters for InDesign-created page templates,
which are only applicable for Flatplanner publications and typically areGalley templates. The options are Frame
Type and Frame ID.
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For information on how to use these options, see theGalley Templates section of the Flatplanner
documentation.

Grouped Frame Parameters for Publication Templates

Though a 'Frame Type' dropdown list is available for grouped frameswhen working with publication templates,
the options are grayed out, as they are not applicable to grouped frames. The dropdown exists, however, in the
instance that it might have a future use if a customer need arises.

These two options (Product Continuation Note Before Split and Product Continuation Note After Split) only apply
to text frames on publication templates that will be used in AutoPage publications. See About Templates in
AutoPage in theAutoPage documentation for more information.

STEP Images
TheSTEP Images panel is used to find images andmount them on the InDesign page. STEP Images enables
you to search for images across the whole STEP database. You can use wild cards * (wild card string) and ? (wild
card character) in your search. Searching is performed under the selected hierarchy (if a hierarchy is selected).
Themaximumnumber of images returned in a search is 150.

Note: Searches in the STEP Images panel do not function the sameway as searches in the STEP Structure
View and STEP Template Content palettes, i.e., searches are not typeahead and cannot be filtered by object
type.
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The lower part of STEP Images displays the details of the current selected image if theShow Details option is
selected (see the next section of this topic,Options Menu).

Clicking theReset button after a search will return the view to the top level.

Clicking theUp button will bring the view one level back.

Use the Scale field to scale selected items in the STEP Images palette.

Options Menu
TheOptionsmenu in the upper-left corner of the STEP Images palette contains the following commands:

l Case Sensitive: Use this option to determine if you want to search in case sensitivemode or not.
l Use Full Text Index: Use this option to search for attribute values that are defined as full text indexable in
the attribute editor in STEP. (It may take a little while to show the results).

l Show Details: Use this option to get details about a selected image. The details are shown in the lower part
of the window.
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STEP Tasks
The STEP Tasks palette is used in conjunction with Flatplanner workflows and enables creative staff (DTP
operators) to pick up workflow tasks fromwithin InDesign. The palette displays a tree view of tasks similar to what
is displayed in the STEPWorkflow Tasks tab in the workbench, except the tasks picked up fromwithin InDesign
are Flatplanner planned pages. The tasks are grouped by publication.

From the STEP Tasks palette, DTP operators can accept tasks, submit tasks, reject tasks, andmore. Tasks
typically arrive in the STEP Tasks palette after the page has already been planned in STEP by amerchandiser
user, and then released to the DTP operator for further work.

This topic provides a broad overview of the options available on the STEP Tasks palette but does not go into detail
on how to use this palette with Flatplanner. SeeConfiguring DTP Task Views for InDesign in the Flatplanner
documentation for more information.

Accessing the STEP Tasks Palette
The STEP Tasks palette is accessed by navigating toWindow > STEP Structure View from the InDesign
application bar across the top of the InDesign interface.
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Description of the STEP Tasks Palette
The following screenshot shows the basic objects that display on the STEP Tasks palette. The numbers in the
image correspond to the numbered list below it.
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1. Publication: Each task (Flatplanner planned page) is organized by publication in the STEP Tasks palette. The
numbers in parentheses after the publication name represent the number of unaccepted tasks for the
publication / number of available tasks for the entire publication.

2. Task: The Flatplanner planned page that is ready to be actioned by the InDesign user, designated by the page
number and the page name. If the task is in bold text, the task is new and it has not yet been accepted. If it is in
regular text, the task has been accepted. Displayed after the page number and the page name is the name of
the current workflow state and the ID of the locale used in the context of your publication version. For example,
in the above screenshot, DTP is the workflow state and en_US is the locale ID of an English US dimension
point.

3. Status:Displays the number of unaccepted tasks for all displayed publications / number of available tasks for
all displayed publications.

4. Options menu: Sub-menu to display additional functions; described in the next section of this topic.

Options Menu
TheOptionsmenu of the STEP Tasks palette contains the following commands.

Note:With the exception of 'Refresh', 'Filter', and 'Show Tasks for Current Publication Only', a taskmust be
selected in order to activate themenu options. (These commands are also available by selecting a task and right-
clicking.)

l Accept Task: Launches the 'Accept' Task dialog. To accept the task, click 'Accept'. To cancel and leave the
task unaccepted, click 'Cancel'. To open the document in InDesign once the task is accepted, check 'Open
document' before clicking 'Accept'. To automatically jump to the planned page in the STEP Publication View
palette, check 'Goto in Publication View' before clicking 'Accept'. After accepting a task, the name of the task
appears in regular (non-bold) text, and the list of tasks is refreshed.
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l Cancel Task: Launches the 'Cancel Task' dialog. This option is only activated when an accepted task is
selected. Click 'Cancel Task' to return the accepted task to the list of incomplete tasks. After canceling a task,
the name of the task becomes bold again and the list of tasks is refreshed. (Note that the open document is not
closed when the task is canceled.)

l Task Completed: Launches the 'TaskCompleted' dialog. (This option is only activated when an accepted task
is selected.) Click 'Completed' to complete a task and send amessage to the next person in the workflow. After
completing a task, the list in the STEP Tasks tab is refreshed, and the task is removed from the list.

To save the finished document back to STEP, check the 'Save document to STEP' box before clicking
'Completed'. (The Section folder where the actual pages should be saved in STEP is highlighted
automatically.) To leave a note for the next user in the workflow, leave a comment in the 'Note' field.
To save your document in STEP only, and not save it locally on your computer, check 'Close and delete local
copy' before clicking 'Completed'. (Note that the document must first be saved locally before it can be saved to
STEP.)

l Show Details:Use this option to display the 'TaskDetails' dialog, which showsmore details about a selected
task.
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l Refresh:Click to refresh the list of tasks.
l Goto in Structure View:Click to jump to the planned page in the STEP Structure View palette.

l Goto in Publication View:Click to jump to the planned page in the STEP Publication View palette.

l Open document:Click to open the InDesign document that is associated with the selected planned page.
l Filter:Click to filter your task types byworkflow state. A 'Choose Item' dialog box appears where you can select
the tasks you would like to see.

l Show Tasks for Current Publication Only:Click to hide all tasks that are from publications other than the
one that you are currently working with, which is determined by the version that you have selected under STEP
> Change Version.

STEP Publication View
The STEP Publication View panel is used in conjunction with the STEP Flatplanner publishing component.

STEP Publication View is used to view the publication hierarchy in STEP.

Note: Search functionality is not available within the STEP Publication View panel.
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It is also possible tomount or unmount page cells from the Preview area (lower part of the STEP Publication
View); see the next section of this topic,Options Menu, for more information.

Options Menu
TheOptionsmenu in the STEP Publication View (arrow in upper right corner) contains the following commands.
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l URL: Selecting this option allows you to enter a STEP URL pointing to a node in STEP. This way you can
easily navigate to a specific node without browsing through the Structure View.

l Mount planned page:Use this option tomount a planned page.
l Mount on current page:Use this option tomount a planned page on a specific page, e.g. page 3 in your
InDesign document.

l Create document from plan:Use this option tomount the plan using the publication template saved in
STEP.

l Unmount planned page:Use this option to removemounted plan on a page.
l Remount planned page:Use this option to remount planned pages if content in STEP has been updated
since the page was originallymounted.

l Mount page cell:Use this option tomount a page cell if you havemounted a Flatplan and selected a cell in
the Preview area (lower area of the STEP Publication View).

l Unmount page cell:Use this option to unmount a page cell if you havemounted a Flatplan and selected a
cell in the Preview area (lower area of the STEP Publication View).

l Update page cell(s):Use this option to update cells if you havemounted a Flatplan and selected a cell in
the Preview area (lower area of the STEP Publication View). If you need to update page cells, a “not equal”
symbol is shown in the STEP Publication View.

l Import notes: Use this option to import Notes placed on the Flatplan in STEP
l Open actual page:Use this option to open a DTP document (InDesign page) from a section in your
publication.

l Scroll to page:Use this option to auto-scroll the page in the document that corresponds to the selected
Flatplan in the STEP Publication View.

l Page Pickup: n/a - Currently not available.
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l Refresh:Use this option to update the STEP Publication View.

l Show:Use this option to choose between different views of the pages (actual / planned) in the lower part of
the STEP Publication View.

AvailableShow options are Plan only, Actual only, Plan on top, Actual on top, Plan on left, and Actual on left.

Templates in STEP'n'design
To reduce the time needed to build pages, ensure style consistency, and improve accuracy, STEP’n’design
enables you to create templates to roughly plan the page layout beforemounting. Templates can easily be
created, maintained, and reused by designers using InDesign.

The STEP’n’design plug-in enables creation of the following template documents:

l Publication templates

l Product templates

l Page templates

Publication templates are also referred to as 'master pages' or 'mounting pages.' They define the document
size, margins, paragraph styles, character styles, table rules, swatches, and so forth that are used throughout a
publication. See thePublication Templates topic for more information.

Product templates predefine selections of STEP database content with powerful formatting rules that will
automatically style content when dragged and dropped onto the page. These templates reduce the time needed to
build pages, ensure style consistency, and improve accuracy. See theProduct Templates topic for more
information.

Page templates, which are only used with the Flatplanner component, are used to roughly plan the location of
product, asset, and/or classification objects on Flatplanner planned pages in a gridded format.

Note: Since page templates are only used with Flatplanner, they are not covered in the STEP'n'design portion of
the STEP online help documentation. See theCreating Page Templates andCreating Page Templates in
InDesign topics in the Flatplanner documentation for more information.

Which templates to use depends on the STEP publisher components that your system contains (see table below).
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STEP'n'design STEP Flatplanner STEP AutoPage

Product Template X* X X

Page Template X

Publication Template X X X

* The use of product templates is optional when building publications strictly through drag and drop, but strongly
recommended.

Note: The product templates used when working with or without STEP Flatplanner / STEP AutoPage are
exactly the same.

Standard InDesign documents with a file extension of .indd are used to create STEP'n'design templates. To
designate an InDesign document as a STEP'n'design template, navigate to STEP > Template Type, then select
the desired template type from the popupmenu.
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Product Templates
STEP’n’design enables users tomount predetermined product presentations directly to InDesign pages using
product templates. Product templates are normal InDesign documents (.indd) that are used along with
STEP'n'design (and the associated STEP Publisher components Flatplanner and AutoPage) to roughly plan the
layout of finalized InDesign pages and organize the STEP attributes, assets, tables, and additional stylistic
elements that comprise these product presentations.

Advantages of Using Product Templates
Product templates are used with all STEP Publisher components—STEP'n'design ('drag and drop'), Flatplanner,
and AutoPage. The advantages of using product templates to build pages in InDesign include:
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l Control over the positioning of individual elements on pages—such as text frames, image frames, and
tables—which reduces the time needed to build pageswhile simultaneously ensuring accuracy and style
consistency

l The ability to place ('mount,' in STEP'n'design terminology) one or several objects directly onto the page in
one operation

l Predetermination of which attributes, attribute groups, and asset references (typically images) are part of the
product presentation

l Predefined product presentations in terms of fonts, styles, colors, table rule lines, and so forth through the
application of InDesign paragraph styles, character styles, swatches, and STEP table settings to frames and
frame contents

l 'Create once, usemany'—product templates can be created once but used over and over, which greatly
streamlines production when a publication contains hundreds of pageswith identical layouts

l Templates can be easily created, maintained, and reused by designers

Note: Pages can be built in STEP'n'design without product templates, but this is uncommon.Without a product
template, data can only bemounted onto pages one attribute / asset reference at a time, and the page layout is
not predetermined. Due to these limitations, it is strongly recommended to use product templates. Use cases do
exist, however, for 'one-off' mounting of attributes and/or assets to InDesign pages. See theMounting Products
topic for more information.

Topics Covered in this Documentation Section
This documentation section addresses the following product template topics:

l Creating a product template

l Configuring text, image, and grouped elements on templateswith STEPXML tagging

l Product template layout, formatting, and styles

l Storing and editing product templates

l Creating a 'table of contents' product template

l Converting a preexisting sample document into a product template

The following topics also involve product templates but are not covered in this documentation section:

l Creating Layers in Product Templates: See theWorking With Version Layers topic for more
information.

l Galley product templates: See theGalley Product Templates section of the Flatplanner
documentation for more information.

Note: Though objects other than product objects can bemounted onto InDesign pages fromSTEP (including
classification folders, entities, and green publication hierarchy objects themselves), the subtopics in this
documentation will refer to InDesign page layouts as 'product presentations' and objects to bemounted as
'products'. This is to streamline the language used in presenting this information.
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Creating a Product Template
STEP'n'design product templates start out just like any other InDesign document—a blank .indd file. They become
product templates after frames (text, image, and sometimes grouped frames) are added to the page, and these
frames are configured using the STEP-specific featuresmade available in InDesign through the STEP'n'design
plugin.

Product template text frames contain STEPXML tags that canmount information from attributes, 'object
properties' such as STEP ID or name, commercial terms list values, and tables.

Product template image frames are also tagged with STEPXML and will mount referenced assets (typically
images, though sometimes PDFs) from products.

Product template grouped frames typically contain amixture of text and image frames. One use for grouped
frames is to mount metadata attributes that appear on reference links, such as image captions that should always
be presented with the image frame.

The general method for creating a new product template is as follows:
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1. Create a new InDesign document

2. Place text frames and/or image frames onto the document

3. Determine which STEP elements (such as attributes or images) should be in the template and reference their
associated STEPXML tags to the frames by using the STEP template palettes (STEP Template Content and
STEP Template Frame)

4. Apply styles to the frames such as paragraph / character styles, frame borders, color swatches, and so forth

5. Apply additional parameters to the frames and their contents from the STEP template palettes, such as image
scaling, automatic frame resizing, and automatic text deletion for empty attributes

The following subtopics in this documentation section describe how to create a product template from scratch. For
information on how to convert a preexisting sample document into a product template, seeConverting a Sample
Document into a Product Template.

Create the Document and Designate the Template Type

1. Create a new document in InDesign by navigating to File > New > Document or typing Ctrl+N.

2. Next, designate your blank InDesign document as a product template. With your blank InDesign document
open, Navigate to STEP > Template Type.

3. SelectProduct Template from the STEPmenu.

Open the STEP Template Palettes
Two STEP palettes (also known as panels in InDesign terminology) are used to create product templates from
your blank document:STEP Template Content andSTEP Template Frame.

To open these palettes (it does not matter in which order the palettes are opened):

1. Navigate to theWindowmenu in InDesign

2. ChooseSTEP Template Content
3. Return to theWindow menu, then chooseSTEP Template Frame.
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4. The palettes should now display in the section of your InDesign interface where you keep your panels docked.
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Text Frames in Product Templates
This topic explains the initial creation and configuration of text frames in product templates. There are twomethods
of creating text frames containing STEPXML textual elements (for example, attribute tags) on a product template.
In the first, the element is dragged directly onto the page from theSTEP Template Content palette, which
automatically creates the frame that contains the tag. In the second, the text frame is drawn on the page first, then
the tag(s) are added next. Whichmethod to use is amatter of personal preference.

Once the frame has been placed, its size can be edited and additional tags and content can be added to it.
Standard practice is to create the framewith the correct width and height for your future output. However,
additional configurations can be applied to these frames from the STEP Template Frame palette that will enable
them to automatically size to fit the content or allow them to split across column or pages (which is frequently
needed for tables and attributes that contain large blocks of text). See theSTEP Template Frame topic for more
information on the frame resizing settings that can be applied to frames.

This topic assumes that you have basic familiarity with the STEP Template Content palette, including how to
browse for and navigate to elements contained within its attribute tree. For full details on the options available
within this palette, see theSTEP Template Content topic.

Dragging Elements Directly From the STEP Template Content Palette

Dragging elements from the STEP Template Content palette directly onto the page enables you to simultaneously
create the text frame and place the attribute tag (or tag from another element, such as an object property or table
type) within the frame at the same time.

1. Open your product template, then open theSTEP Template Content palette.
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2. Search for or browse to the relevant attribute, attribute group, object property, commercial terms value, or table
type in the attribute tree panel of the palette. (Reference type tags are not applied to the inside of text frames,
but rather to entire frames. See the next section of this topic, Image Frames in Product Templates, for more
information.)

3. Using an attribute as an example, select an attribute in the palette tree, and, while holding down the left button
on your mouse, drag the attribute onto the product template. Release themouse button where you would like
to drop the frame.

4. A frame is created that contains the STEPXML tag of the selected attribute.
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5. Resize and reposition the frame as needed.

Using the Text Tool to Draw the Frame

Thismethod is similar to the above instructions except the text frame is drawn first.

1. Draw a text frame using the Type tool (T).

2. Search for or browse to the relevant attribute, attribute group, object property, commercial terms value, or table
type in the attribute tree panel of the palette.

3. Using an attribute as an example, select an attribute in the palette tree, and while holding down the left button
on your mouse, drag the attribute into the frame. Release themouse button when your cursor is inside the
boundaries of the frame.

4. The STEPXML tag of the selected attribute appears in the frame.
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Insert Additional Attributes into Existing Text Frames

It is common for more than one STEP tag to appear in a frame, and there is no limit on how many tags can be
placed into a single frame, since overset text is allowed in the text frame. Auto-sizing features for frames, applied
on the STEP Template Frame palette, will ensure that the frame sizes to fit the placed content when your product
presentation ismounted.

To add additional STEP tags to your frame:

1. With your template open, search for or browse to the relevant attribute, attribute group, object property,
commercial terms value, or table type in the 'attribute' tree panel of the palette.

2. Using an attribute as an example, select an attribute in the palette tree, and, while holding down the left button
on your mouse, drag the attribute into the frame. Release themouse button when your cursor is directly
beneath the preceding attribute(s) inside the frame.

3. The second attribute now displays in the frame.

Note: Be careful to not drop a STEPXML tag inside of another one. In a STEP'n'design text frame, a STEP
element can exist before or after other elements but not within or overlapping one another. Also, deselect the
tag in the text frame, or the tag will be replaced with that of the next element that you select in the attribute tree.

Edit STEP Tags Within a Text Frame

After STEP tags are placed inside frames, it is possible to perform awide range of modifications and operations to
the text frame and the STEPXML tags themselves. These include adding plain text and characters in between the
tags and editing the XML tags freehand.
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Add Plain Text and Characters Between STEPXML Tags
In the example from the previous section, two STEPXML tags appear directly adjacent to each another with
nothing to separate them. To avoid this, you can use the normal editing features of InDesign to add new lines,
tabs, or empty lines, as well as plain text such as commas between tags.

The following screenshot shows a hard return placed between the tags so the valueswill mount on separate lines.

The next example shows not only hard returns placed after each tag, but it also shows plain text (outlined in red)
inserted directly into the product template before the Price attribute, including the currency symbol ($). This
example showsSTEPXML tags that have been created by dragging and dropping definitions for product name,
the attribute Short Description, the attribute Price, and a table type.

There are no limitations on the type of plain text that can be added to STEP'n'design text frames, as long as the
characters do not appear inside of the STEPXML tag brackets (< >). Also note that anymanually added
characters will be used every time you use the template tomount products on a page.

Edit XML Tags Freehand
It is uncommon to edit XML tags freehand, since the normal method of maintaining the STEP XML tags in the text
frame is by dragging the element across from theSTEP Template Content palette. However, it is possible to
change or add tagsmanually. However, be aware that the systemwill not perform any data validation on the tags,
so if you create a new tag such as <STEPREF A=”MarketingText” />, it is the user's responsibility to make sure
that the ID of the attribute and the XML syntax are both correct.

Additional Configurations for Product Template Text Frames

Once all STEP tags have been placed into the frame(s), in almost all circumstances, theremust be additional
configurationsmade not only to the tags but to the frame itself. These configurations are performed using the
options available in the bottom panel of theSTEP Template Content palette and the options available to text
frames in theSTEP Template Frame palette.
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For information on configuration options available for STEP tags inside text frames, see theSTEP Template
Content topic. For information on all available options for product template text frames themselves, see the Text
Frame Parameters topic.

Styling—such as fonts, bolding, color swatches, and so forth— is almost always applied to product template text
frames aswell. See theProduct Template Layout, Formatting, and Styles topic for more information.

Image Frames in Product Templates
This topic explains the initial creation and configuration of image frames in product templates. Image frames are
added to product templates in much the sameway as text elements are, except there is some overlap between
how adding imagesworks between the STEP Template Content palette and the STEP Template Frame palette.
Just as with text frames, there ismore than onemethod of adding image frames to product templates.

This topic assumes that you have basic familiarity with the STEP Template Content Template and STEP
Template Frame palettes, including how to browse for and navigate to elements contained within the STEP
Template Content attribute tree. For full details on these palettes, see theSTEP Template Content topic and the
STEP Template Frame topic.

Note: Even though this topic concerns image frames, other assets also can bemounted into image frames, such
as PDFs.

Dragging Asset References Directly From the STEP Template Content Palette

Dragging elements from the STEP Template Content palette directly onto the page enables you to simultaneously
create the image frame and place the asset reference on the frame at the same time.

1. Open your product template, then open theSTEP Template Content palette.

2. Search for or browse to the relevant reference type in the attribute tree of the palette. For this example, the
PrimaryProductImage asset reference type will be used.
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3. Using the PrimaryProductImage reference type as an example, select the reference type in the palette tree
and, while holding down the left button on your mouse, drag the reference onto the product template. Release
themouse button where you would like to drop the frame.

4. A frame is created that contains the STEPXML tag of the selected asset reference type. Note that in this
example, the reference type is displayed on the frame because adornments have been turned on. See the
STEP Template Frame topic for more information on this feature.
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5. Resize and reposition the frame as needed.

Note: Unlike text frames on product templates, only one asset reference type can be applied to an image
frame at a time. However, if the asset reference allows for multiple references, all referenced images can be
pulled onto the frame, or, the frame can be configured to 'tile across' the page and place each referenced
asset in its own frame. See theSequencing Images in InDesign topic for more information.

Using the Rectangle Tool to Draw the Frame

Thismethod differs from the above instructions in that the image frame is drawn first, and the reference type does
not need to be dragged onto the page.

1. Draw an image frame on the product template with the InDesign rectangle frame tool.

2. Select the image framewith the InDesign selection tool.

3. With your image frame selected, locate and click on the desired asset reference in the STEP Template Content
attribute tree. (For this example, PrimaryProductImage is used.)
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4. Once the asset reference type is selected, the STEPXML tagging is applied to the frame.

Using the STEP Template Frame Palette to Create the Image Frame

Because asset references are attached to entire frames, and no tagging goes 'inside' the frames, there is overlap
in how to create image frames between the two STEP template palettes. The following instructions describe how
to place a tagged image frame on the page using theSTEP Template Frame palette.

1. Open your product template, then open theSTEP Template Frame palette.
2. Draw an image frame on your page with the rectangle tool, then select the framewith the selector tool.

3. With your image frame selected, select the relevant asset reference type from theAsset Content dropdown.
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4. Once the asset reference type is selected, the STEPXML tagging is applied to the frame.

Additional Configurations for Product Template Image Frames

Once your image frame is in place and tagged with the STEP asset reference type, in almost all circumstances
theremust be additional parameters set on the frame using the STEP Template Frame palette. These parameters
control how images appear on the page when a product presentation ismounted using the product template.
These parameters include settings such as image scaling, image tiling, frame size adjustment, and the ability to
delete the image frame from the page altogether if there is no asset referenced to themounted product. For more
information, see theSTEP Template Frame topic.
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Grouped Frames in Product Templates
After text and image frames have been added to the product template, it is sometimes necessary to group frames
together. Reasons to group frames include the following:

l Tomount a linked asset and ametadata attribute connected to the asset (for example, an image caption) by
grouping an image frame together with a text frame

l To tie together a product presentation with information from a referenced product, such as bringing in an
image from a secondary product that is linked to themounted object

l To ensure that the grouped elements always remain together when they aremounted

Frames are grouped using standard InDesign functionality.

1. Choose the InDesign selection tool, then hold down the left button on your mouse while drawing a 'selection'
frame around the objects that you wish to group.

2. Release themouse button to select all the frames.
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3. Right-click anywhere within the selected frames, then clickGroup from the popupmenu. Youmay also right-
click anywhere within the selected frames and pressCtrl+G.

4. The frames are now grouped.
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Once the frames are grouped, in almost all circumstances, additional configurationswill need to be applied to the
frames using theSTEP Template Frame palette.
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For more information about the individual parameters available for grouped frames, see theGrouped Frame
Parameters in the STEP Template Frame Palette topic.

Product Template Layout, Formatting, and Styles
After creating a product template and defining which elements (attributes, images, and other elements) should be
part of your product presentation, it is necessary to define how the data should be formatted once it comes across
to the InDesign page. This involves arranging the text and image frames tomatch the layout that you are trying to
accomplish aswell as applying styling such as InDesign paragraph styles to text and swatches (colors) to frames
and frame borders.

Note: This topic does not describe how to create paragraph styles, character styles, or swatches in InDesign.
Explaining how to use InDesign itself is outside the scope of the STEP'n'design documentation.

Positioning Text and Image Frames

Since STEP’n’design product templates are standard InDesign documents, it is entirely up to users to design the
layout of the finalized product presentation. STEP does not place limitations on how templates can be laid out or
styled; the STEP portion of product template creation lies only in the application of STEPXML tagging and other
parameters to frames and their content using the STEP palettes.

Product templates are intended to create 'rough' layouts, with the expectation that DTP operators will still make
manual adjustments to the page elements once the pages aremounted. However, in some cases, product
templates can be designed in such a way that a product can bemounted onto the page with a perfect or near-
perfect layout. Since STEP does not place limitations on how many product templates can be used within a single
publication, it is standard practice to createmultiple product templates for a publication to handle the varying
product layouts that appear within.

Positioning Frames
Once you have built a product template with some image and text frames, you can determine their position
relationship—the distance between the individual frames—by simplymoving or sizing the frames.

The distance between the elements in the product template will be kept when a product ismounted to the page
using that template. When organizing and positioning your frames, you can use standard InDesign functions such
as aligning, grouping, and rotation.

Applying Styles to Frames and Frame Contents

Even though STEP'n'design publication templates (also referred to as 'master pages' or 'mounting pages') are the
documents that define the document size, margins, paragraph styles, character styles, table rules, swatches, and
so forth that are used throughout a publication, it is strongly recommended that your product templates contain all
of the same styles and swatches that are used in the publication template. If your product templates do not contain
the same styles, however, all paragraph styles and other stylistic elements will still come across to themounted
InDesign page. It is just a best practice for the styles tomatch.

You can define all styles in the product template and then load them to the publication template, or vice versa.
Defining styles in a product template is identical to the procedure of defining styles in a publication template. For
more information, see thePublication Templates topic.
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The following screenshots show the application of standard InDesign paragraph styles to product template text.

The following screenshot shows a 'before and after' of a product mounted using a product template that employs
paragraph styles, frame shading, and frame borders.

Note: Style tags do not need to be created in STEP for InDesign paragraph styles used in standard text frames.
The only time STEP style tags are needed is for InDesign character styles and for text that appears within
tables. See thePublication Template Layout, Formatting, and Styles topic for more information.

Storing and Editing Product Templates
After creating your product templates, you need to save them in the STEPWorkbench and, in order to use them to
build pages fromwithin your InDesign client, on your local computer.
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Storing Product Templates Locally
Product templatesmust be saved locally (on your own hard drive or other locally accessible file location) before
they can be used tomount products fromwithin InDesign using standard 'drag and drop' functionality. Simply save
the templates as standard InDesign (.indd) files to a directory or folder on your machine, then provide the path
where the templates are saved in the Template Path field of the STEP Preferencesmenu.

For information on the STEP Preferencesmenu, see theConfiguring the STEP Preferences Menu topic.

Storing Product Templates in STEP
Product templatesmust be saved to STEP for the following reasons:

l At least one product templatemust exist in STEP in order to create a publication. (The exception to this is if
you create a publication by using a Publication Excel import. However, the publication cannot be used until a
product template is linked to it, as the Publication Excel import merely creates the publication structure. See
Importing Publications in Excel for more information.)

l Templates stored in STEP can be opened and edited by any user who has access to the same STEP
environment, in essence treating STEP as a 'cloud' storage solution

l Product templatesmust be stored in STEP in order to utilize Proof View functionality

l Product templatesmust be stored in STEP in order to use the Flatplanner and AutoPage components

Note: For standard drag-and-drop functionality, all product templates do not have to be saved in STEP, but it is
recommended to store them in STEP so other users can open and edit them if needed.

To store a product template in STEP:

1. Save the InDesign document on your local hard drive as a standard InDesign file.

Note: STEP will not let you save a template to the workbench unless it is first saved locally. However, once
the template is saved in STEP, youmay delete the local file if you do not plan on using it later for drag-and-
drop pagemounting.
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2. Click on STEP > Save Document to DB ....

3. TheSave Document to STEP Database dialog displays.
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4. Select the publication group where you would like to save the template.

Note: Templates can only be saved to publication group folders; they cannot be saved into publications or
section folders.

Determining which publication group to save your product templates into is amatter of user preference.
Common choices are to save all product templates in a publication group that is devoted solely to product
templates, or to save product templates in a publication group along with their associated publication(s).

5. ChooseSave as Product Template from the dropdown list near the bottom of the dialog.

6. Check theClose document and delete local copy box to delete the local copy of your template once you
save it to STEP.

7. Optionally, you can specify aminimumandmaximum value for the product template's dimensions by entering
the values in theMin andMax value fields for theHeight andWidth dimensions. TheMin andMax dimension
values are used in pagination rules. The values are pre-populated based on the dimensions of the total content
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of your product template but can be overridden by entering new values in the fields. For more information on
pagination rules, seePagination Rules for Flatplanner in the Flatplanner documentation andAbout
AutoPage Pagination Rules in theAutoPage documentation.

8. ClickOK. The product template is saved in STEP.

Opening and Editing Product Templates
If a product template needs to be altered after it is saved to STEP, it must be opened from theSTEP Structure
View palette within InDesign. This is to ensure that your system recognizes the template as the original file, as
product templates previously saved to STEP contain an embedded, 'hidden' STEP ID. If the template is opened
from a location on a local drive and resaved to STEP, the original file will not be overwritten—STEP will recognize
this template as a new file.

To open and edit a product template:

1. Open theSTEP Structure View palette in InDesign.

2. Browse to or search for the product template that you wish to edit.

3. Right click on the template and selectOpen Document from themenu.

4. Make the necessary edits to the template, then save it on your local drive. (All templatesmust first be saved
locally before they can be loaded to STEP.)

© Stibo Systems - Confidential - STEP Trailblazer 8.2 120



5. Follow the steps outlined in the previous section of this topic ('Storing Product Templates in STEP') to save the
template back to STEP. Make sure that you save the template back to the same location fromwhich it was
opened.

6. The updated template will overwrite the previous document on STEP and will not need to be relinked to any
publications or products.

Creating a Table of Contents Product Template
Product templates that mount tables of contents in publications can be created in STEP'n'design. Tables of
contents typically appear at the beginnings of publications and/or sections and can bemountedmanually using
'drag and drop' operations, as well as automatically using AutoPage. These tables of contents can be sorted either
alphabetically by section name or by page number. When sorted alphabetically, they can be thought of as section
indexes, as their intent is to alphabetically list the STEP names of all sections that appear within an entire
publication and/or the names of all subsections that appear within a section. When sorted by page number, they
can be thought of as true tables of contents, listingmounted objects in the actual order that they appear within
the publication.

Product templates designed to create tables of contents / section indexes utilize tagging that mounts the following
information:

l STEP names of the child sections and subsections of the publication

l Values from calculated description attributes that pull in the first and last page numbers of mounted pages
that are saved into the publication's sections and subsections

In addition, paragraph styles are set up to insert dot leaders between the section names and the page numbers.

The following screenshot shows an example of an alphabetically sorted table of contentsmounted from a
publication object:

This screenshot shows a table of contents sorted on page number:
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This topic explains the steps involved in creating the page number calculated attributes, the required tagging for
the product template, the InDesign paragraph styling needed to insert dot leaders, and instructions for mounting
the table of contents once the product template is configured.

Additionally, this topic explains how tomount a table of contents using standard STEP'n'design 'drag and drop'
functionality. For instructions on how tomount a table of contents usingAutoPage, see theCreating Tables of
Contents in AutoPage section of theAutoPage documentation.

Configuring Page Number Calculated Attributes
Two calculated description attributesmust be created andmade valid on the section object type(s) that you are
using in your publication. One of these attributes should pull the first page number in the section and the second
attribute should pull the last page number in the section.

To create these attributes, follow these steps:

1. Create a Description attribute by the samemethod that you would create any other description attribute. (See
theCreating Attributes section of theSystem Setup / Super User Guide documentation for more
information.) Give it a name that indicateswhat it is used for, e.g., FirstPageNumber.

2. After creating the attribute, right-click in theValue template field on theAttribute tab and selectEdit
Function. The Function Editor displays.

3. Click Insert Template, then expand thePublishing Functions section of theDefault Templates.
4. Select 'Find the first page number in the section' and clickOK. The Insert Templatewindow closes.
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5. No additional action is needed in the Function Editor, so clickOK to close it.

6. To create the second calculated attribute—which will pull the last page number in the section—the steps are
identical to 1 - 5 above, except in step 4 you will select 'Find the last page number in the section.'

Note: Calculated attributes related to publishing functions cannot be tested in the Function Editor, as publication
hierarchy [green] objects are not among the available optionswhen selecting an object as the Evaluation Node.

7. On theValidity tab for each of your attributes, check theSection box tomake them valid on the desired section
object types.

8. When actual pages have been saved to STEP into your section, the calculated attributeswill display page
numbers as such:
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Configuring the Table of Contents Product Template
A product template intended tomount tables of contents will look similar to the following example. Note that text
styles, colors, and so forth are completely configurable to individual user needs. This is only a sample for
illustration purposes.

Note: This topic does not explain all aspects of product template creation; it merely focuses on how to create a
product template tomount a table of contents. For more general information on creating product templates, see
theProduct Templates topic.

The sample pictured above is designed tomount three levels of subsections—in alphabetical order—by using the
Repeat Options available in theSTEP Template Palette. The following text is the content that appears in the
above screenshot:

<STEPREPEAT NF=”SectionsOnly - Sort by Section Name” RS=”\n” ><STEPREF
A=”stibo.pseudoObjectName” /> <STEPREF A=”FirstPageNumber” />-<STEPREF A=”LastPageNumber”
/>

<STEPREPEAT NF=”SectionsOnly - Sort by Section Name” RS=”\n” ><STEPREF
A=”stibo.pseudoObjectName” /> <STEPREF A=”FirstPageNumber” />-<STEPREF A=”LastPageNumber”
/>
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<STEPREPEAT NF=”SectionsOnly - Sort by Section Name” RS=”\n” ><STEPREF
A=”stibo.pseudoObjectName” /> <STEPREF A=”FirstPageNumber” />-<STEPREF A=”LastPageNumber”
/></STEPREPEAT></STEPREPEAT></STEPREPEAT>

To set up this tagging on a product template in InDesign, follow these steps:

1. With your product template open, open theSTEP Template Content palette by navigating toWindow >
STEP Template Content from the application bar across the top of the InDesign interface.

2. Using the InDesign Text tool, draw a text frame to the width that you would like your table of contents to
appear.

3. Drag theObject Name 'pseudo attribute' into the text frame. Object Name is located in theObject Properties
folder in the STEP Template Content palette. Object Name is used tomount the STEP names of the sections
and subsections in the publication.

4. Drag the attribute that you are using for the first page number into the text frame directly after the Object Name
tag.

5. Drag the attribute that you are using for the last page number into the text frame, directly after the first page
number tag, then place a hyphen between the two tags.
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6. To set up the dots (dot leader) between the tags for the section name and the first page number, follow these
steps.

Note: This dot leader should be added to your paragraph style so you can reuse it later if needed.

l With your text frame selected, navigate to Type > Tabs in the InDesign application bar. The Tabs dialog will
display at the top of your text frame.

l Click the right tab icon, then click anywhere on the ruler to apply the right tab.

l Click the tab symbol that you just placed in the ruler, then hold down the left button on your mouse and drag
the tab symbol to the far right of the ruler until it alignswith the right edge of the text frame. (The edge of the
framewill turn green if you have Smart Guides turned on in InDesign.)

l Place a period in the Leader box, then clickX to close the Tabs dialog.
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7. Using the text tool, place your cursor between the tags for the section name and the first page number, then
press the Tab key. The dots will appear between the two tags.

8. Next, using the text tool, highlight all content in the frame, then right-click and selectRepeat Selection.

9. On theRepeat Selection dialog, type \n into theRepeat Separator field. The repeat separator is the string or
character that will be placed between each repeated entry. \n is the symbol for hard return.

10. Next, make a selection from theData Filter dropdown list. To sort the table of contents alphabetically by
section name, chooseSections Only - Sort by Section Name. To sort the table of contents by page
number, chooseSections Only - Sort by Page Number. ClickOK to close the dialog.
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11. Your tagging should now look like this (example shows the 'SectionsOnly - Sort by Section Name' selection):

12. Copy and paste the tagging into the same frame twomore times. This will enable the product template to pick
up section names and page numbers from two additional levels of subsections. Your tagging should look like
this:

13. Cut the two </STEPREPEAT> end tags from the end of the first and second paragraphs, then paste them at
the end of the last paragraph. There should now be three </STEPREPEAT> end tags at the end. Your tagging
should look like this:
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14. Apply styling (e.g., font size, text bolding, paragraph indents) as needed to differentiate the three levels of the
TOC. For example:

15. Next, test your product template to ensure that it has been set up correctly.

Mounting the Table of Contents Product Template
The TOC product template can bemanually tested in InDesign by dragging the desired publication object from the
STEP Structure View panel and dropping it onto a blank InDesign page (or a publication template).

To test the TOC product template, follow these steps:

1. With your blank document / publication template open in InDesign, locate the relevant publication in theSTEP
Structure View panel.

2. Make sure that your TOC product template is displayed in the Template dropdown at the bottom of the STEP
Structure View panel.

3. Left-click the desired publication, then hold down themouse button as you drag the publication onto the page.
Release themouse button in the upper left corner of the page.
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4. The table of contents will mount and should look similar to the following:

Converting a Sample Document into a Product Template
A sample document created outside of STEP can be converted into a STEP'n'design product template in
InDesign—either an entire page at once or one link at a time—by using theConvert to STEP Product
TemplateandConvert to STEP Tags functions, respectively. These features are intended for use on existing
pages on which all page elements are already arranged in the desired page layout, preventing the need to create
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the product template from scratch. Though documents created outside of STEP are commonly used as a starting
point for product template creation, these features enable users to partially (or even fully) automate the process
instead of having tomanually remove all content from frames, identify what STEP content belongs in each frame,
andmanually apply STEP'n'design template tagging to each frame.

Though this feature cannot be used to automatically create publication templates or page templates from sample
documents, youmaymanually convert the sample document into one of these two document types after first
converting it into a product template.

This topic assumes that users are familiar with the overall functionality of product templates and STEP'n'design.

The following sections of this topic explain the different methods of converting a sample document to a product
template.

Method 1: Entire Page at Once
A sample document can, in some instances, be fully converted to a product template in amatter of clicks using the
Convert to STEP Product Template function.

Thismethod requires that a product already exists in STEP that containsmatching content to the contents of the
sample page. If such a product does not already exist, then a 'dummy' product should be created.When using this
method, the systemwill scan the page to locate content matches on the selected product in STEP. For example, if
there is an image named 'Image.jpg' embedded in the sample file, and there is an image named 'Image.jpg' in
STEP that is linked to the product by a Primary Product Image reference type, then the image will be removed
from the image frame on the sample page and replaced with the tagging for the Primary Product Image reference
type.

The concept works the samewaywith text frames. If the text content in a frame—either the entire contents of the
frame or part of the text within a frame—matches content in STEP, then the text will be removed from the page
and replaced with the tag for the attribute in STEP that contains thematching content.

The following example shows a sample document as compared against amatching product in STEP. The
numbering in the image correspondswith the numbered list below the image to explain what tags the frameswill
be linked to when the sample is converted.

Note that the tables on the page are not numbered, asConvert to STEP Product Template cannot automatically
recognize tables. See the next section on converting tags / frames one at a time for more information on how to
manually convert a table frame to a frame containing a STEP table tag.
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Sample Document Elements

1. Brand Name:

2. Primary Product Image: The following screenshot shows the InDesign 'Links' panel superimposed over the
Image References section of the product's References tab, displaying what needs tomatch before the system
can apply the tag to the frame.
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3. Manufacturer's Part Number:

4. Name:

5. Long ItemDescription:

6. Product Group Description:
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Steps to Convert the Sample Document to a Product Template

1. In InDesign, navigate to the relevant product object in the STEP Structure View.

2. Right-click the product object and choose Selection > Convert to STEP Product Template.
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3. A 'Convert to STEP Product Template' dialog appears with an option to select a color from a dropdown list
labeledBackground Colour for Unlinked Items. If no color is desired, clickOK. Otherwise, choose a color
from the dropdown list. (See the 'When Page Content Cannot beMatched to STEP Content' section of this
topic below for more information on how this color will be used.)

4. All content on the page that can bematched to content in STEP is converted to the corresponding asset
reference and/or attribute tags.

Note: If there aremultiple attributes on the product object in STEP that contain identical content to content on the
sample page, STEP will randomly select an attribute to use.
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When Page Content Cannot be Matched to STEP Content

For content that cannot bematched to content in STEP, the framesmay optionally be shaded with a background
color in order for users to recognize what still needs to be convertedmanually and/or removed from the page. The
'Convert to STEP Product Template' dialog that displays has a dropdown list labeled 'Background Colour for
Unlinked Items.' this dropdown is populated by the colors that exist in the sample document's InDesign color
swatches. As such, a custom color can be created (through the creation of a new swatch) solely for the purpose of
shading the background for unlinked frames.

Note that, in the previous screenshot, the tables are shaded pink and have not been converted to STEP tags.
Even if a STEP table exists on the product object and contains identical content to that of a table on the sample
page, the table framesmust be convertedmanually, as explained in the next section of this topic, 'Manually
Converting Frames and Text to STEP Tags.'

Method 2: Manually Converting Frames and Text to STEP Tags
TheConvert to STEP Tags feature is used tomanually convert frames (and, in some instances, portions of text
within text frames) on a sample page to frames that contain STEP tagging for reference types, attributes, and/or
tables. To use this feature, the following elements (if applicable) must bemade visible in the STEP Structure View:

l Attributes

l Tables

l Asset References

These options are selected in the 'Structure Tree view options' of the STEP Preferences menu. From the
dropdown list, choose either 'Show all Attributes in Tree' or 'Show Attributeswith Values in Tree.' Then, check the
boxes for 'Show Tables in Tree' and 'Show Asset References in Tree.'

Converting Asset Frames

An asset frame on a sample document can bemanually converted to a product template frame even if the image /
asset on the sample page does not match any content in STEP. The process of tagging a framewith an asset
reference is solely based on selecting the desired asset reference type in the STEP Structure View palette.

1. Select the relevant image frame on the sample document.

2. In the STEP Structure View, expand a product object (can be any product object) and select the desired asset
reference type.

3. Right click the reference type, then click Selection > Convert to STEP Tags.
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4. A 'Convert to STEP Tags' dialog displays that contains additional options that can be applied to the asset
frame, such as the settings for content deletion, sizing, scale, and alignment. Youmaymake the relevant
selections here or youmay set these options at a later time from the STEP Template Frame palette. ClickOK
when finished.
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5. The asset is removed from the frame and replaced with the STEP tag for the asset reference.

Converting Text Frames

Aswith converting an asset frame, a text frame on a sample document can bemanually converted to a product
template frame even if the text within the frame does not match any content in STEP. The process of tagging a
framewith an attribute tag is solely based on selecting the desired attribute in the STEP Structure View palette.

1. Select the relevant text frame on the sample document.

2. In the STEP Structure View, expand a product object (can be any product object) and select the desired
attribute.

3. Right-click the attribute and choose Selection > Convert to STEP Tags.
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4. A 'Convert to STEP Tags' dialog displays that contain options that can be applied to both the entire frame or
the attribute tag itself, such asDelete Before / Delete After and Transformation (which apply to the tag) and
Delete NoContent and Split (which apply to the frame). Youmaymake the relevant selections here, or, you
may set these options at a later time from the STEP Template Frame and/or STEP Template Content palettes.
ClickOK.

5. The original text is removed and replaced with the STEP tag for the attribute.

Converting Partial Text Within Frames

Aswith converting entire text frames, attributesmust be visible in the STEP Structure View tree in order to convert
partial text to STEP tags.

1. In a text frame, highlight the selection of text that you would like to convert to an attribute tag.

2. In the STEP Structure View, expand a product object (can be any product object) and select the relevant
attribute.

3. Right-click the attribute and choose Selection > Convert to STEP Tags.
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4. A 'Convert to STEP Tags' dialog displays containing options that can be applied to the attribute tag, such as
Delete Before / Delete After, Fail Text, and Transformation. Youmaymake the relevant selections here or you
may set these options at a later time from the STEP Template Content palette. ClickOK when finished.

5. The original text is removed and replaced with the STEP attribute tag.
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Converting Frames to STEP Table Tags

Aswith asset reference types and attributes, table tagsmust be visible in the STEP Structure View tree to use
'Convert to STEP Tags.'

An entire text frame, or partial text within the frame, can be converted to a table tag. Note that a table tag can be
placed in any text frame; the frame does not have to already contain a table.

The following steps outline how to convert an entire frame to a frame containing a table tag.

1. Select the relevant text frame or text on the sample document.

2. In the STEP Structure View, expand a product object (can be any product object) and select the desired table
type.

3. Right-click the table tag and choose Selection > Convert to STEP Tags.

4. A 'Convert to STEP Tags' dialog displays containing options that can be applied to both the frame and the table
tag, such asDelete NoContent, Delete Before / Delete After, and Split. Youmaymake the relevant selections
here or youmay set these options at a later time from the STEP Template Frame and/or STEP Template
Content palettes. ClickOK.
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5. The original text is removed and replaced with the STEP table tag.

Converting Partial Text to a Table Tag

The samemethod used for converting partial text (explained in the previous 'Converting Partial TextWithin
Frames' section of this topic) can be used to convert text to a table tag, except amore limited 'Convert to STEP
Tags' dialog appears after clicking Selection > Convert to STEP Tags.

As with attributes, the selected text is removed and replaced with the table tag.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 142



Default InDesign Product Templates
Default product templates can be assigned to product, product-override, and classification objects in the
workbench by setting the value of InDesign Template Allowed to 'Yes' on the corresponding object types in
SystemSetup. Default templates are assigned to these objects so that:

l A default product template can be set at a higher node in the product hierarchy and inherited by lower nodes

l Templates do not have to be stored locally whenmounting pages using 'drag-and-drop' operations in InDesign

l Publication rules can be configured in Flatplanner and AutoPage to use the default templates that are
assigned, eliminating the need to assign product templates to Flatplanner frames or create additional
pagination rules to drive product layouts

Note: The 'InDesign Template Allowed' field is only visible in STEP systemswith a STEP'n'design license.

Configuring Object Types to Allow Default Product Templates
Before a product object can be assigned a default InDesign product template, it must first be configured to display
the 'Default InDesign template' field under theDescription flipper on theProduct tab. To set this up:

1. Locate the relevant product or product-override object type inSystem Setup under Object Types & Structures
> Primary Product Classification or Object Types & Structures > Basic object Types > Product-
Overrides.

2. With your object type selected, go to theObject Type tab and expand theDescription flipper.
3. In the InDesign Template Allowed field, select 'Yes' from the dropdown list.
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4. After enabling an object type to allow a default InDesign template, a default product template can be assigned
to any object of the selected object type in the Tree.

Assigning a Default InDesign Product Template

1. In the workbench, navigate to your product or product-override object in the Tree and go to theProduct tab.
2. Under the Description flipper, go toDefault InDesign template and click the ellipsis button (…).

3. In theSelect InDesign product template dialog that displays, browse to or search for the template that you
would like to set as the default, then clickSelect.
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Note: If you have already selected a default product template and want to remove it, clickSelect None from
the dialog.

4. The product template is set as the default.
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Default Product Template Inheritance
Default InDesign templates can also be inherited from higher nodes in the product hierarchy, saving time and
effort in assigning a default template tomultiple products.

Note: Both parent and child objectsmust be configured to accept default InDesign templates before templates
can be inherited.

A small green arrow to the left of the template field indicates that the template is inherited.

The inherited template can be overridden by choosing another one by following the steps in the previous section of
this topic, Assigning a Default InDesign Product Template.

To revert back to the inherited template, click the ellipsis button (…) by the Default InDesign template field, then
clickSelect None in the 'Select InDesign product template' dialog.
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Default Product Template Inheritance for Product Overrides
By default, product overrides do not inherit default product templates from the product hierarchy. This behavior
can be reversed by changing the Inherit Default Product Template through product hierarchy for Product
Overrides setting to 'Y'. This setting is located under theDTP Settings flipper on the SystemSettings tab,
located under SystemSetup > Users andGroups.
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The following screenshot shows a product-override object with a product template inherited from its Level 2 parent
object.
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Publication Templates
When creating InDesign pages using STEP'n'design, publication templates are used. Publication templates,
like product templates, are normal InDesign documents (.indd) and are used with all STEP Publisher
components—STEP'n'design ('drag and drop'), Flatplanner, and AutoPage. They serve as the foundation of
publications created with STEP and define the document size, margins, paragraph styles, character styles, table
rules, swatches, page numbers, and so forth that are used throughout a publication. Whereasproduct
templates serve to define the layout of product presentations on InDesign pages, publication templates are
the empty pages onto which objects (typically product objects) are placed. Since the process of placing items
onto publication templates fromSTEP is referred to as 'mounting,' publication templates can also be referred to as
'mounting pages.'

Topics Covered in this Documentation Section
This documentation section addresses the following publication template topics:

l Creating a publication template

l Publication template layout, formatting, and styles

l Storing and editing publication templates

The following topic also involves publication templates but are not covered in this documentation section:

l Creating Layers in Publication Templates: See theWorking With Version Layers topic for more
information.
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Note: Though objects other than products can bemounted onto InDesign pages fromSTEP (including
classification folders, entities, and green publication hierarchy objects themselves), the subtopics in this
documentation will refer to InDesign page layouts as 'product presentations.' This is to streamline the language
used in presenting this information.

Creating a Publication Template
STEP'n'design publication templates start out just like any other InDesign document—a blank .indd file. They
become publication templates after being designated as such in STEP'n'design. In addition to background
graphics such as logos, publication templates also typically contain footers, sidebars (such as section names),
page numbers, and so forth.

This topic explains how to create and configure a publication template from a blank InDesign file, as well as create
a publication template from a previously existingmaster document. It does not describe how to use standard
InDesign functionality such as adding page numbers tomaster pages, since this documentation assumes the
reader already has a working knowledge of InDesign.

Creating a Publication Template as a New Document

1. After opening InDesign, begin the process of creating a new InDesign document by navigating to File > New >
Document or typing Ctrl+N.

2. In theNew Document dialog that displays, define the settings for your template, including page size, margins,
and bleed / slug. Publication templates can also be created with multiple columns. In most instances, these
settingswill apply to the entire STEP'n'design publication, though it is possible to create additional master
pages in your publication template that have different page sizes, margins, and so forth. See the 'Master Pages
of Different Sizes' subsection of this topic below for more information.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 150



3. Check the Facing Pages check box to create a spread for themaster page.When using STEP Flatplanner
and STEP AutoPage, the publication templatemust be created as a spread, by creating two pages based off of
themaster page.

Note: If you are working with a previously createdmaster document that does not already have Facing Pages
checked, you can correct this by navigating to File > Document Setup in InDesign and checking the Facing
Pages box on the Document Setup dialog.
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4. ClickOK to finish creating the empty document.

Designating the Template Type
Next, designate your blank InDesign document as a publication template.

1. With your blank InDesign document open, Navigate to STEP > Template Type.
2. SelectPublication Template from the STEPmenu.

Master Pages and Spreads
A publication template can consist of one or manymaster pages and spreads. Many publications, especially large
catalogs, needmore than onemaster spread because each sectionmay have, for example, different colored
thumb tabs for each chapter. The following screenshot shows a publication template as viewed in the InDesign
Pages panel. It contains threemaster pages (A-Master, B-Master, and C-Master) and three spreads based off
of thesemaster pages—pages 2-3 are created fromA-Master, pages 4-5 are created fromB-Master, and pages
6-7 are created fromC-Master.
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Note: Each page spreadmust only contain two pages.

Page spreadsmust be created from themaster pages because products can only bemounted on pages, not on
master pages. For standard drag-and-dropmounting operations, users will drag products onto one of the page
spreads and not amaster page. For the AutoPage and Flatplanner components, these page spreadsmust be
mapped to publication sections using pagination rules. For more information about pagination rules in STEP
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AutoPage, seeAbout Pagination Rules in theAutoPage documentation. For more information about
pagination rules in STEP Flatplanner, seePagination Rules for Flatplanner in the Flatplanner
documentation.

To create a new master page in InDesign:

1. Open thePages panel (navigate toWindow > Pages or press F12).

2. Click theOptionsmenu in the upper right corner of the panel and selectNew Master.

3. Configure your new master page on theNew Master dialog, then clickOK to complete.

Master Pages of Different Sizes

Sometimes a publicationmay need one or moremaster pages that are a different page size than the rest of the
catalog. For example, youmay need a smaller page size to create an order form or advertising insert. Sincemore
than one publication template cannot be used for an entire publication, this different page size is handled by
creating a new master page within the publication template.

A master page of a different size is created the sameway as any other master page, except it is given a different
page size on the New Master dialog.
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The following screenshot shows how a page created from amaster page of a different page size looks alongside
the other pages in the template. The InDesignPages panel is on the right and the page spreads (viewed at a
zoom level of 25%) are on the left.
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Creating a Publication Template From an Existing Document
In many instances, a sample InDesign document will be provided (typically by a customer) before the template-
building process begins. Creating a publication template from a finished sample document is a relatively
straightforward process. Re-using a sample document in thismanner removesmuch of the guesswork in setting
up the size of the pages andmargins, the required paragraph and character styles, color swatches, and so forth.
Creating a template from a preexisting sample ensures that a publication created in STEP will look exactly like the
publication as it was created previously, outside of STEP. For thismethod, follow these steps:

1. Open the sample InDesign document.

2. Open thePages panel by navigating toWindow > Pages (or pressing F12).
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3. In thePages panel, delete all pages andmaster pages that are not needed. If the publication template will only
be used for simple proof views in STEP, then only onemaster page and one page spread needs to remain. If
you are using the AutoPage or Flatplanner component and need tomap publication sections tomaster spreads
through pagination rules, then youmay need to retain most or all of themaster pages in the document. For
more information, see the 'Set publication template spread index' section of theAutoPage Pagination Rule
Actions topic in theAutoPage documentation and the Flatplanner Pagination Rule Actions topic in the
Flatplanner documentation. For information on basic proof views, see theGenerating Proof Views topic.

4. Next, select the page(s) at the bottom of the Pages panel.
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5. Using the InDesign selection tool , click anywhere on the InDesign page and pressCtrl+A to select all
elements on the page(s), or, go to Edit > Select all in the InDesignmenu. Then, press the Delete key to
remove all elements.

6. The resulting blank document will still contain all elements from themaster page such as page numbers, side
tabs, and other background graphics.
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In addition, all paragraph and character styles will remain.
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Publication Template Layout, Formatting, and Styles
Publication templates contain the 'background' graphics of the pages that are used in a publication. The below
screenshot shows an example of a publication template page spread with productsmounted onto the left page
and no products on the right page. The background graphics, headers, page numbers, and so forth are driven by
the publication template. The object layouts are driven by the product template.

Aswith product templates, the graphical formatting of a publication template is completely up to the user—
background graphics, colors, fonts, and other design elements are not functions of STEP'n'design. However,
certain considerations need to bemadewith regard to how publication templateswork together with
STEP'n'design product templates and how graphical elements (such as textual styling that is driven by InDesign
paragraph and character styles) work along with corresponding configurations in STEP.
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This topic focuses on the following subjects specific to configuring a publication template for use with
STEP'n'design:

l Defining and configuring InDesign paragraph styles
l Defining and configuring InDesign character styles

l Loading styles from other templates (such as product templates or other publication templates)

l Defining and configuring InDesign swatches

Paragraph Styles in Publication Templates
Paragraph styles are used in publication templates in order to keep text styles consistent throughout a publication.
They are also required to apply text styles tomountedSTEP tables, but instructions on how to configure
paragraph styles for STEP tables are not covered in this topic. For more information, seeConfiguring Table
Styles in Publication Templates in theSTEP Tables documentation.
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The following screenshots show the application of standard InDesign paragraph styles to text on a product
template. These identical styles should be contained within the publication template in order to globallymanage
styles throughout the publication.

The following screenshot shows how a product mounted using this product template looks on a publication
template containing the same styles.

Note: Best practice is for publication templates to contain the identical paragraph styles that are used in the
product templates associated with the publication. It is possible tomount styled pageswithout using paragraph
styles, but this is not recommended because you will not be able to globallymanage the styles throughout the
publication.

If your styles are only defined in the product template but not the publication template, the styles will not be
imported into the publication template; instead, theywill be defined as [Basic Paragraph]+.
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Creating a Paragraph Style in InDesign

1. In InDesign, navigate toWindow > Styles > Paragraph Styles (or press F11). TheParagraph Styles panel
displays.

2. Click theOptions menu in the upper right corner of the Paragraph Styles panel, then clickNew Paragraph
Style.

3. On theNew Paragraph Style dialog, enter a style name, then clickOK to create the style.
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Character Styles in Publication Templates
InDesign character styles are used in conjunction with STEP style tags to apply formatting to characters
embeddedwithin paragraph styles. For example, a STEP style tag can be used with a corresponding InDesign
character style to bold a single word inside of a non-bold sentence.

Note: This topic does not explain how to create a style tag in STEP; only how to use pre-made style tags in
conjunction with InDesign character styles. For instructions on how to create and configure style tags in the STEP
Workbench, seeCreating Tags in theSystem Setup / Super User Guide documentation.

The following screenshot shows the bold character style applied to certain words embedded within a paragraph
style.
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This is picked up from the bold style tag created in STEP (left) and applied with the bold character style in
InDesign (right)

Note: STEP style tags are case-sensitive; therefore, the name of the style tag in STEP and the character style in
InDesignmust match exactly.

To apply this style in STEP, using a product object as an example:

1. On theProduct tab, navigate to the attribute value that you want to edit and select the attribute value field.
2. Right click and selectEdit to open the large value editor for the cell.
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3. In the value editor, highlight the word(s) to which you would like to apply a style, then click theStyle button.

4. In theStyle dropdownmenu, choose the style that you would like to apply. For this example, the bold style is
used.
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5. The style is applied to the word(s).

6. The product will mount as pictured in the first screenshot in this section.

Note: Style tags are not created in STEP for InDesign paragraph styles used in standard text frames. STEP style
tags are only used with InDesign character styles and for text that appears within STEP tables. See the
Configuring Table Styles in Publication Templates topic for more information.

Loading Text Styles From Another Template
If paragraph styles have already been defined in another InDesign document, these stylesmay be imported from
the other document in order to save time when setting up your publication template. The other InDesign document
does not need to be a publication template that was created using STEP'n'design; it can be any InDesign
document.

To load text styles from another InDesign document:

1. In InDesign, navigate toWindow > Styles > Paragraph Styles (or press F11) to open theParagraph Styles
panel.

2. Click theOptions menu in the upper right corner of theParagraph Styles panel, then clickLoad Paragraph
Styles. If you would like to load both Paragraph and Character styles from the other InDesign document,
select Load All Text Styles.
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3. In theOpen a File dialog that displays, navigate to the InDesign document that contains the styles that you
would like to import, then clickOpen.

4. In the Load Styles dialog, select the styles that you want to load. By default, all styles are selected. Use the
Check All /Uncheck All buttons depending on your needs.

5. If an incoming style conflicts with an existing style (meaning that an incoming and an existing style both have
the same name), text will appear in theConflict with Existing Style column.

ChooseAuto-Rename from the dropdown if you do not want to overwrite the existing style. ChooseUse
Incoming Definition if you want to overwrite the existing style and use the imported style.

6. ClickOK.
7. Repeat these steps to load styles from other documents to the publication template.
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Swatches in Publication Templates
Swatches are used in both publication templates and product templates to add color shading to frames and frame
borders, but their primary use is for applying colors tomountedSTEP tables. It is best practice to have the same
swatches in both your publication template and product templates.

Note: Swatches aremandatory in the publication template if mounting STEP tables. See theConfiguring Table
Styles in Publication Templates topic for more information.

The following screenshot shows a 'before and after' of a product mounted using a product template that employs
swatches to add color fill to the text frames and a border to the image frame.

Swatches are optional in publication templates unless tables are beingmounted. If youmount a product using a
product template that has swatches but a publication template that does not have swatches, the swatcheswill be
added to the publication template when the product ismounted.
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Storing and Editing Publication Templates
After creating your publication templates, you need to save them in the STEPWorkbench and, in order to use
them to build pages fromwithin your InDesign client, on your local computer.

Storing Publication Templates Locally
Publication templatesmust be saved locally (on your own hard drive or other locally accessible file location) before
they can be used tomount products fromwithin InDesign using standard 'drag and drop' functionality. Simply save
the templates as standard InDesign (.indd) files to a directory or folder on your machine.

Storing Publication Templates in STEP
Publication templatesmust be saved to STEP for the following reasons:

l At least one publication templatemust exist in STEP in order to create a publication. (The exception to this is
if you create a publication by using a Publication Excel import. However, the publication cannot be used until
a publication template is linked to it, as the Publication Excel import merely creates the publication structure.
See Importing Publications in Excel for more information.)

l Templates stored in STEP can be opened and edited by any user who has access to the same STEP
environment, in essence treating STEP as a 'cloud' storage solution.

l Publication templatesmust be stored in STEP in order to utilize Proof View functionality.

l Publication templatesmust be stored in STEP in order to use the Flatplanner and AutoPage components.

l Publication templatesmust be stored in STEP in order to create Flatplanner page templates in the
workbench

Note: For users who only use 'drag-and-drop' functionality to build InDesign pages, a 'dummy' publication
templatemay be saved to a publication in STEP instead of the actual 'mounting page.' This 'dummy' template
(whichmay be a blank page with no graphical elements) can be used solely to generate proof views in the
workbench, while actual pages are built in the InDesign client by dragging and dropping products onto themore
fully developedmounting page. See theGenerating Proof Views topic for more information.

To store a publication template in STEP:

1. Save the publication template on your local hard drive as a standard InDesign file.

Note: STEP will not let you save a template to the workbench unless it is first saved locally. However, once
the template is saved in STEP, youmay delete the local file if you do not plan on using it later for drag-and-
drop pagemounting.

2. Click on STEP > Save Document to DB ....
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3. TheSave Document to STEP Database dialog displays.
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4. Select the publication group where you would like to save the template.

Note: Templates can only be saved to publication group folders; they cannot be saved into publications or
section folders.

Determining which publication group to save your publication templates into is amatter of user preference.
Common choices are to save all publication templates in a publication group that is devoted solely to
publication templates, or to save publication templates in a publication group along with their associated
publication(s).

5. ChooseSave as Publication Template from the dropdown list near the bottom of the dialog.

6. Check theClose document and delete local copy box to delete the local copy of your template once you
save it to STEP.

7. ClickOK. The publication template is saved in STEP.
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Opening and Editing Publication Templates
If a publication template needs to be altered after it is saved to STEP, it must be opened from theSTEP Structure
View palette within InDesign. This is to ensure that your system recognizes the template as the original file, as
publication templates previously saved to STEP contain an embedded, 'hidden' STEP ID. If the template is
opened from a location on a local drive and resaved to STEP, the original file will not be overwritten—STEP will
recognize this template as a new file.

To open and edit a publication template:

1. Open theSTEP Structure View palette in InDesign.

2. Browse to or search for the publication template that you wish to edit.

3. Right-click on the template and selectOpen Document from themenu.

4. Make the necessary edits to the template, then save it on your local drive. (All templatesmust first be saved
locally before they can be loaded to STEP.)

5. Follow the steps outlined in the previous section of this topic ('Storing Publication Templates in STEP') to save
the template back to STEP. Make sure that you save the template back to the same location fromwhich it was
opened.

6. The updated template will overwrite the previous document on STEP and will not need to be relinked to any
publications or products.
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Sorting Templates in STEP
The sorting of publication templates, product templates, and page templates in the STEPWorkbench Tree is
determined by theManually Sorted setting on the publication group object type in which templates are stored
(which is typically 'Publication group root').

Automatic Sorting
IfManually Sorted is set toNo on the publication group object type, all template types shown in the STEP
Workbench Tree are grouped by type, with alphabetical sorting applied within each group. The default sort order is
as follows:

1. Product templates (in alphabetical order)

2. Page templates (in alphabetical order)

3. Master (publication) templates (in alphabetical order)

Manual Sorting
IfManually Sorted is set toYes on the publication group object type, templatesmay be sorted in a non-
alphabetical order. No additional configurations are required, as publication templates, product templates, and
page templates are not included as object types in SystemSetup.
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Note: Manually sorted templates still remain grouped by type (product, page, and publication) within the
publication group folder that contains them.

For more information about object type sorting in STEP, see theManually Sorted section of theSystem Setup /
Super User Guide documentation.
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Mounting Products
This topic describes the basic functionality of mounting one or more product objects onto a publication template by
the 'drag-and-drop' method using a STEP'n'design product template. When using a product template, you can
mount one or several products onto the page in one operation.

This topic does not explain:

l How tomount products using version layers. See theMounting Products to Version Layers topic for more
information.

l How to create and configure publication templates or product templates. See thePublication Templates
topic and theProduct Templates topic for more information.

l How tomount products using Flatplanner and AutoPage. See the respective user guides for these
components for more information.

l STEP Flatplanner user guide
l STEP AutoPage user guide

Note: Though objects other than product objects can bemounted onto InDesign pages fromSTEP (including
classification folders, entities, and green publication hierarchy objects themselves), the subtopics in this
documentation will refer to InDesign page layouts as 'product presentations' and objects to bemounted as
'products'. This is to streamline the language used in presenting this information.

This topic assumes that:

l You have already installed your STEP'n'design plugins and have connected to the relevant STEP environment
fromwithin InDesign.

l You have already created and configured a product template and publication template.

l You have already created a publication along with its relevant versions in the STEPWorkbench.

l You have a working knowledge of the STEP Structure View palette. For more information on this palette, see
theSTEP Structure View topic.

Setting Product Template Preferences in the STEP Preferences Menu
Beforemounting products, youmust determine what product template to use. The initial steps of the selection
process are configured in the STEP Preferencesmenu. The settings chosen vary on whether you will be using
product templates stored locally on your computer or product templates stored in STEP.

The relevant settings that determine which product templates are used inmounting are Template Path and
Server presentation.
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To set these preferences, follow these steps:

1. In InDesign, navigate to STEP > Preferences to open thePreferencesmenu.
2. If you will bemounting products using locally stored product templates, enter the path to the folder / directory

where your product templates are stored in the Template Path field. If you want to alwaysmount products
using locally stored templates, then selectNone from theServer Presentation list.

Note: ChoosingNone ensures that your product will alwaysmount with the local template chosen from the
'Template' dropdown in the STEP Structure View palette and override the default product template applied to
the product in STEP, if any.

3. To use product templates stored in STEP, select one of the following from theServer Presentation list:

l Product Default: Choose this to mount your product to the page using the default product template
assigned to it in STEP, regardless of what template is chosen locally from the Template dropdown list in the
STEP Structure View palette. If the product you aremounting does not have an assigned default template,
then the product will mount using the locally selected product template.

For information on how to assign a default product template, see theDefault InDesign Templates topic.

l Publication rules: Choose this to mount products using the product template specified by theObject
Layout pagination rules in STEP.When you choose a publication version tomount, the publication rules
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exist on the publication or publication section of the corresponding publication.

Choosing a Version
Beforemounting a product, youmust always designate fromwhat publication version you will bemounting data.
This is important because the system needs to know not only what publication you are building but fromwhat
context and workspace the product data should be pulled. You can either make a one-time selection of a
publication version, if you are certain that this is the version that you will be working with for an extended time, or
youmay configure STEP'n'design to prompt you to choose a version every time youmount a product. Having the
system prompt you for a versionmay be helpful if you plan to work with multiple versions or multiple publications in
one sitting.

To choose a publication version, and/or change the publication version in which you are currently working, follow
these steps:

1. In InDesign, Navigate to STEP > Change Version ....

2. On theChange Version dialog that displays, navigate to the publication version that you would like to use,
then clickOK.
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3. The selected version displays at the bottom of the STEP Structure View.
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Prompt for Version
To have STEP'n'design prompt for a version every time youmount a product:

1. In InDesign, navigate to STEP > Preferences to open thePreferencesmenu.
2. Tick thePrompt for Version box, then clickOK to close the Preferencesmenu.

Mounting the Product(s)
1. Open the STEP Structure View palette by navigating toWindow > STEP Structure View.

2. If using locally stored product templates, select the product template that you would like to use from the
Template list at the bottom of the palette.
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Note: The product templates in the dropdown list are the templates stored in the Template Path folder
designated in the STEP Preferencesmenu.

3. In the STEP Structure View tree, locate the object that you would like tomount.

To locate an object in the STEP Structure View, either browse through the tree or click on themagnifying glass
icon in the lower left corner of the palette to display theSearch dialog. The Search dialog can also be accessed
by clicking theOptions dropdown arrow in the upper right corner of the panel.

4. Select the object, then hold down the left button of your mouse while you drag it to the desired location on the
page.
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5. Tomount several products in one operation, hold downCtrl or Shift while making your selections in the STEP
Structure View tree. Products will bemounted sequentially.

Note: Your multi-selectionmust be within the same classification or product family.

A gap will be placed between the products based on what was entered in theMulti-place Gap field in the
STEP Preferencesmenu.

If the product data exceeds the available space on the column or page or column, STEP’n’design can be
configured to flow the data into next column or page by splitting a frame, or group of frames, across the column
or page. These split settings are applied to product template frames on the STEP Template Frame palette. See
theSTEP Template Frame palette topic for more information.

6. Release themouse button where you would like to drop the product onto the page.

7. If you selected 'Prompt for Version' in the STEP Preferencesmenu, theChoose Version to Mount dialog will
display when you release the left button of your mouse. Select the desired version, then clickOK to close the
dialog andmount the product.
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8. Once dropped, the product ismounted to the page, using the layout and formatting from the product template.

Remounting Products
After mounting a product onto a page, you can remount it using a different product template by using theReplace
selected object with template selected command. This command enables you to keep themounted product on
the page and change its layout without having to delete it from the page and remount it anew.

To use this command, follow these steps:

1. In theSTEP Structure View palette, navigate to the product that you would like to remount.

2. Select the new template from the Template dropdown list.
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3. SelectPlace, thenReplace selected object with template selected.

4. The product is remounted using the selected template.
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Unmounting Products
Sometimes after mounting a product onto the publication template / mounting page, it must be unmounted.
Objects are frequently removed from pageswhen testing product templates, but they can be removed at any point
in the production process.

Once a product ismounted onto a page fromSTEP, information about themounted object is embedded into the
XML Structure in InDesign. However, unmounting a product involvesmore steps than simply deleting it from the
page.When amounted product is deleted, STEPXML tags still remain in the InDesign XMLStructure, even
though the visible data is gone from the page. Leftover STEPXML tagsmean that historical data is still embedded
on pages, and these leftover tags can cause issues such as:

l Attribute transformations not working correctly when a new product ismounted

l Problemswith updating product data on the page, since the systemwill 'see' data on the page that is not
actually there

l Miscalculations of space usage for products on pages

l Amixture of publication versions on the same page, since version information is embedded in the XML tags

l Unwanted products appearing in indexes

l Inflated file size from the amount of broken and unusedmount tags building up in the background

Note: To view the XMLStructure in STEP'n'design, pressCtrl+Alt+1 inWindows or go to View > Structure >
Show Structure.

There are three ways to properly unmount a product and clear the InDesign XML structure.
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Undo
After mounting a product, if you decide that you are unhappywith the results and would like tomount it again, or,
you are testing on a publication template and want to return to a clean slate after mounting, perform one of the
following actions:

1. PressCtrl+Z onWindowsmachines or Cmd+Z onMacs.

2. Go to Edit > Undo STEP Drag/Drop.

Delete Mounted Object and Cleanup Mount Tags

1. Delete themounted product(s) from your page. If your product hasmounted onmultiple pages, youmust
delete the entire product presentation from all pages that it appears on, not just the portion that appears on the
first page.

2. Go to STEP > Cleanup Mount Tags

3. The XMLStructure is now cleared.
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Unplace selected object
Use theUnplace selected object option to delete a product from the page and remove the STEPXML tags from
the structure in one action. This option only works on one product at a time.

1. Navigate to themounted product in the STEP Structure View.

2. Right-click and select Place > Unplace selected object.

3. Themounted object is removed from the page and all associated STEPXML is removed from the InDesign
XMLStructure.
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Sequencing Images in InDesign
Assets can bemounted in a specified sequence on InDesign pages by using anAsset Order Meta-attribute that
is valid on the link between products and image reference types. This attribute is used for asset reference types
that allow for multiple references.

If there aremultiple references from a product to various images using the same reference type (for example,
'Product Images'), and the product template calls out the Product Images, then all of the imageswill mount to the
page. However, without configuring an asset order meta-attribute to control their sequence, theywill mount in the
alphabetically / numerically sorted order that they appear in the workbench.

This topic explains how to create and configure an asset order meta-attribute, how to configure image frames on
product templates tomount multiple images at one time, how to tile these images, and how to sequence them.

Creating and Configuring the Asset Order Meta-attribute
If your system does not already have an attribute that is dedicated for use as the asset order meta-attribute, you
can create this attribute with the following steps.

1. Create a description attribute following the steps outlined in theCreating Attributes topic in theSystem
Setup / Super User Guide documentation. A suggested location for the attribute is within a 'Metadata' folder.

2. The following screenshot shows an attribute with a STEP ID of ImageDisplaySequence and a name of
Image Display Sequence. It is recommended to give the attribute an easily identifiable ID and name so it will
not be confused with other sequencing attributes, such as an attribute display sequence attribute. The same
attribute cannot be used for both image display and attribute display.The attributemust have a Type of
Description and a Validation Base Type ofNumber.
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3. On theValidity tab for the attribute, make the attribute valid on the asset reference types that you will be using
it for. In this example, the Image Display Attribute is valid on the Product Images reference type.
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4. The attributemust also be placed into an attribute group that contains the relevant asset reference type(s) for
which the attribute is valid.

5. TheView Definition for the attribute group that contains the asset order meta-attribute and associated asset
reference typemust be configured to display the asset order meta-attribute on the links between the assets
and the product on theReferences tab in the workbench. For details on how to configure a view definition for
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an attribute group, see theAttribute Groups topic in theSystem Setup / Super User Guide
documentation.

6. After the View Definition is configured, the Image Display Sequence attribute will be visible on the References
tab of your product on the link between the product object and the assets. The below screenshot shows seven
images linked to the product using the Product Images reference type and a column containing the Image
Display Sequence attribute.
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7. In order for the sequencing attribute to take effect on InDesign pages, the attributemust be designated as the
Asset Order Meta-attribute in SystemSettings.

l Navigate to SystemSetup > Users & Groups, SystemSettings, then expand theDTP Settings flipper.
l Click the ellipsis button (…) in theAsset Order Meta-attribute field.
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l In the Asset Order Meta-attribute dialog that displays, browse to or search for the asset ordering attribute,
then clickSelect.

l The attribute is now set as the system-wide asset order meta-attribute.
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Setting the Sequence of Images in STEP
Once the Image Display Sequence attribute is available on the References tab and has been set as the asset
order meta-attribute, the next step is to designate the order in which you would like the images tomount.

1. Navigate to your product object in the Tree, then click on theReferences tab.
2. Enter numbers in the asset order meta-attribute fields (in this example, Image Display Sequence) to designate

the order in which you would like the images tomount.

In this example, seven product images are ordered in increments of 10. Thismethod of numbering is best practice
in case the images need to be rearranged later or if a new image needs to be added to the group. For example, if
an image is added later but needs tomount in the third position, it can be numbered 21 and the numbering on the
other images can be left as-is.

Tiling Images in Individual Frames on InDesign pages
Once the asset order meta-attribute has been created and configured, the next step is to configure the image
frame on your product template to tile multiple assets across the page. These configurations are applied using the
STEP Template Frame palette.

Configuring the Product Template to Tile Image Frames
The following steps assume that you have already created a product template with an image frame, the template is
open in InDesign, and theSTEP Template Frame palette is also open. For more detailed information on all
available options on STEP Template Frame palette for image frames, see the Image Frame Parameters topic.

1. Select the image frame on your product template, then click on theAsset Content dropdown list and select
'Asset Content.' If adornments are visible on your template, the framewill display stibo.asset.content.
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2. Next, click on the Data Source dropdown list and select the desired asset reference type, for example,
Product Images.

3. The following STEP Template Frame parametersmust also be applied to the image frame. The numbers in the
following screenshot correspond to the numbers in the list below the screenshot.
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l (1) Select aSplit setting to determine what should happen if there are somany images that they tile off of the
page whenmounted. In this example, the split setting of 'Anywhere' means that a new page will be created if
the images cannot fit on one page.

l (2) The selections chosen forAsset Sizing, Scale, Size Frame to Asset, andAsset Alignment are up to
the user. In this example, the settings ensure that the assets will be scaled to the size of their frames and
centered within the frames.

l (3) The Tile across checkboxmust be selected in order for the images to tile horizontally across the page. If
left unchecked, the imageswill mount vertically.

l (4) AMax Distancemust be entered to tell the system how far across the page the images should tile before
wrapping around to a second row. If no distance is set here, the imageswill tile off of the edge of the page if
there are toomany to fit in a single row. Max distance starts at the left edge of the image frame and ends at
the point where you would like the tiling to start over on a second row.

Onemethod of determiningmax distance is to draw a line on the product template that alignswith the left
edge of the image, then enter the length of that line into theMaxDistance field. Delete the line once you have
determined its length.
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l (5) A Gap distancemust be set if you would like space to appear between the image frameswhenmounted.

Note: TheGap distance should be factored in when settingMax Distance.

4. When the product ismounted, the images appear in the location on the page designated by the template and in
the order specified in STEP. See the Mounting Products topic for more information on how tomount objects
to InDesign pages.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 197



Sequencing Grouped Image Frames
Image frames that are part of tiled grouped frames, which are commonly used tomount imageswith metadata
captions, can also be sequenced using the steps outlined in this topic. For information on images in grouped
frames, see theMounting Images With Metadata Captions topic.

Tiling Multiple Images Within a Single Frame

Note: Image sequencing works the samewhether images are tiled within a single frame or in individual frames.

Multiple images can be tiled within a single frame using theMulti Asset Across function. In order for images to be
tiled, all imagesmust be of the same asset reference type and the asset reference typemust allow multiple
references.

Typically, image sequencing for multiple images in a single frame is used for small icons that need to be
sequenced in a certain order. This example uses a kitchen sink product that appears on the page along with icons
indicating that the faucet meets the following compliance standards: ADA, Cal Green, NSF Lead-Free, and EPA
WaterSense. An asset reference type named Icons is used.
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Configuring the Product Template Image Frame

1. Select the image frame on your product template, then click on theAsset Content dropdown list and select
the desired asset reference type, for example, Icons.

2. If not automatically selected when you chose the asset reference type, click on the Data Source dropdown list
and chooseMount Object.

3. The following STEP Template Frame parametersmust also be applied to the image frame. The numbers in the
following screenshot correspond to the numbers in the list below the screenshot.
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l (1) The selections chosen forAsset Sizing and Max Scale are up to the user. In this example, the settings
ensure that the assets will be imported at actual size (100%). Best practice when using small images such as
icons is to load them into STEP at the actual size theywill appear on the page. However, if they are not
actual size, they can be scaled to be either smaller or larger by changing theScale value. (Note that this will
apply equally to all images in the frame.) For more information on asset sizing parameters, see the Image
Frame Parameters in the STEP Template Frame Palette topic.

l (2) The selections chosen for Size Frame to Asset andAsset Alignment are also up to the user. In this
example, the settings ensure that the frame remains its original size and that the icons are aligned to the left.

l (3) TheMulti Asset Across checkboxmust be selected in order for the images to tile horizontally across
the frame. If left unchecked, the imageswill mount vertically.

l (4) AMax Distance can be entered to tell the system how far across the frame the images should tile before
wrapping around to a second row. 0 is the default. If no distance is set here, the imageswill tile to the edge of
the frame, then wrap around to a second row automatically. Max distance starts at the left edge of the image
frame and ends at the point where you would like the tiling to start over on a second row.

l (5) A Gap distancemust be set if you would like space to appear between the tiled images.

4. When the product ismounted, the images appear in the frame in the order specified in STEP.
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Mounting Images With Metadata Captions
To keep the number of caption attributes at aminimum in STEP, imagemetadata captions are commonly used.
Imagemetadata captions are description attributes that aremade valid for Asset Reference types. As such, they
exist on the link between products and assets.Grouped frames are used on product templates tomount these
captions along with their corresponding images onto InDesign pages.

Usingmetadata captions for images keeps the number of caption attributes low because a singlemetadata
attribute can be used, for example, on seven images that are linked to a single product, as opposed to needing
seven different caption attributes. Another advantage to using caption attributes that are valid for an asset
reference type, as opposed to using a description attribute that is valid on the asset type itself, is that the caption is
not attached to the asset, and can change from product to product that the image is linked to.

Configuring a Metadata Caption Attribute
Metadata image caption attributes are created and configured like any other description attribute that ismade valid
on an asset reference type. If your system does not already have attribute(s) that are being used for image
captions, you can create themwith the following steps.

1. Create a description attribute following the steps outlined in theCreating Attributes topic in theSystem
Setup / Super User Guide documentation. A suggested location for the attribute is within a 'Metadata' or
'Asset Metadata' folder.

2. The following screenshot shows a sample attribute with a STEP ID ofCaption1 and a name ofCaption 1.
The attributemust have a Type ofDescription.
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3. On theValidity tab for the attribute, make the attribute valid on the asset reference types that you will be using
it for. In this example, the Caption 1 attribute is valid on the 'Primary Product Image' and 'Product Images'
reference types.

4. Lastly, the attributemust be placed into an attribute group that contains the relevant asset reference type(s) for
which the attribute is valid. This attribute groupmust have itsView Definition configured to display the caption
attribute on the reference links between the assets and the product on theReferences tab in the workbench.
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For details on how to configure a view definition for an attribute group, see theAttribute Groups topic in the
System Setup / Super User Guide documentation.

5. After the View Definition is configured, the caption attribute will be visible on theReferences tab of your
product on the link between the product object and the asset(s). The below screenshot shows the Caption 1
attribute on the link between the product object and the asset linked with the Primary Product Image asset
reference type.

Configuring the Product Template to Mount a Metadata Image Caption
Once the image caption attribute has been created and configured, the next step is to configure a grouped frame
on your product template that contains an image frame for the asset and a text frame for the caption. These
configurations are applied using theSTEP Template Frame palette.

The following steps assume that you have already created a product template with an image frame and a text
frame (which contains the STEPXML tag for the caption attribute), the template is open in InDesign, and the
STEP Template Frame palette is also open. For more detailed information on all available options on the STEP
Template Frame palette for image frames, see the Image Frame Parameters topic. For more detailed
information on all available options on the STEP Template Frame palette for grouped frames, see theGrouped
Frame Parameters topic.
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1. Select the image frame on your product template, then selectAsset Content from the Asset Content
dropdown list on the STEP Template Frame palette. This setting tells the system that the framewill contain
asset content, but does not designate the asset reference type itself because it will be applied to the entire
grouped frame in step 3 below.

2. Group the image and text frames together by following the instructions in theGrouped Frames in Product
Templates topic.

3. Choose the relevant asset reference type from theData Source dropdown list. In this example, the Primary
Product Image reference type is used. Applying the reference type to the grouped frame instead of the image
frame inside of the group tells the system that everything in the group will be pulled from this asset reference,
including the caption attribute in the text frame.
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4. When the product ismounted, the image caption will appear beneath the image on the page. See
the Mounting Products topic for more information on how tomount objects to InDesign pages.

Sequencing Grouped Image Frames
Image frames that are part of grouped frames can also be tiled and sequenced on the InDesign page when the
product to which the imaegs are linked ismounted. For information on sequencing images in InDesign, see the
Sequencing Images in InDesign topic.
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Mounting Product References
Themethod of configuring a product template tomount data from product references is similar to themethod used
tomount imageswith metadata captions, detailed in theMounting Images With Metadata Captions topic.

The example shown in this topicmounts a product object (LED Pocket Flashlight) and an associated item (AA
Batteries) using a product reference type of 'Accessory Required'.

Configuring the Product Template to Mount Data from a Referenced Product
Tomount data from a product object that is referenced to the object that you aremounting, certain configurations
must be applied to the frame(s) on your product template using the STEP Template Frame palette. For detailed
information on this palette, see theSTEP Template Frame topic.

The following steps assume:

l You have already created a product template, and it is open in InDesign

l A text frame exists that contains STEPXML tags for the attribute(s) that you wish to display from the referenced
product

l The STEP Template Frame palette is open

l You are familiar with the process for mounting objects to InDesign pages (see the Mounting Products topic
for more information)
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Mounting Textual Content From a Referenced Product
The product template used in this example is configured to pull in the STEP name, Primary Product Image, and
Long ItemDescription attribute value from the product beingmounted. A second frame, directly to the right, is
configured to pull in the STEP name and Long ItemDescription attribute value from the referenced product.

Tomount textual content from a referenced product:

1. Select the frame on your product template that contains the STEPXML attribute tags for the data that you wish
tomount from the referenced product.

2. Select the relevant Product Reference from theData Source dropdown list on the STEP Template Frame
palette.

3. When the product ismounted, the data from the referenced product (AA Batteries) appears in the frame that
was configured to bring in data from the Accessory Required product reference.
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Mounting Textual and Asset Content From a Referenced Product
The following steps build on the procedure outlined in the previous section, except an asset framewill be added
and grouped with the text frame tomount an asset that is linked to the referenced product.

1. Add an image frame to the product template and apply the relevant asset reference type to the frame, which is
Primary Product Image in this example.
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2. Group the image framewith the text frame following the instructions provided in theGrouped Frames in
Product Templates topic.

3. Select the grouped frame, then select the relevant Product Reference from theData Source dropdown list on
the STEP Template Frame palette.

4. When the product ismounted, the textual and asset data from the referenced product (AA Batteries) appears
on the page.
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Attribute Transformations in InDesign
Attribute transformations are frequently used in STEP'n'design product templates to change the value of an
attribute on amounted InDesign page into another value, typically into another word or an image. Attribute
transformations used with STEP'n'design are created in STEP in the sameway as those used for other purposes.
The difference for print is that these transformationsmust also be applied to attribute tags on the product template.

This topic does not describe, in depth, how to create attribute transformations in the STEPWorkbench. It focuses
on attribute transformations intended for InDesign pages. For more information on attribute transformations in
general, see theAttribute Transformations topic in theSystem Setup / Super User Guide documentation.

Using an Attribute Transformation to Transform Text in InDesign
A common application for attribute transformations in InDesign is to transform a value of 'Yes' into another word.
For example, an attribute could indicate whether a product is new or exclusive by having a value of either Yes or
No. If the product is new, the value of 'Yes' ismounted on the page, then transformed into the word 'New!'.

The following steps explain how to change an attribute value of 'Yes' into the word 'New!' on an InDesign page
using an attribute transformation. The attribute used in this example is named 'Is New?'. This attribute has a
validation base type of LOV and uses a Yes/No LOV. If the value is 'No,' then the value will be replaced with
nothing, and the text framewill be automatically removed from the page. The removal will occur because the
'Delete no Content' parameter is applied to the text frame on the product template that contains the transformed
attribute.
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1. In SystemSetup, create an attribute transformation following the instructions outlined in theAttribute
Transformations topic in theSystem Setup / Super User Guide documentation. In this example, the
transformation has a STEP ID of 'NewItem' and a STEP name of 'New Item'.

2. Click 'Add Transformation' to launch theSelect Transformation dialog. In this example, the 'Replace the
whole value' transformation is chosen. ClickOK.
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3. Type 'Yes' into theReplace field and 'New!' in thewith field.

4. Click 'Add Transformation' again and choose 'Replace the whole value' again.

5. In the second transformation row that displays, type 'No' in theReplace field and delete the 'y' in thewith field
to leave the field blank.
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6. Expand the 'Applies To' flipper and clickAdd Attribute.

7. Browse to or search for the relevant attribute in the 'Please Select Attribute' dialog, then click Select.

8. The transformation is now applied to the attribute.

If you have an LOV with a large number of values that need to be transformed, best practice is to replace all the
values using a lookup table instead of creating a separate transformation for each value. For more information on
lookup tables, see theCreating a Transformation Lookup Table and Transformation Lookup Table
Example topics in theData Exchange documentation.

Applying the Transformation to the Product Template
The next step in getting the transformation to work on themounted InDesign page is to apply the transformation to
the relevant attribute tag on the product template. The following steps assume that you have already created a
product template and that the STEP Template Content palette is open.
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1. Create a frame on the product template containing the attribute that you applied your transformation to in the
workbench. For this example, the attribute is 'Is New?' and the text has been styled bold red within the product
template.

2. With your cursor inside the STEPREF tag, enter the name (not ID) of the relevant attribute transformation in
the Transformation field on the STEP Template Content palette and then press Enter. The STEPREF tag on
the product template will update with the ID (not name) of your attribute transformation, preceded by the letters
TN=, as shown below:

3. To ensure that the text frame is removed from the page if the value is 'No,' apply theDelete No Content
parameter to the frame using the STEP Template Frame palette. For more information on this parameter and
palette, see theSTEP Template Frame topic.
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Testing the Transformation
To ensure that the transformation is working, mount a product using the product template to which you just applied
the transformation. If the transformation has not been applied to the attribute correctly, either in STEP or on the
product template, the untransformed value will display (in this example, either 'Yes' or 'No').

Testing the Yes Value

1. Locate a product object in STEP for which the 'Is New?' attribute is valid andmake sure that the value of the
attribute is 'Yes.'

2. Locate the object in the STEP Structure View in InDesign and drag it onto the publication template.

3. The word 'Yes' displays as 'New!'

Testing the No Value

1. Locate a product object in STEP for which the 'Is New?' attribute is valid andmake sure that the value of the
attribute is 'No.'

2. Locate the object in the STEP Structure View in InDesign and drag it onto the publication template.

3. The frame containing the 'Is New?' attribute is removed from the page and no frame appears.
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Using an Attribute Transformation to Transform Text Into an Image in InDesign
Another common application for attribute transformations in STEP'n'design is changing a value into an image. For
example, an attribute with a Yes/No value could indicate whether a product meets certain criteria that would
require an icon to display beside the product.

For this example, the fictional company Acme Faucets sells products that are expected to comply with certain
industry and/or government certification standards. Icons appear on the page next to the products that meet these
standards. Attributeswith Yes/No values are used to control whether or not these icons display. The icons indicate
whether the faucetsmeet the following compliance standards: ADA, Cal Green, NSF Lead-Free, and EPA
WaterSense.

Instead of using image reference types tomount these icons onto the page, an attribute transformation changes
the value of 'Yes' into the corresponding icon.
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Themethod for transforming an attribute value of 'Yes' into an image on an InDesign page is nearly identical to
that used to transform one value into another.

1. Follow steps 1 and 2 from the 'Using an Attribute Transformation to Transform Text in InDesign' section above
to create the attribute transformation and apply the 'Replace the whole value' transformation.

2. In the 'Yes' field of the transformation, enter a tag that references the ID of the image that should appear on the
page. The following format is used: <img src="step://asset?id=ADA_Icon">.

ADA_Icon is the ID of the image used in this example:
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3. Apply the transformation(s) to the attribute(s) on the product template following the samemethod outlined in
the 'Applying the Transformation to the Product Template' subsection above. For this example, the frameswill
look as follows. (All of the transformation tag text does not have to be visible in the frame; the font size has been
reduced for this image to display the full text for illustration purposes.)

4. For the attributeswhose values equal 'Yes,' the corresponding icon will mount in the frame. Since the text used
in the attribute frames is centered and top-aligned, so are the icons.
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5. If the attribute value is 'No,' the icon will not mount and the framewill be removed from the page. This requires
applying the 'Delete NoContent' parameter to the text frame, as detailed in the 'Applying the Transformation to
the Product Template' subsection above.
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Scaling Images in Transformations
Often, images used in a transformationmay be larger than the frames into which the image will display. However,
since these images appear in text frames instead of image frames, the scaling parameters available for image
frames on the STEP Template Frame palette (e.g. 'Scale Asset to Frame') are unavailable.

Though best practice is for the original image to be loaded into STEP at the actual size that is needed, actual-size
images are not always available. If the image available in STEP is too large for the frame, the image can be
resized within the transformation by adding a dimension value of eitherwidth or height to the end of the 'img src'
transformation tag. The applied dimension is in points. For example:

<img src="step://asset?id=CalGreen_Icon_Large&width=17">

or <img src="step://asset?id=CalGreen_Icon_Large&height=17">

Note: The transformation tag will accept a value of width or height but not both. However, the image will be sized
proportionately regardless of whether width or height is used.

Determine the width / height that you need by changing your measurements in InDesign to points, then selecting
the frame.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 220



In this example, the transformationmakes the image 17 points wide to give it 1 point of padding inside the frame.

Once the attribute value is transformed, the image is 17 points wide and alignswith the frame identically to how the
text was originally placed in the frame. I.e., if the text was centered and top-aligned, the image is aswell.
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Using the Repeat Function for Subproducts
The STEP'n'design repeat functionSTEPREPEAT is used tomount attributes, asset references, tables, or any
other values from child objects of a parent object by repeating the STEPXML tags for subproducts. For example, if
mounting a product family, the repeat function STEPREPEAT is used to pull data that exists on the child products
of the family. In addition to child product objects, this function can also be used tomount data from child objects
within the classification structure or the publication structure.

As an alternative to creating a table in STEP, the STEPREPEAT function can repeat a range of attributes for the
subproducts of the product beingmounted. This can enable you to create a simple, table-like structure on your
InDesign page where every subproduct has its own row. However, to make the datamore closely resemble a
table, additional formatting would need to be applied, and STEP tables providemore complex formatting options.
For information on STEP Tables, seeAbout STEP Tables in the Tables documentation.
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The STEPREPEAT function is also used to create tables of contents / section indexes, typically in AutoPage
publications. For more information, seeCreating Tables of Contents in AutoPage in theAutoPage
documentation andCreating a Table of Contents Product Template in theSTEP'n'design documentation.

Configuring the Product Template to use the Repeat Function
This topic assumes that a product template has already been created with a frame that contains the STEPXML
tags for the attributes that should bemounted from the child objects. In this example, the original frame on the
product template—before the repeat functionality is applied—looks like the following and contains free text values
along with three attributes: 'ProductName,' 'ManufacturerName,' and 'CountryOfOrigin.'

The parent object that will be used in this example is 'HolidayHats.' One of its child objects, 'Christmas Party Hat,'
is pictured below in the STEPWorkbench. The values for 'ProductName,' 'ManufacturerName,' and
'CountryOfOrigin' are outlined in red.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 223



Before applying the repeat functionality to the template, and when onlymounting a child product, themounted
page looks as follows. The goal of applying the STEPREPEAT functionality to the template will be tomount the
same attribute data from the other child objects in the parent folder.

Applying the STEPREPEAT Function to Product Template Tags

1. On your product template, expand the InDesign text frame containing the STEP tag(s) that you would like to
repeat.

2. Using the InDesign Text tool, select the XML tag(s) within the frame that you would like to repeat. One or more
STEPXML tags can be selected.

3. With the tags selected, right-click and selectRepeat Selection.
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4. In theRepeat Selection dialog that displays, there are numerous options that can be configured to control
how the repeated content appears on the page. ClickOK when you have finished configuring your selections.
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The options and their descriptions are as follows. For more information on the options that are identical to
those present on the STEP Template Content palette, see theSTEP Template Content topic.

l Delete Before + Delete After: If a mounted attribute is empty, STEP’n’design can be configured to
remove a number of characters either before or after the location where the attribute should have been
placed. This setting is identical to the 'Delete Before' and 'Delete After' options that appear on the STEP
Template Content palette.

l Fail Text: If an attribute does not contain a value for the product you aremounting, you can use this field to
insert text that should appear on the page instead of a blank space or frame. This setting is identical to the
Fail Text option that appears on the STEP Template Content palette.

l Repeat Separator: Enter the repeat separator string or character that will separate the repeated values
('rows') on the page. Themost commonly used separators are \n (hard return), \r (soft return), and \t (tab),
though the character can be as simple as a comma.

l Line Styles: Allows you to assign specific InDesign styles to the 'rows' in the 'table' created by the repeat
function. Choose which InDesign paragraph style to apply to each 'line' of the repeated attribute values.
These are not the same as table rule line settings. The styles in the line style dropdowns are populated by the
InDesign paragraph styles present in the product template.
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l Data Filter: Available options areSections Only - Sort by Section Name andSections Only - Sort by
Page Number. Used whenmounting publication or section objects to pull information (such asmetadata
attribute values or section names) from child sections / subsections. This functionality is used in publications
(typically AutoPage) to create tables of contents / section indexes. See theCreating a Table of Contents
Product Template topic for more information.

5. Once all options have been configured on theRepeat Selection dialog, the product template will resemble the
following. The STEPREPEAT tag has been placed at the beginning and end of the selected tags. The
paragraph style 'Blue Text' has been selected as the Even Line Style (ELS), and the hard return (\n) has been
selected as the repeat separator (RS).
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Mounting a Product Using the Repeat Function
A parent product object will bemounted using the product template configured with the STEPREPEAT option.

The following steps assume that you have already selected the relevant product template from the Template
dropdownmenu in theSTEP Structure View palette and that you have already located the product that you want
to mount. Additionally, it assumes that you already have a publication template / mounting page created and
configured.

1. Drag the parent product object onto the publication template / mounting page following the instructions outlined
in theMounting Products topic.

2. The attributes specified on the product template aremounted from each child product. In the below example,
every other 'line' of text—the even lines—aremounted in blue text, and each line is separated by a hard return.
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Mounting Commercial Data
This topic explains how to configure a product template to bring in commercial data values (terms) fromSTEP and
mount these values onto InDesign pages.

There are two ways tomount commercial data onto an InDesign page—through a product template and through
a table. This topic describes the product templatemethod. For information on how tomount commercial data in
tables, see theCommercial Data Content Definitions topic in the Tables documentation.

The following four aspects of a commercial data terms list can bemounted on an InDesign page: Maximum
Quantity, MinimumQuantity, Unit, and Value.

Note: Though commercial terms lists also contain a Start Date and an EndDate, these cannot bemounted using
the aspects in the STEP Template Content palette. Additionally, themetadata 'Default Start-date' and 'Default
End-date' attributes available on commercial lists also cannot bemounted. Datesmust bemounted using another
list that contains the date value within the value field.

Incorporating Commercial Terms Into a Product Template
Themethod for placing commercial data aspect tags onto a product template from the STEP Template Content
palette is identical to that of placing any other attribute tag onto a product template. See the Text Frames in
Product Templates topic for more information on the steps for actually placing the information on the template.
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The following screenshots explain how the different aspects of commercial data display on the product template.
All commercial term tags are designated byTP, whichmeans 'Commercial Term (Price) Property.'

Value
The Value element appears on the product template as TP="1".

Minimum Quantity
TheMinimumQuantity element appears on the product template as TP="2".

Maximum Quantity
TheMaximumQuantity element appears on the product template as TP="3".

Unit
TheUnit element appears on the product template as TP="4".
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Price Number
A Price Number (PN) must be designated for every commercial data tag.

The price number determineswhich price break is being referred to when there ismore than one term for the
same product on a single commercial terms list. Price number is the order in which the terms appear in the list. The
below screenshot indicates Price Number 1, Price Number 2, and Price Number 3. Price numbers typically
indicate price breaks; for example, price 1 will be the retail price, price 2 will be a discounted price for a larger
quantity, price 3 will be an even lower price for an even larger quantity, and so forth.
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Price Number is also the same as the value chosen forGroupwhen commercial data is imported. See the
Defining Import Settings for Commercial Data topic in theCommercial Data documentation for more
information.

Mounting a Product With Commercial Terms
The following sample product template is configured tomount three terms for a single product. The tags for Value
are in black text, the tags for Unit are in pink, and the tags for MinimumQuantity andMaximumQuantity are in
blue.
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The product, 'Pink & Green Party Hat,' has three terms in the 'Price' terms list type. Price 1 is $5.99; price 2 is
$4.99, for aminimumof 12 andmaximumof 23 pieces; and price 3 is $3.99, for aminimumof 24 pieces and
maximumof 35 pieces. (Note that the product template has not been configured to pick up theminimumand
maximumquantity values from price 1.)

Note: Beforemounting the product, make sure that your commercial data lists aremapped to the publication
version that you are using to build your page. For more information, seeMapping a Publication Version Using
Commercial Data in theCommercial Data documentation.

Themounted product appears as follows:
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Mounting Multi-Valued Attributes and Attribute Groups
This topic describes how to configure a product template tomount multi-valued attributes and attribute groups.
The setup for both is similar, asmultiple values are placed onto the page at once, and repeat separators can be
configured to separate the values. Additionally, whenmounting attributes from an attribute group, a sequencing
attribute can be configured to control the order that the valuesmount on the page.

Mounting Multi-Valued Attributes
The following screenshot shows an example of amulti-valued attribute in STEP.

An attribute with multiple values is placed onto a product template by the samemethod used to place any other
attribute onto the template. The difference in configuration between a single-valued and amulti-valued attribute is
that a repeat separator can be applied to the attribute to control the separation of the values on the page.

By default, the values of multi-valued attributes appear on themounted page separated by hard returns. Pictured
below on the left is a sample product template with a tag for amulti-valued attribute without a repeat separator
applied to the tag. On the right is amounted product with the values of the attribute separated by hard returns.
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If more space should be placed between the values, or if a different separator should be used, then a repeat
separatormust be set. Common repeat separators are \n (hard return), \r (soft return), or \t (tab), though a
separator can be as simple as a comma. In the following example, two instances of the hard return (\n) have been
added to insert another paragraph break between each value. The first screenshot shows the repeat separators
added to the tag. The second screenshot shows the same product mounted, but with the additional hard returns
between the values.
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Adding a Repeat Separator
To add a repeat separator to the tag:

1. Using the InDesign text tool, place your cursor inside of the relevant tag on the product template.

2. On the STEP Template Content palette, enter a repeat separator character into theRepeat Separator field.
3. PressEnter to apply the separator to the tag.

If additional styling is desired, such as bullets, then these can be configured with an InDesign paragraph style.

Mounting Attribute Groups
If multiple attributes are needed on a page, and all attributes are within the same group, then an easier andmore
dynamic setup for the product presentation is to mount the entire attribute group. This reduces the setup involved
in adding separate tags for each attribute. Additionally, as attributes are added to or removed from the group in
STEP, themounted data can be updated to ensure that only values from the attributeswithin the group are
displayed.

In this example, a small group with only three attributes is used.
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On product templates, a tag tomount values from an entire attribute group can be placed into a frame, as opposed
to themore common practice of placingmultiple attributes into the frame.

When an object ismounted onto an InDesign page using a product template containing this type of tag, the values
from all attributeswithin the group aremounted.

If a repeat separator is not set on the attribute group tag on the product template, the valueswill mount together
without a separator at all.

To apply a repeat separator to the attribute tag, follow the same steps used to add a separator to themulti-valued
attribute tag, outlined above in the 'Adding a Repeat Separator' section.
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With a repeat separator added (in this example, \n\n), the valuesmount as pictured below:

Attribute Display Sequence for Print Output
Whenmounting values from an attribute group, the valueswill bemounted in the order that the attributes appear
within the attribute group. This is typically in alphabetical order, unless the attributes have beenmanually sorted
previously. If you need the attributes tomount in a specific order on the page, anAttribute Display Sequence
attribute is used. This is not configured on the product template; it is set up in the workbench.

Note: The 'Attribute Display Sequence' setting under DTP Settings isnot the same as the 'Default Attribute to
use asDisplay Sequence Attribute' setting under 'Product InformationManager Default Settings.' The attribute
chosen for 'Default Attribute to use asDisplay Sequence' is used to sort the order of attributes as they display in
the STEPWorkbench. The 'Attribute Display Sequence' setting is solely used to control the order of attribute
group values onmounted InDesign pages. The values added for a print attribute display sequence attribute do
NOT affect the order that the attributes display in the workbench product editors.
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An attribute display sequence attribute is created and configured in a near-identical fashion to the display
sequence attribute used to control the order of attributes in the STEPWorkbench. This topic describes how to use
an attribute display sequence attribute for print output but not how to create the attribute itself. For information on
how to create an attribute sequencing attribute, see theAttribute Display Sequence section of theAttributes
documentation.

In this example, an attribute named 'Print Display Sequence' is used.

In the ItemDescription Information attribute group, the attributes are arranged alphabetically.

To set themounting order on the attributes, locate the attributes in System setup and add the relevant numeric
values. For this example, Product Namewill mount first (value of 10, pictured below). Short ItemDescription will
mount second (value of 20) and Long ItemDescription will mount third (value of 30).

Themounted product now displayswith the attributes in the order set by the Print Display Sequence attribute:
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Applying Styles to Attributes From Mounted Attribute Groups
To apply styles tomounted attributes frommounted attributes, twometadata attributes are used and configured in
SystemSettings under Users & Groups—Attribute Name Style Meta-attribute andAttribute Value Style
Meta-attribute.

These attributes are required only when the style of the attributes' names and/or values differ from attribute to
attribute within the attribute group. For instanceswhere the styles of the attribute names and/or values do not
change, the product template can normally be used to generate the desired effect.

The description attributes used for the 'Attribute NameStyle Meta-attribute' and 'Attribute Value Style Meta-
attribute' settings are used to call out paragraph styles (not character styles) in InDesign that are applied to the
name of amounted attribute and the value of amounted attribute, respectively, whenmounted as part of an
attribute group. These attributes aremade valid on the Attribute object type. The values of these attributes should
be an exact match to corresponding paragraph styles in the publication template / mounting page.).

Style LOV
These attributesmust use an LOV that holds all of the required style names used both for the attribute names and
the attribute values. The values of this LOVmust be exact matches to the names of the corresponding paragraph
styles in InDesign.
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Adding the Style Attributes in System Settings

1. In SystemSetup, navigate to Users & Groups > System Settings.
2. Expand the DTP Settings flipper and click the ellipsis button (…)forAttribute Name Style Meta-attribute.

3. Browse to or search for the relevant attribute in the 'Attribute NameStyle Meta-attribute' dialog, then click
Select.

4. Follow the previous steps to select the attribute forAttribute Value Style Meta-attribute.

Assigning Styles to Attributes in the Workbench
To assign the style attributes to the attributes that will bemounted, choose the relevant LOV values from the
dropdown lists contained within the attribute name style and attribute value style attributes. The below
screenshots show four different style selections: one for the Country of Origin attribute name, one for the Country
of Origin attribute value, one for theManufacturer Name attribute name, and one for theManufacturer name
attribute value.
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Configuring the Product Template
The following two tags under Object Properties on the STEP Template Content palette are used to pull in the
attribute name and the attribute value, respectively: Object Name and Attribute value.
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The <STEPGROUP> tag should appear at the beginning of the tag grouping and close with the
</STEPGROUP> tag.

Note: The tags containing the attribute name and the attribute valuemust appear in separate paragraphs for the
styles to be applied, since they are paragraph styles and not character styles.

Mounted Product
The following attribute names and attribute values have beenmounted on the page in this example.

Note that the attributes have also been sequenced, using themethod outlined in the'Attribute Display Sequence
for Print Output' section of this topic.

Configuring the Product Template Styles Without Using Workbench Metadata Attributes
If the paragraph styles should be the same for all attributes in the group, the styling can be controlled in the product
template. This eliminates the need to set up themetadata styling attributes in STEP.

By using the product template to control the styles, character styles can be used, so the attribute name and the
attribute value do not have to appear in separate paragraphs. However, paragraph styles can still be used if
desired.
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In this example, the attribute names and style meta-attributes are not being used in the system. The effect on the
mounted page is accomplished via the setup in the product template.

Mounting Attributes and Images Without a Product Template
Though uncommon, it is possible tomount attribute values and images onto pageswithout using a product
template. This type of 'one-off' mounting is done in case you would like to add additional data to a page that is not
included in a product template, allowing you to add elements fromSTEP that you can update later instead of
adding free text or an image that has no connection to STEP.

Attributes aremounted from theSTEP Structure View palette, and images aremounted from theSTEP Images
palette.

This topic assumes that you have a basic familiarity with these palettes and have already created the publication
template / mounting page onto which you will bemounting data.
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Mounting Attributes Without a Product Template
In order to mount attributes onto the page, theymust first be visible within the STEP Structure View palette. The
following steps explain how to display the attributes in the STEP Structure View tree, then how to drag them onto
the InDesign page.

1. In InDesign, navigate to STEP > Preferences to open thePreferencesmenu.
2. SelectShow Attributes with Values in Tree from the topmost dropdown list on the dialog, then clickOK.

3. Open the STEP Structure View palette by navigating toWindow > STEP Structure View.

4. In the STEP Structure View tree, locate the object that contains the attribute(s) with the values that you would
like tomount onto the page. This can be any object type that has linked attributes and is not limited to product
objects.

To locate an object in the STEP Structure View, either browse through the tree or click on themagnifying glass
icon in the lower left corner of the palette to display theSearch dialog. The Search dialog can also be accessed
by clicking theOptions dropdown arrow in the upper right corner of the panel.

5. Click the black arrow next to the object to expand the list of linked attributeswith values.

6. With your publication template or mounting page open, select the attribute whose value you would like to
mount onto the page, then hold down the left mouse button as you drag it onto the InDesign page.
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Note: Attributes can bemulti-selected by holding the Ctrl or Shift keywhile making selections, but all attribute
valueswill mount into a single text frame.

7. Release your mouse button where you would like to drop the content.

8. A frame is created on the page containing the attribute value.

Alternatively, youmay draw a text frame on the InDesign page using the Type tool (T) before dragging over the
attribute value. The value is dragged and dropped onto the page in the samemanner as described in the
previous instructions, except the attribute is dropped into the preexisting frame instead of onto a blank area on
the page.
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Mounting Images Without a Product Template
Images aremounted directly from the STEP Images palette for reasons such as full-page ads in catalogs that
consist of a single image that do not need to bemounted with a product template.

1. Open the STEP Images palette by navigating toWindow > STEP Images.
2. Locate the image that you would like tomount by searching or browsing in the palette. Only one image at a time

can bemounted from the STEP Images palette.

3. Select the image, then hold down the left button of your mouse as you drag the image onto the page.

4. Let go of themouse button where you would like to drop the image.

5. The image is placed on the page.
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Note: Images dragged onto pages from the STEP Images palette are placed onto the page at the actual size that
they exist in STEP.

Saving Finalized InDesign Documents to STEP
Another important feature of STEP'n'design is the ability to save finalized InDesign documents back to STEP. One
of the primary reasons to save InDesign documents to STEP is to enable users across an organization or across
geography to access these documents, in addition to the following advantages:

Document Visibility in STEP
The documents become visible in STEP, allowing users who do not use InDesign to view the pages in the
workbench.
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'Referenced By' Product Data for Publications
It is possible to view a product in STEP and view the following publication-related information on theReferenced
By tab under theUsed on Page flipper. The numbers in the below list correspond with the numbers in the
screenshot directly below the list.

1. Which publications the product appears in
2. Which versions of these publications the product appears in
3. What page(s) the product appears in within these publications
4. How much space the product takes up on the page(s) on which it appears (Area Used)
5. Whether the page type is Actual (a mounted InDesign document) or Planned (a Flatplanner planned page).
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Page Data
It is possible to look at a page in STEP and view the following information on thePage Data tab. The numbers in
the below list correspond with the numbers in the screenshot directly below the list.

1. Thumbnail preview of the InDesign page

2. Page description:

l STEP ID and Name

l Date created (when the document was saved to STEP)

l Status: If the page is in a Flatplanner workflow, the status will change fromUnassigned to the user name to
which the DTP page is assigned.

l Page number

l Overset: If the page contains text or frameswith overset content, meaning there is content on the page that
does not fit in one or more frames, then the value will be ‘Yes’.

3. The list of products used on the page and the space used by each product
4. The list of classifications used on the page (if any) and the space used by each classification
5. The list of images used on the page
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Other Advantages

l It is possible to reuse product layouts when working with STEP Flatplanner. SeeReusing Saved Layouts in
the Flatplanner documentation for more information.

l It is possible to create indexes that list the page numbers of all mounted objects in the publication. See the
Creating Document Indexes topic for more information.

Saving a Mounted Document to STEP
Once you have finalized your mounted page in InDesign, the typical next step is to save it back to STEP.

Though it is optional to savemounted InDesign documents back to STEP, these documentsmust exist in STEP in
order to take full advantage of STEP's publishing capabilities, such as extraction of product indexes and
calculation of space usage.

To save amounted InDesign document back to STEP, follow these steps:

1. With your mounted document open in InDesign, first save it to your computer's hard drive.

Note: InDesign documentsmust first be saved locally before they can be saved to STEP.
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2. Next, navigate to STEP > Save Document to DB from the top of the InDesign interface.

3. In theSave Document to STEP Database dialog box that displays, the section folder fromwhich you
mounted your planned page should be automatically selected. If not, navigate to the correct section.

4. From the dropdown list, selectSave Document and Page Information (default) or Save Page
Information.

ChooseSave Document and Page Information to save page information, such as page numbers and
space allocation, into STEP aswell as the actual InDesign page itself. This option stores these documents in
the database for you and other users to access later.

SelectSave Page Information if you would only like to save page information into STEP. This option will save
a thumbnail of your page to STEP but not the actual InDesign page itself. Some usersmay prefer this option in
order to save space on their STEP application server.

5. CheckClose document and delete local copy if you would like to save the document to STEP, then have
the local copy automatically deleted from your computer.

6. ClickOK. The document is saved back to STEP within the correct publication.
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Working With Version Layers
This documentation section describes how to work with version layers when creating publications in
STEP’n’design. Both the STEP database and STEP’n’design are capable of supportingmulti-dimensional
product data. In STEP publications, thesemulti-dimensional views are configured as publication versions and are
typicallymodeled around specific language and country views of data. Versionsmay also be created to support
currency zones, vertical markets, or different types of catalogs. Therefore, product data in STEPmust be
organized into different versions in a publication.

The following image shows an example of a product mounted in three languages simultaneously onto the same
InDesign page. Each layer in the InDesign document corresponds to a publication version. Since all three layers
aremade visible with the eye icon on the left of the layer, theywill appear overlapping. In use, only one language
will show based on the current context.

This topic assumes the following:

l Basic understanding of standard InDesign layers functionality

l An understanding of publication versions (see thePublication Versions topic in thePublication
Maintenance documentation for more information)

Note: Version layers do not apply to page templates.

Using Version Layers
Layers are used typically for 'black plate' language and pricing content. For example, an English US layer will
contain US English textual content; a French layer will contain French content, and so on. Layers aremost
commonly used with publications created in Flatplanner and AutoPage, although layersmay also be used for
standard STEP'n'design ('drag and drop') publications. Layers are useful for mounting all language versions at
once, in order to save time onmanual duplication of layers or creatingmultiple publications for different languages.

However, all layers do not need to bemounted at once. A single layer can bemapped first, e.g., US English. Then,
as translated content becomes available, the layer can be duplicated, and the content on the duplicated layer can
be updated using Layer Version Update in order to replace all the US English content with content from another
language, e.g. French.
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Viewing Version Layers
Fromwithin InDesign, you can inspect the different versions you will bemounting by clicking the Layers tab
(Window menu/Layers or F7). Each version has its own layer (see example in illustration below). If multiple
versions share a layer, you will still only see one layer here, as this will match the name in the layer mapping.

Likewise, you can see how STEP’n’design knowswhich STEP context ismounted on a layer, by clicking Layer
Version Update in theSTEPmenu.

Creating Layers in Templates
In order to work with multi-dimensional data in STEP'n'design, both product templates and publication
templatesmust be configured with InDesign layers. Standard practice is for there to be a 1-to-1 relationship
between publication versions and layers. Though less common inmodern printing, a single layer may also be
designated as the repository for product images, while the additional layers each correspond to publication version
but contain black text only. This is to accommodate what is known in the printing industry as 'fifth-black' plate
change.
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Note: Version layers do not apply to Flatplanner page templates.

Creating a New Layer
The process for creating a new layer is identical for both product templates and publication templates since both
are standard InDesign documents. The following steps describe standard InDesign functionality.

By default, all new InDesign documents already have one layer defined called 'Layer 1'. In order to define
additional layers, either new layersmust be created, or the original layer can be duplicated.

1. Open your product template in InDesign.

2. In InDesign, navigate toWindow > Layers (or click F7) to open the InDesign Layers panel.
3. On the Layers panel, expand theOptionsmenu and clickNew Layer. Or, right-click on the layer name and

selectNew Layer.

4. In theNew Layer dialog, type the name for the new layer In theName field.

5. To change the color of the layer, select a color from theColor dropdown. The layer color determineswhat
color the frameswill appear on your layer. Best practice is to have a different color for each layer so they can be
easily differentiated.

6. ClickOK to close the New Layer dialog and finish creating the layer.
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Duplicating a Layer
Duplicating a layer follows a similar process to creating a new layer. Youmay choose to duplicate a layer either as
an alternative to creating a new layer or as amethod to copy all contents of a layer that already containsmounted
products. A layer with preexistingmounted content can be duplicated so that the duplicated pages can then be
updated with content from a different publication version. For more information on this, see theChanging a
Version Layer topic for more information.

To duplicate a layer:

1. Open your product template in InDesign.

2. In InDesign, navigate toWindow > Layers (or click F7) to open the InDesign Layers panel.
3. On the Layers panel, expand theOptionsmenu and clickDuplicate Layer. Or, right-click on the layer name

and select Duplicate Layer.

4. The layer is duplicated.
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Changing the Name of a Layer
The process for renaming a new layer is also identical for both product templates and publication templates since
both are standard InDesign documents. The following steps describe standard InDesign functionality.

1. Open your product template in InDesign.

2. In InDesign, navigate toWindow > Layers (or click F7) to open the InDesign Layers panel.
3. Double click on the layer name (in this example, Layer 1) to open the Layer Options dialog.
4. Type the new name for your layer in theName field, then clickOK.

5. The layer is renamed.

Layers in Publication Templates
Whenmountingmultiple versions onto a publication template, it is not always required to have layers set up on the
template beforehand. Layers from the product templatewill be copied across the publication template during
product mounting.

However, if you need translated content in the 'furniture' of the publication template—meaning the background
elements on the page that are not placed through the product template, such as text on side tabs—then the layers
must already created in the publication template.

The below screenshot shows three views of the same side tab on a publication template as it appears on an
English, a German, and a French layer. In this example, the content is not populated by STEP—it is already on the
publication template.
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To view an individual layer, click the box in the first column next to the layer that you wish to view. The eye icon will
display to indicate that the layer is visible. To hide the layer, click the eye icon tomake it disappear.

It is possible to populate publication template background elements with content fromSTEP by using STEP tags
on the publication template, but this can only be done using Flatplanner or AutoPage. For more information, see
Using the getInheritedPublicationValue Function in Flatplanner in the Flatplanner documentation and
Using the getInheritedPublicationValue Function in AutoPage topic in theAutoPage documentation.

Considerations for Layers in Publication Templates
Even though it is not mandatory to create layers on publication templates, it is recommended to do so to avoid any
future errors caused by keeping the 'Layer 1' (default layer). Whenmounting a Flatplanner page or a product onto
the publication template using a product template that contains layers, the system creates the same layers as
those on the product template, but themounted document will retain the default layer 'Layer 1,' as pictured below:

Layers in Product Templates
Whenmountingmultiple publication versions at one time (typically in Flatplanner and AutoPage), it is mandatory
that product templates contain layers. As stated in the previous section of this topic, layers in publication templates
are not always required since the layers from the product template will be copied across to the page when
mounting. In other words, when a document ismounted using a product template that contains layers, the same
layers will be automatically created in the publication template.

Note that if you are using drag-and-drop tomount a product onto a page using a product template with layers—
and the publication template does not have layers—all layers will be automatically be created on the publication
template, but the content from the publication version that you are working with will bemounted on all of the layers.
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For example, if your product template has three layers (USA, France, andGermany), and you are working with
the USA (English) context, the three layers from the product template will be created in the publication template,
but the English content will go on all three.

Mapping Versions to Layers
If you plan to set up a publication in which you would like all publication versions tomount onto the InDesign
publication template / mounting page at the same time, youmust define which layer each publication version will
placed onto. This definition is accomplished through Layer Mappings. Layer mapping is required when the intent
is to mount multiple versions ontomultiple layers at one time and applies tomulti-versioned publications created
with any STEP Publisher component—STEP'n'design (drag and drop), Flatplanner, and AutoPage.

The following screenshot shows a publication with threemapped versions.

Note: If you have a single-version publication, you do not need to create layer mapping.
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Steps tomap publication versions to layers are as follows:

1. In the Tree, navigate to the relevant publication, then click thePublication tab.
2. Expand the Layer Mappings section, then click 'CreateMapping.'

3. In the blank row that is created after clicking 'CreateMapping,' enter the name of one of the layers from your
product template in the Template column. This field is case sensitive.

4. In theDocument column, enter the name of the corresponding layer in the publication template / mounting
document. Best practice is for the names of the layers tomatch on both templates. If the publication template
does not already have layers, the layers will be created from the product template when a product ismounted.
The created layers will be given the names provided in the layer mapping.
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5. In theVersions column, click the ellipsis button (…).
6. Select the relevant version(s) in theSelect Versions dialog.

7. By default, the selected version will also be the owner of the layer. If youmapmore than one version to a layer,
youmust designate one of these versions as the owner from theOwner dropdown list. See the following
section of this topic for more information on layer ownership.

8. ClickOK.

9. To createmore layer mappings, repeat steps 1-8.

Versions Owning Layers
In almost all cases, whenmapping publication versions to InDesign page layers, there is a 1-to-1 relationship
between publication versions and layers. The concept of a version 'owning' a layer is related to the idea of the 'fifth
black plate' change print process that can be used to reduce print costs.

Note: TheOwner is the version that will be used whenmounting in InDesign. However, content on the layer is
shared by the other versions that aremapped to it and will appear in the PDF output of the document.

In commercial printing, color printing presses produce pages using four plates, with each plate containing a
different color of ink—Cyan, Magenta, Yellow, and Black (referred to asCMYK). Publishers use a 'fifth black' color
when the text and/or prices are different for each publication version. It ismore cost-effective for publishers to first
print their books using the CMYK process but excluding the text. Then the publications are 'overprinted' with a fifth
black plate that contains only the text portion, and a different fifth black plate is used for each text version.

Sincemost printing houses these days have the ability to separate these layers digitally fromPDFs, it is not a
requirement to map version layers in STEP to preciselymatch the way the printer will create the fifth black plates.
Specifically, it is OK if color elements (such as images or background colors) are included in every layer of the
InDesign document (and subsequently the PDF that is created from it), as long as these elements are placed in an
identical location within each layer.

The following use cases describemore traditional layer mappings based on the idea of mapping text ('fifth black')
to separate layers than images.

'Fifth Black' Use Cases
A basic use case for 'fifth black' layer mapping is as follows:
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A catalog is being produced in both the U.S. and the U.K. The desired layers are:

l An image layer with the same color pictures in both countries
l A US text and price content layer
l A UK text and price content layer

In this instance, the product templatewould have two layers:

l Image Layer

l Text Layer (which contains your region text as well as the price)

The layer mapping would be as follows. Note that a single layer from a product template—in this case, Text—can
bemapped tomount ontomore than one layer in the publication template.

Template Document Owner version Other Version

Image Image US UK

Text US-Text US

Text UK-Text UK

The layer mapping in this example will resemble the following. Versions that own the layers are in bold text.

A more complex use case for 'fifth black' layer mapping is as follows:

A catalog is being produced in both France andGermany. The desired layers are:

l An image layer with the same color pictures in both countries
l A German text content layer
l A French text content layer
l A Euro price layer

In this instance, the product templatewould have three layers:
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l Image Layer

l Text Layer

l Price Layer

The layer mapping would be as follows. Note that a single layer from a product template—in this case, Text—can
bemapped tomount ontomore than one layer in the publication template.

Template Document Owner version Other Version

Image Image DE FR

Text DE-Text DE

Text FR-Text FR

Price Price DE FR

The layer mapping in this example will resemble the following.

Mounting Products to Version Layers
One advantage to using version layers in a publication is the ability to mount content from all publication versions in
one operation. This is typically only used for Flatplanner and AutoPage publications, but multiple versions can also
bemounted in one operation using the standard 'drag-and-drop' functionality of STEP'n'design.

Layers are useful for mounting all language versions at once in order to save time onmanual duplication of layers
or creatingmultiple publications for different languages.

However, all layers do not need to bemounted at once. A single layer can bemapped first, e.g., US English. Then,
as translated content becomes available, the layer can be duplicated, and the content on the duplicated layer can
be updated using Layer Version Update in order to replace all the US English content with content from another
language, e.g. French. All methods require layer mapping.
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Mounting Multiple Versions in STEP'n'design
Multiple versions can bemounted to a page in a single drag and drop operation bymulti-selecting the versions you
would like tomount when prompted to choose a version.

1. Open InDesign, then navigate to STEP > Preferences to open thePreferencesmenu.
2. Tick thePrompt for Version box, then clickOK to close the Preferencesmenu.

3. Open the STEP Structure View palette by navigating toWindow > STEP Structure View.
4. Ensure that the correct layer-containing product template is selected in the Template dropdown in the palette.

5. In the STEP Structure View tree, locate the product object that you would like tomount, then hold down your
left mouse button as you drag it onto the publication template.

6. Release themouse button where you would like to drop the product onto the page.

7. In theChoose Version to Mount dialog that displays, multi-select the versions that you would like tomount
by holding Ctrl or Shift while making your selections, then clickOK.
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8. The product ismounted on the layers of the publication template.

The following screenshots show how the content looks on the page when viewed one layer at a time.
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Working With Preexisting Layers and Newly Created Layers
If there are preexisting layers In your publication template and the layer names exactlymatch the name of the
layersmapped in theDocument column of the layer mappings in STEP, then the publication versionswill mount
on the preexistingmapped layers. If the names of the layers on the publication template do notmatch those in
STEP—or if there are no layers to begin with in the publication template—then the layers will be created and given
the names provided in the layer mappings.

The following image shows a product mounted on a publication template that did not already have layers other
than Layer 1. The product wasmounted from a product template containing layers named France, USA, and
Germany. Because of theDocument layer names provided in STEP, the layers were created in the publication
template and named 'French Version', 'USA Version', and 'German Version'.
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This image shows a similar scenario, except there were already layers on the publication template. However, the
content wasmounted on three newly created layers since the names of the preexisting layers did not match those
in theDocument column. No content wasmounted on the existing layers.

Mounting Multiple Versions in STEP Flatplanner and STEP AutoPage
A huge advantage of using STEP Flatplanner and STEP AutoPage is the ability to mount all publication versions
in one operation for entire sections of a publication or even an entire publication at once. Layers and versions are
mapped for Flatplanner and AutoPage publications in an identical fashion as that described in this topic.

Viewing Version Layers in STEP
When layered InDesign documents are saved to STEP, the individual layers can also be viewed in the workbench
based on their publication versions, allowing users to view the different versionswithout having to access the
documents in InDesign.

1. Save your finalized InDesign document to STEP by following the instructions outlined in theSaving Finalized
InDesign Documents to STEP topic.

2. In the STEPWorkbench, navigate to the DTP document in the Tree. As pictured below, if you hover over the
document with your cursor, the versionsmounted in the document appear in the hover text.
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3. With the document selected, choose the version you wish to view from theVersion dropdown in the upper
right corner of the workbench.

4. Select a page in the DTP document, then click on theDetails tab to view themounted page. The below
screenshot shows themounted product in the GermanDE publication version.
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5. Alternatively, you can navigate to View > Select version, and choose the publication version that you would
like to view from themenu.

6. After choosing a version from theSelect version list, return to step 4 above—select a page in the DTP
document, then click on theDetails tab to view themounted page.

Changing a Version Layer
Changing a version layer in InDesign will force InDesign to re-fetch the data contents for your version fromSTEP.
Changing context / workspace for a certain version layer will potentially affect all data in the selected version layer
in the active document.

The reasons for changing the content on a version layer include the following:
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l You have finished creating the pages for themaster language of your publication and are now ready to
duplicate the layer and update the new layer with content from another version of your publication.

l You have finished creating the pages for your publication by using a publication version that is using content
from theMain workspace. You now need to update the pageswith content from the Approved workspace.

l Youwant to attach an existing document to another publication.

l You actually want to avoidworking with layers in your InDesign documents.

Adopting Layout and Content From Another Version
When creating new version layers it is possible to adopt the layout from another publication version—either within
the same publication or a different one—then swap out the dimension-dependent content on the page using the
Layer Version Update feature in STEP'n'design.

A typical workflow for working with version layers in STEP’n’design is that you first create your full master version
layer. Thismeans that youmount your products from your first version into your InDesign page or spread. Then
you use the features of InDesign to edit the layout of the pages and the products on the pages. Only when you are
happywith the way a version's pages look, you will start creating the other version layers. Following this procedure
will make it easier for you to let the remaining version layers in a publication reuse the layout you have created on
the original mounted pages.

It is possible to duplicate a version layer from the Layers panel (opened by navigating toWindow > Layers in
InDesign, or pressing F7) and then change the version afterward. This way, you keep all your formatting and
layout from one version to another within a publication, and you canmount several versions of a publication within
the same document.

The following directions are for adding content from a different publication version when working within the same
publication or from a different publication.

1. Select the relevant version layer in the Layers tab, then right-click and selectDuplicate Layer.

2. The layer is duplicated into a new layer with the name of the original layer followed by the word 'copy'.
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3. Rename the duplicated layer and change its color by following the instructions outlined in theCreating Layers
in Templates topic.

4. Ensure that you are working on the duplicated layer bymaking sure that the pen icon is visible on the selected
layer.

5. Navigate to STEP > Layer Version Update.

6. In the Layer Version Update dialog, select the version that you would like to update your layer to from the
Version dropdown list.
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If you wish to use a version from a different publication, click the ellipsis button (…) in the 'Revised' field. Select
the desired publication from theChoose Publication dialog, then clickOK. Updating the content with a
version from a different publication will allow you to save your mounted pages back to that publication in STEP.

7. Once the new version is selected, theApply checkbox is automatically selected.
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8. ClickOK to update the layer content.

Additional Options on the Layer Version Update Dialog
The following options available on the Layer Version Update dialog can be selected to further control how data on
the duplicated layer is updated fromSTEP.

l Clear Context Overrides: This option sets the context applied to all items on the layer to that is assigned to
the version. If a frame or attribute had a specific context applied through the product template settings on the
STEP Template Content palette, these context overrides are removed.

l Override Version Workspace: This option swaps the workspace of mounted products. For example, if you
built your publication using a publication version that was pulling content from theMain workspace, you can
then swap the workspace to the Approved workspace to overwrite the valueswith those from the Approved
workspace. To swap the workspace, tick the 'Override VersionWorkspace' checkbox and select the workspace
fromwhich you would like to pull the content fromwhen you update the content on your layer.

For more information about workspaces, see theWorkspaces topic in theSystem Setup / Super User
Guide documentation.
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l Under theDocument Data update options label is a dropdown list that contains the following options.

l Update all values:Updates all valueswithin the document, even if the values are identical to those in
STEP.

l Do not update matching DB/placed values:Only updates values that do not match placed values.
'Placed' values refer to the values that exist on the page, whichmay or may not be different than the
values that exist in STEP at the time of the update. The placed valueswill be compared to the values in
STEP and if these two values are identical, no change will occur. This option is a useful way to retain
stylingmade to placed values that match the new values in STEP. This also allows for quicker
processing time, since all values do not have to be updated—only the ones that do not match.

l Do not update any placed values:Updates the publication and version references of themounted
elements but does not update the page data.

l Obtain values from transformed tables, preserve local table styling and structure: If there are
mounted tables on the layer that you are updating, checking this boxwill retain the existing table structures and
only update the valueswithin the tables. For example, local stylingmight have been applied to the table on the
InDesign page after its original mount, such as the alteration of row / column sizes or the addition of color
shading (either manually or through a previous table transformation). Checking this box ensures that the table
structure and formatting remain as-is and only the values are updated. If the box is not checked, the entire table
is re-sent from the database (force updated) and any local updatesmade to the table are lost.

If actual table structural changes have beenmade to the table in STEP, such as the addition or removal of rows
or columns, then a Table Structure Mismatch alert dialog will display.

l ChooseDB Attribute to only update the content in the table. The structure of the table will not change;
any inclusions or exclusions of rows / columns or any other changesmade to the table structure will not
be updated.

l ChooseDB Table to update the table with all the structural changesmade in STEP. This is the
recommended option when any structural changes have beenmade to the table since it wasmounted.

l ChooseSkip to make no changes to the table at all.
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l Update Repeat Area:Checking this boxwill compare the list of objects in STEP applicable to a repeat area to
the objectsmounted on the page (ignoring order). Additional objects are placed at the end of the list unless
deleted items are also found, in which case added items replace the deleted items until there are nomore
deleted items and the remaining items are then placed at the end of the list.

A repeat area is created in the product template using the 'Repeat Selection' feature (STEPREPEAT). This
function is applied to a group of attributes in the product template and causes the values of the selected
attributes to repeat for the child objects of themounted product. After the product has beenmounted onto the
page, if there are any inclusions or deletions on the child objects, then choosing this option will allow the user to
update the inclusions and/or exclusions. For more information on STEPREPEAT, see theUsing the Repeat
Function for Subproducts topic.

Alternative to Working With Version Layers
InDesign documents created from a publication that hasmultiple versions are not required to use layers. A single
'master' publication can be created that containsmultiple versions, but layers are not needed because all versions
will not bemounted at once.

For example, your businessmay publish a near-identical catalog in 15 languages, but the 'master' language
catalog (e.g., US English) needs to go to press before the translated versions are ready.When the translated
content is available in STEP, the single-layer US English catalog can be opened in InDesign, then the layer can be
updated with content from a different version within the publication by using the Layer Version Update feature.
This updated document can then either be saved back to the publication in STEP (as separate files from the
original language) or saved locally, outside of STEP.
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Creating Document Indexes
This documentation section provides information about creating document indexes from finalized InDesign pages
that have been saved back to STEP.

The twomost common types of indexes created fromSTEP are a basic 'stock number' index and amore
advanced 'alphabetical index.' These are not official STEP terms, but they are used in this documentation as
labels to describe the twomost common types of indexes generated from finalized InDesign pages saved into
STEP.

Though an index can be generated using standard InDesign features, this is not ideal for a typical STEP-produced
product catalog, since, in most cases, using InDesign to generate the index requires amanual selection of index
words on each individual page.

Stock Number Indexes
Stock number indexes do not use indexwords or an indexwords hierarchy. The following screenshot shows a
sample stock number indexmounted onto an InDesign page.

Alphabetical Indexes
Alphabetical indexes require the use of index words and an indexwords hierarchy. The following screenshot
shows a sample alphabetical indexmounted onto an InDesign page.
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Index Words
Indexwords are created in the workbench Tree under the Index Words node and can be linked to asmany
products as needed. For more information about creating Indexwords and linking them to products in STEP, see
theCreating an Index Words Structure topic.

Tables of Contents
As opposed to indexes, which are located at the back of publications, tables of contents are found at the
beginnings of publications or publication sections. It is typically recommended to use the standard table of contents
functionality in InDesign to create traditional tables of contents.

However, STEP'n'design can be used to create 'section indexes' fromSTEP, which are a type of table of
contents. Since the creation of a section index follows a different process than the creation of a document index, it
is not covered in this section. For information on how to create a product template designed to create a 'section
index' table of contents, see theCreating a Table of Contents Product Template topic.
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Creating an Index Words Structure
In order to generate and extract an alphabetical index from a publication in STEP, a hierarchy of Index Words
must first be created. These wordsmust then be linked to the products that should appear in the index. Index
words are created in the Tree under the IndexWords root node and can be linked to asmany products as needed.
For example, youmay need to link a product family containing chair products to two different indexwords—
'Chairs' and 'Furniture.' Child products within the family could further be linked to sub-levels of indexwords, for
example, 'Swivel chairs' or 'Recliners.'

The indexword hierarchy functions similarly to a classification hierarchy in STEP. Products are linked to index
words from the productReferences tab, similar to how products are linked to classification folders. Indexword
links are also inherited from parent to child objects.

The following screenshot shows a partial sample of an index exported from a publication in STEP:

The next screenshot shows a section of the same index, superimposed with a portion of the indexwords hierarchy
that was used to generate the index:
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When generating an index, it is possible to use InDesign’s standard features. However, for a typical STEP-
produced publication, standard InDesign functionality is not ideal as it typically requires amanual selection of index
words on each individual page. An index created in STEP, however, can generate an entire publication indexwith
a single STEPXML export in the 'Alphabetical Index - XML' format.

For detailed instructions on how to export an index from a publication in STEP, see theCreating Document
Indexes section of theSTEP'n'design documentation.

Creating Index Words

1. In the Tree, navigate to the IndexWords root node, then right-click and selectNew Index Word.
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2. In theCreate Classification dialog that displays, enter aName for your indexword, then clickCreate. (By
default, the 'Index' alternate classifications object type [ID = stibo.IndexWord] is configured to autogenerate an
ID by using the ID Pattern of [id].)

3. To create additional sub-levels of indexwords, right-click on the indexword you just created (in this example,
'A'), selectNew Index Word, then repeat step 2. An unlimited number of sub-levelsmay be created.

Note: Typically, an indexword hierarchy intended for use with a single language will have a 'parent' level of
single index letters (for example, A, B, C). For dimension-dependent indexes, however, it is recommended to
instead use a transformation on export that extracts the first letter of each word that begins a new letter in the
index. For information on thismethod, see theExporting Index Data from STEP topic.

Using a Sort Word
In the indexword editor, enter aSort Word if, on output, you would like your indexword to be placed in a different
area of the index than its alphabetical order. For example, if you are creating a supplier index and one of your
company names beginswith a numeral, such as '1st AcmeCorp.', youmaywant this company to appear in the F
section of the index output (listed with other companieswhose names begin with the word 'First') instead of
appearing before the letter A, where entries that begin with numbers would be placed in a standard alphabetical
sort order.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 280



Linking Products to Index Words from the Product Hierarchy
Once your indexwords hierarchy is created, youmay now link these words to products.

1. In the Tree, navigate to the product to which you would like to link your indexword(s).

2. On theReferences tab, expand the flipper for IndexWords and clickAdd Index Word.

3. Select the relevant index, then click through the additional levels until you have applied the desired index
words. ClickOK.
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4. The product is now linked to the indexword.

5. Repeat the above steps to link your product to additional indexwords. A single product can be linked tomultiple
indexwords, depending on all of the index locationswhere the product should appear.

Note on Index Word Pathnames
If the system settingUse full pathname for classes on Product References Tab is set toY, the lowest level of
each linked indexword will appear as a path instead of an individual word. However, this will not impact the output
of the indexwords in the 'Alphabetical Index - XML' file; linked indexwordswill correctly appear aswords, not
paths.

For more information on this system setting, see theProduct Information Manager Default Settings section of
theSystem Setup / Super User Guide documentation.

Setting Dimension Dependency on Index Word Links
Making the links between products and indexwords dimension dependent can be useful for situationswhere not
all products are sold in all countries. Because the IndexWord product-to-classification link type (ID =
stibo.IndexWord) is a hidden object in STEP (see the 'Note on the IndexWord Product to Classification Link Type'
subsection below for more information), dimension dependency cannot be set on indexword link types by the
samemethod used for other product-to-classifcation link types. Instead, the dimension dependencymust be set in
SystemSettings under the 'IndexWord Settings' flipper. For more information, see the Index Word Settings
section of theSystem Settings documentation.
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Viewing and Linking Products from the Index Words Hierarchy
All products linked to a particular indexword can be viewed from theSub Products tab of the indexword object.
Additionally, products can be added to indexwords from this tab.

1. In the Tree, navigate to the indexword to which you would like to link your product(s).

2. On theSub Products tab, click 'Add Product.'

3. In theSelect Classification Product Link dialog that displays, browse or search for the product(s) that you
would like to link to the indexword. Multiple productsmay be selected by holding Shift or Ctrl whenmaking
selections.

4. ClickSelect to close the Select Classification Product Link dialog. The products are now linked to the index
word.
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Inheritance of Index Words
Indexwords are inherited in a similar fashion to how standard product-to-classification references are inherited.
By default, indexwords are inherited in anAccumulative fashion. Allow multiple links is by default set to Yes. This
means that an indexword that is linked to a parent product will be inherited by all of its child products, and
additional indexwords can be linked to the children in addition to the inherited word(s). However, inherited words
cannot be overwritten or removed from lower levels.

The Inherited From column displays the level at which the indexword is linked in the hierarchy. In the following
example, the words 'Hats' and 'BirthdayHats' are linked to the parent product 'Paper Hats.' The indexword
'Sweet 16' is linked locally ('Locally defined') on the child product.

For more information on reference link inheritance, see the Inheritance Example for a Reference section of the
System Setup / Super User Guide documentation.

Note on the Index Word Product to Classification Link Type
The IndexWord product-to-classification link type (ID = stibo.IndexWord) is a hidden object in STEP. It can only
be accessed by searching for its ID in theGoto field or on theSearch tab. Typically, no configuration changes
should bemade to this object. However, an occasional configuration needmay arise, such as the need tomake
the link type externallymaintained.

Unlinking Products from Index Words
Unlinking From the Product Hierarchy

1. Navigate to the relevant product in the Tree, then expand the Index Words flipper on the productReferences
tab.

2. Right-click the arrow to the left of the word that you would like to remove, then selectRemove Index Word
from themenu. (Note that only words designated as 'Locally defined' can be removed. Inherited words can
only be removed from the parent level to which they are linked.)
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Unlinking From the Index Word Hierarchy

1. Navigate to the relevant indexword in the Tree, then click theSub Products tab.
2. Right-click the name of the product that you would like to unlink, then selectRemove Product.

Importing and Exporting Index Words
As an alternative tomanual creation, an indexwords structure can be created through an Excel or STEPXML
import. Additionally, product objects can be linked to indexwords through an import. Indexword hierarchies are
exported and imported in STEP using standard Export Manager and Import Manager functionality.

Note: This topic presumes a basic familiarity with the Export Manager and Import Manager wizards in STEP. For
more information, see theExport Manager and Import Manager sections of theData Exchange
documentation.

Exporting an Index Words Structure
Indexwords are exported fromSTEP in the samemethod that any other classification hierarchy is exported.
Common export formats are Excel, CSV, and STEPXML. The below steps give an overview of how to export an
indexwords structure inExcel.

1. In the Tree, select the desired IndexWords parent node, then right click and selectExport Data Below. In this
example, the root node is selected.
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2. On the 'Select Objects' screen, uncheck 'Only export leaf objects' and choose 'Classification' from theExport
dropdown list. Leave 'Include object types' with the default setting of <All object types>. ClickNext.

3. On the 'Select Format' screen, selectExcel as the export format, then click Next.
4. On the 'Map Data' screen, select ID, Name, and Parent ID, then clickFinish.
5. The resulting file will resemble the following.
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Importing Index Words With Excel
To import indexwords using Excel, the Excel file will have the same format as the export sheet pulled in the
previous section, except a fourth Object Type column is added containing stibo.IndexWord. Thismethod can be
used to create new indexwords aswell as alter the names of existing indexwords.

1. To import the sheet, follow the same initial steps as you would to import any other Excel sheet.

2. On the 'Map Data' screen of the Import Manager, selectClassification in the 'Map to:' dropdown andmap the
columns as follows—ID, Name, Parent ID, andObject Type.
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3. On the 'Identify Objects' screen, existing indexwords appear in green and new indexwords appear in black.

4. Click Finish to complete the import. The new indexword shown in the previous step appears in the indexwords
hierarchy.
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Linking Index Words to Products Using Excel
To link indexwords to products using an Excel import, the sheet must contain aminimumof two columns: one
containing the ID of the product object and a second containing the ID of the indexword that will be linked to it. The
indexword columnmust have the header <Stibo Index Word>. Other columns, such asName (pictured below),
are optional.

1. To import the sheet, follow the same initial steps as you would to import any other Excel sheet.

2. On the 'Map Data' screen of the Import Manager, selectProduct from the 'Map to:' dropdown. Map the ID and
Name columns to ID and Name, respectively. Map the <Stibo IndexWord> column toProduct Classification
Link.
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3. Complete the import as you would any other Excel import.

4. In the Tree, navigate to one of the products contained in the sheet, then go the References tab. Expand the
IndexWords flipper to view the linked indexword.

Importing Index Words and Linking to Products Using STEPXML
Using STEPXML imports, indexword structures can be created and products can be linked to indexwords. An
advantage to using STEPXML over Excel is that indexwords can be created and simultaneously linked to
products in a single file.

Create an Index Words Hierarchy With STEPXML
To create an indexwords hierarchy by STEPXML import, use the following sample format:

<STEP-ProductInformation ContextID="Context1" WorkspaceID="Main">

<Classifications>
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<Classification ID="179705" UserTypeID="stibo.IndexWord" ParentID="stibo.IndexWordRoot">

<Name>Acme Party Supplies</Name>

<Classification ID="" UserTypeID="stibo.IndexWord">

<Name>X</Name>

<Classification ID="" UserTypeID="stibo.IndexWord">

<Name>Xylophones</Name>

<Classification ID="" UserTypeID="stibo.IndexWord">

<Name>Plastic Xylophones</Name>

</Classification>

<Classification ID="" UserTypeID="stibo.IndexWord">

<Name>Metal Xylophones</Name>

</Classification>

</Classification>

</Classification>

</Classification>

</Classifications>

</STEP-ProductInformation>

Link Index Words to Products With STEPXML
To link indexwords to products by STEPXML, use the following sample format:

<STEP-ProductInformation ContextID="Context1" WorkspaceID="Main">

<Products>

<Product ID="20805" UserTypeID="Item">

<Name>Baseball Cap</Name>

<ClassificationReference ClassificationID="179720" Type="stibo.IndexWord"/>

</Product>

</Products>

</STEP-ProductInforma

STEPXML File Example
An example of a STEPXML import used to create an index hierarchy and link products to the indexwordswith a
single file is pictured below:
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Exporting Index Data from STEP
After all InDesign documents for a publication have been finalized and saved back to STEP, data about the
mounted products and the pages on which they appear can be exported from the publication in order to generate
anAlphabetical Index - XML file. This XML file format is used to create both types of indexes—the basic 'stock
number' index and themore advanced 'alphabetical index.'

If building an alphabetical index, index words are required. This topic assumes that you have already created
your indexwords and indexwords hierarchy and linked them to the products in your publication. See theCreating
an Index Words Structure topic for more information.

This topic describes how to export an Alphabetical Index - XML file from a publication in STEP using standard
STEP Export Manager functionality. By using the Export Manager, you can define, throughmapping, which index
words and/or STEP attribute(s) to include in the index output; how to sort the exported data (for example, what
country, language, or numerical order should be used to sort); and what separator characters should be placed
betweenmultiple page numbers and/or page ranges (such as 1, 2 or 1-3).

The exported indexwill organize the index entries into XML tag structures, such as:
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<Level1>
<Word>Laser Printer</Word>
<PageNumber>2,5-6</PageNumber>
</Level1>

Note: This topic assumes a basic familiarity with the STEP Export Manager. For full details on Export Manager
functionality, see theExport Manager section of theData Exchange documentation.

Exporting an Index Using the STEP Export Manager

1. In the workbench, navigate to File > Export > Data to launch the Export Manager. SelectCreate New Export,
then clickNext. Alternatively, youmay right-click on the publication fromwhich you want to export the index
and clickExport Data Below.

2. In step 2 (Select Objects), define the publication fromwhich you would like to export the index. ClickAdd
Objects, search for or browse to the relevant publication in theSelect Objects dialog, then clickSelect.
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3. To define the publication version fromwhich you want to export your index, select the relevant version from
the dropdown list in theVersion column, then clickNext.

Note: 'Product' should be selected from theExport: dropdown, not 'Publication Objects'. Also, it does not
matter if 'Only export leaf objects' is checked. Since the export will be in XML format, this option is ignored.

4. In step 3 (Select Format), chooseAlphabetical Index - XML from the dropdown list.
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5. Configure the remaining options in step 3 as follows:

l Sort Language Code: This is a free-text field. Enter the two-letter lowercase ISO639-1 language code on
which you would like to sort the indexwords. The default selection is en. A full list of codes can be found on
the web.

l Sort Country Code: This is a free-text field. Enter the two-letter uppercase ISO-3166 country code on
which you would like to sort the indexwords. The default selection isUS. A full list of codes can be found on
the web.

l Page Number Separator: This defineswhat character should be placed between page numbers if a
product appears onmore than one page in the publication. This is typically a commawith a space added
after.

l Page Range Separator: This defineswhat character should be placed between page numbers if a product
appears onmore than one consecutive page. This is typically a hyphen with no space on either side.

l Use Numerical Sort: Select yes to sort numerical entries in ascending numerical order:

l 100

l 200

l 1002345

l 1003456

l 2001234

Select no to sort numerical entries on the first number, as follows:
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l 100

l 1002345

l 1003456

l 200

l 2001234

6. ClickNext to move to step 4,Map Data.

Mapping Index Data
The next step in configuring the index export is to map the data, which occurs in step 4 of the Export Manager,
Map Data.

All indexesmust contain at least two elements—an index word and a page number.

Page number is not mapped as an attribute, since page numbers are automatically populated from InDesign
pages after they are saved to STEP.
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Mapping a Basic Stock Number Index
The index word in a basic stock number index is typically a part number or a catalog number. This can either be
an attribute, a STEP ID, or a STEP name. For this example, the STEP ID will be used as the indexword.

1. On theMap Data screen of the Export Manager (step 4), select <ID>, then click on the arrow directly to the left
of the Index words flipper.

2. Expand the <ID> flipper to display theSort Word Path andWord Path. Leave these as-is.

Sort Word Path denotes the content that the Index is sorted by—in this case, the ID of the products.Word
Path is the content that is actually being pulled into the index—in this case, also the ID of the products.

3. Select <Page Number>, then click on the arrow directly to the left of thePage Number flipper. ClickNext.
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4. To complete the export of the stock number index, see the last section in this topic, 'Completing the Index
Export'.

Mapping an Alphabetical Index
Mapping an alphabetical index ismore in-depth thanmapping a basic stock number index, asmore considerations
aremade for indexwords and translated content.

The index words in an alphabetical index are pulled from the indexwords that are linked to the productsmounted
to the InDesign pages.

1. On theMap Data screen of the Export Manager (step 4), expand the Index Words hierarchy and select the
relevant index hierarchy.

2. Click the arrow directly to the left of the Index words flipper.
3. Expand the Index words flipper
4. Expand theWord flipper to display theSort Word Path andWord Path. The number in front of Word is the

STEP ID of the selected indexword hierarchy.

Sort Word Path denotes the content that the Index is sorted by—in this case, the sort word attached to the
indexwords.Word Path is the content that is actually being pulled into the index—in this case, the actual index
words in the hierarchy. See theCreating an Index Words Structure topic for more information on sort
words.
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5. If your indexwill contain translated content, it is recommended tomap a constant value in order to generate
top-level index letters—1, 2, 3, A, B, C, and so forth. For example, in English, a product named 'Black chair'
would be listed under the letter B, but in Germany, the same product would be named 'Schwarz stuhl' and
would need to be listed under the letter S. This enables you to use a single dimension-dependent indexwords
hierarchy that is translated instead of having a separate hierarchy for English, a separate hierarchy for
German, and so forth.

If there is no chance that the contents of your publication will be translated, it is acceptable to notmap a
constant and instead use letters as the Level 1 indexword, as shown throughout theCreating an Index
Words Structure topic.

6. Select "Constant Value" under MapData, then click the arrow to the left of Word Path.
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7. On theEnter Value dialog that displays, enter the string <pathsep/>, then clickSave.

The constant <pathsep/> is used to identify each individual index letter and ensures that the same index letter
is only shown once.

8. Next, the index hierarchymust bemapped to theWord Path again. The first mapped indexwill be used to
extract the index letters from the indexwords through a transformation (see step 10). The secondmapped
indexwill be used to extract the indexwords themselves.

Select the relevant index hierarchy again from beneathMapData, then click on the arrow to the left of Word
Path tomap the index hierarchy a second time.
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10. Next, a transformationmust be applied to the first mapped Index hierarchy to extract the first letter of each
indexword. This letter will be used as the index letter when a new letter begins in the index.

Click on the transformations icon to the right of the first Word Path field to display the Transformations dialog.
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11. Click 'Add Transformation' to display theSelect Transformation dialog.
12. Select 'Extract characters at position' from the list of transformations, then clickOK to return to the

Transformations dialog.

13. Enter a '1' in both the 'Starting from position' and 'extract' fields, then clickSave.

14. Last, map the Page Number by clicking <Page Number> and clicking the arrow next to Page Number, then
clickNext.
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Completing the Index Export
Once you have completed your indexmappings, follow these steps to complete the index export fromSTEP. The
following steps describe basic Export Manager functionality and are not unique to the Alphabetical Index - XML
format.

1. After clickingNext on theMap Data screen of the Export Manager (step 4), you are taken to theAdvanced
screen (step 5). All optionsmay be left as-is. ClickNext.

2. On theSelect Delivery Method screen (step 6), choose File from the dropdown, then clickFinish. 
3. On theSave Export Configuration dialog, select 'SaveOptions' to save the Index Export configuration,

which is recommended. Click the ellipsis button (…) by theSave towindow and choose a classification folder
in which to store your export configuration. A typical location is Configurations > Export Configurations.

Note: For more information on saving export configurations, see theRunning a Data Export section of the
Export Manager documentation.

1. ClickOK to begin the Export Process, then clickGo to Process to go to the BGProcesses tab and retrieve the
file once the export is completed. The file is exported as XML.

2. Save the XML file to a location of your choosing on your hard drive.

Once these steps are completed, the XML file is ready to be formatted and imported into InDesign. For instructions
on next steps, see the Formatting and Mounting an Index in InDesign topic.
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Formatting and Mounting an Index in InDesign
Once the Index XML has been exported fromSTEP, the next steps are as follows:

1. Format the XML file

2. Create the indexmounting page

3. Configure the paragraph and character styles within themounting page

4. Import the XML file into InDesign

5. Mount the index onto the page

6. Apply final formatting to the index

Formatting the Index XML File
The typical desired end result for amounted index is to have what is known asdot leaders to separate the index
words from their corresponding page numbers. For example:

Laser Printer ........1
Inkjet Printer .......2

Dot leaders are not placed into the XML file itself. Instead, a special character—typically a # symbol—is added to
the XML file, and this symbol will later be replaced in InDesign with a tab character that will generate the dot
leaders. This process is explained later in this topic in the 'Replacing Special CharactersWith Dot Leaders on the
InDesign Page' subsection.

To add the special character to the index XML:

1. Open the XML file in the XML editor of your choice, such asUltraEdit or Notepad++.

2. In the XML file, find all instances of the string </Word><PageNumber> and replace themwith
</Word>#<PageNumber>.
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3. Save the file.

Configuring the Index Mounting Page
The best practice for indexmounting pages is to create an InDesign document that contains columnswith
threaded text frames on themaster pages.

Note: Amounting page for an index is not a publication template.

The following screenshot shows an indexmounting page with three text columns threaded to one another on the
master page. Placing text frames on themaster eliminates the need to draw a text frame on the page when
mounting an index, as the frameswill be automatically created. This setup is ideal for lengthy indexes, as new text
frames and pages are automatically created as the indexmounts.

Since this type of document is created using standard InDesign functionality, instructions on how to create the
document itself are outside the scope of STEP documentation. Refer to Adobe InDesign's help documentation for
more information. However, the information is presented here to illustrate the recommended document setup for
mounting indexes generated fromSTEP.
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Configuring InDesign Paragraph and Character Styles for Indexes
The indexmounting pagemust also have InDesign paragraph styles and character styles configured to properly
format the different levels of the index.

Note: This topic does not explain how to create InDesign paragraph styles and character styles themselves; see
thePublication Template Layout, Formatting, and Styles topic for more information.

As illustrated in theCreating an Index Words Structure topic, there aremultiple levels to indexwords—Level 1,
Level 2, and so forth.

In the index XML, these levels have corresponding tags. Level1 corresponds to the <Level1> tag, PageNumber
corresponds to the <PageNumber> tag, and so forth.
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Paragraph Styles for Index Words
Each level of indexwords needs to have a corresponding paragraph style configured in InDesign, not only for the
textual formatting but to place the dot leaders between the words and the page numbers. Best practice is to name
the paragraph styles tomatch the tag names, though any naming can be used as long as the styles are correctly
mapped to the tags. See the 'Mapping Styles After Importing the XML' section of this topic below for more
information.

Formatting of the styles is up to the user, but the following screenshots show a common configuration. 'Level1' is a
bold 12 pt font; 'Level 2' is a bold 9 pt font; and 'Level3' is a regular 8 pt font. The font sizes typically get smaller as
the index levels go lower.

Creating Dot Leaders in Paragraph Styles
To place dots between the indexwords and page numbers in your index, you will need to configure dot leaders.
Dot leaders are embedded into the Tabs area of InDesign paragraph styles and are configured as follows.

1. Open the InDesignParagraph Styles panel (Window > Styles > Paragraph Styles, or F11), then double-click
on the paragraph style that you would like to edit.

2. On theParagraph Style Options dialog, click on Tabs in the left column.
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3. Under Tabs in the right panel, select the right tab icon (1 in the below screenshot), then click the white area
above the ruler to place the tab. Drag the tab over until it alignswith the edge of the column (2 in the below
screenshot).
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4. Enter a period in the Leader field (3 in the above screenshot), then clickOK (4).

5. The dot leader is now configured. Repeat the above steps for all other paragraph styles that should have a dot
leader.

Character Styles for Page Numbers
Page numbers are frequentlymounted using a character style, as it is common for the page number to be a
different style than the indexword immediately preceding it. In the below instance, the 'Level3' paragraph style is
used to format the indexword ('Bookplates & Protectors') and the character style 'PageNumber' is used to
override the Level3 paragraph style with a 9 pt bold font for the page number.

Importing an Index XML File Into InDesign
After formatting your indexmounting page and the paragraph and character styles, the next step is to import the
index XML file into InDesign.With your indexmounting page open, follow these steps to import the index XML file.
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1. Open the InDesignPages panel (Window > Pages, or F12), then click on the page in the lower portion of the
panel. Since indexes are not mounted onmaster pages, the pagemust be selected.

Note: Themaster pagemust be applied to the page. In the below example, the A-Master master page has
been applied to page 1.

2. Navigate to File > Import XML... in the Filemenu to import the index XML file.
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3. In the Import XML dialog that displays, locate the XML tile that you want to import, then clickOpen.
4. ClickOK on theXML Import Options dialog that displays. All settings can be left as-is.
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5. The index file (AlphaIndex) displays in the InDesign XMLStructurewindow on the left-hand side of the
InDesign interface.

Mapping Styles After Importing the XML
After importing the index XML file, the next step is to map your paragraph and character styles to the XML tags
contained within the index file. Thismapping ensures that your indexwill be properly formatted and that styles can
be applied automatically uponmounting.

1. Click theOptionsmenu in the upper right corner of the InDesign XML structure panel, then clickMap Tags to
Styles.
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2. TheMap Tags to Style dialog displays.
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3. If your style names are identical to the tag names, clickMap By Name to automaticallymap the tags to the
styles, then clickOK.

4. If your style names do notmatch the tag names, theymust bemapped.

l In theStyle column of theMap Tags to Styles dialog, click on [Not Mapped] for each tag that you would like
tomap.

l Select the relevant paragraph style or character style from the dropdown list.

l Follow these steps for the remainder of styles that should bemapped.
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5. ClickOK when complete.

Mounting the Index XML
After mapping the index tags to the paragraph and character styles, the next step is to mount the index onto the
page. Themounting is performed by a drag-and-dropmethod.

1. Select the AlphaIndex XML file in the InDesignStructure panel.
2. While holding down your left mouse button, drag the index onto the page in the desired location (typically the

upper left corner of the page).

3. The index is now mounted with the relevant mapped styles applied to each level of the index. The next step is to
generate the dot leaders by replacing the # characters with tab characters.
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Replacing Special Characters With Dot Leaders on the InDesign Page
The final step inmounting the index is to complete the formatting by replacing the # symbols with a right-tab
character in InDesign, which will insert the dot leaders.

1. With themounted index open in InDesign, click on Ctrl+F or Edit > Find/Change to open the Find/Change
menu.

2. Type # in the 'Find what' field and ^y in the 'Change to' field. ^y is the InDesign character for Right Indent Tab.
3. ClickChange All, then clickDone.
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4. Your index should now resemble the following:
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Additional Index Formatting Options
Additionally, youmay format your index by any of the followingmethods:

l turn the index into an InDesign table by clickingConvert Text to Table in the Tablemenu
l format the index anyway you want by using InDesign’s native table formatting features

Exporting and Importing Publications
Publicationsmay be exported from and imported into STEP in two formats:Publication Excel andSTEPXML.
Both formats supports all publication types: standard STEP'n'design ('drag and drop'), Flatplanner, and
AutoPage. In addition, publications and their accompanying templates can be exported from one STEP system
and imported into another through the use of publication Transfer Packages.

Using Publication Excel sheets, STEPXML files, and transfer packages to export and import publications can help
reduce the time spent onmanual publication-building tasks in the workbench, such as themanual creation of
publication hierarchies aswell as the linking of product, asset, and classification objects into publication sections.
Publication transfer packages not only include this functionality, but they also remove the need tomanually link
templates into a new publication created from the import.

The ability to export and import publications also greatly simplifies themigration of publications from one STEP
system to another, reducing the number of manual steps needed to duplicate and/or rebuild these publications.

The Publication Excel sections of this documentation explain the information included in the spreadsheet for
standard ('drag and drop')publications. For information on the additional information included in the export of
Flatplanner and AutoPage publications in the Publication Excel format, see these sections of the Flatplanner and
AutoPage documentation:

l Exporting and Importing Flatplanner Publications in Excel

l Contents of Flatplanner Publication Excel Exports

l Exporting and Importing AutoPage Publications in Publication Excel

Exporting Publications in Excel
Publications can be exported and imported in an Excel format calledPublication Excel. The Publication Excel
format supports all publication types: standard STEP'n'design ('drag and drop'), Flatplanner, and AutoPage.

The typical first step in using a Publication Excel sheet to import a publication is to export a pre-existing publication.
This exported Publication Excel file can then be used as a 'template' sheet to import new publications.

Note: The Publication Excel format is only available when exporting from the publication level. It is not available
for exports from the publication group level or section level.

The following screenshots show a sample Publication Excel spreadsheet in two sections, displaying the columns
that apply to standard publications. The Publication Excel format only allows one object per row.
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Information Included in the Export
The following table outlines the contents of a Publication Excel export for a standard publication.

Column Header Description

PublicationID STEP ID of exported publication

PublicationName STEP Name of exported publication

PublicationType Object type ID of exported publication

PublicationTemplateID STEP ID of publication template linked to the exported publication

PublicationInheritedUnit Unit applied to the publication group that contains the publication (mm, inches,
points, or picas)

VersionID STEP ID of the publication version(s) of the exported publication

VersionName STEP Name of the publication version(s) of the exported publication

VersionContextID STEP ID of the context(s) used in the publication version(s) of the exported
publication

VersionWorkspaceID STEP ID of the workspace(s) used in the publication version(s) of the exported
publication

LayerMappingTemplate Name of the layers in the product template. Not commonly used for standard 'drag
and drop' publications.
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Column Header Description

LayerMappingDocument Name of the corresponding layer in the publication document, which is either the
publication template or themounting page. Not commonly used for standard 'drag
and drop' publications.

LayerMappingOwner Displayswhether the publication version to which the layer ismapped is the owner
of the layer. Not commonly used for standard 'drag and drop' publications.

SectionLevel A number that represents whether the section is a top-level section (1) or a
subsection (2, 3, 4, etc.)

SectionID STEP ID of the exported publication section(s)

SectionName STEP Name of the exported publication section(s)

SectionTypeID Object type ID of the exported publication section(s)

MetaDataAttributeID STEP ID of metadata (description) attributes linked to the publication or section
(columnwill not appear in the export if there are no values populated for the
metadata attributes)

MetaDataAttributeValue Value of metadata (description) attributes linked to the publication or section
(columnwill not appear in the export if there are no values populated for the
metadata attributes)

ProductTemplateID STEP ID of the product template(s) linked to the exported publication

Location of Publication Export Information in STEP
The following sections use a sample publication to illustrate where the information included in a Publication Excel
export resides in the STEP workbench.

The information in this topic is also applicable for STEPXML exports, but the 'tags' listed in this topic are the
column headers that appear in Publication Excel files. For more information on STEPXML exports of publications,
see theExporting and Importing Publications in STEPXML topic.

Publication Group Tab (Parent Publication Group)
ThePublicationInheritedUnit field contains the unit used in the publication. The unit for a publication is set on
the publication group parent object that contains the publication. This unit inherits to all publications contained
within the publication group.
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Publication Tab
In this example, the sample publication contains eight top-level sections, two linked product templates, one
metadata (description) attribute that contains a value, and four mapped layers.

1. ThePublicationID andPublicationName columns contains the STEP ID and STEP Name of the
publication, respectively.

2. ThePublicationType column contains the object type ID of the publication.

3. ThePublicationTemplateID column contains the STEP ID of the publication template.

4. TheMetaDataAttributeID andMetaDataAttributeValue columns contain the STEP ID(s) and STEP Names
(s) of populatedmetadata attributes that appear on the publication and section(s). (If a publication / section has
linkedmetadata attributes but these attributes do not contain values, theMetaDataAttributeID and
MetaDataAttributeValue columnswill not appear on the exported sheet.)

5. TheProductTemplateID column contains the STEP ID(s) of the product template(s).

6. The LayerMappingTemplate column contains the name of the layer in the templates (Publication and/or
Product); LayerMappingDocumentwill contain the name of the corresponding layer in the Publication
Document (mounting page); and LayerMappingOwner will display whether the publication version to which
the layer ismapped is the owner of the layer—value of 'true' or 'false.' In the following screenshot, 'English US'
(displayed in bold) is the owner of the 'Images' layer.

Note:When exporting a 'model' publication in order to use the resulting Publication Excel sheet as a template for
later publication imports, it is recommended to populate at least onemetadata attribute on the publication (and
each section) with a 'dummy' value. This ensures that theMetaDataAttributeID andMetaDataAttributeValue
columns appear on the 'template' sheet and will not have to bemanually inserted later.
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Sections, Subsections, Linked Products, and Assets
The sample AutoPage publication also contains subsections (sectionswithin sections), product objects, and asset
objects linked to the publication sections.
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l TheSectionLevel column contains a number that represents whether the section is a top-level section (1) or a
subsection (2, 3, 4, etc.).

l TheSectionID andSectionName columns contain the STEP IDs and STEP Names of all sections and
subsections.

Version Tab
All information related to the publication version(s) is included in the export.

1. TheVersionID column contains the STEP ID(s) of the publication version(s).

2. TheVersionName column contains the STEP Name(s) of the publication version(s).

3. TheVersionContextID column contains the STEP ID(s) of the context(s) to which each publication version is
linked.

4. TheVersionWorkspaceID column contains the STEP ID of the workspace to which each publication version
is linked (will either be 'Main' or 'Approved').

Exporting a Publication Excel Sheet
The following steps explain how to export a Publication Excel sheet from a publication object in STEP.

1. Right-click on a publication object and selectExport Data Below, or go to File > Export > Data.

If you export directly from the publication object, the publication will already be selected in Step 2 of the Export
Manager (Select Objects), andPublication Objects will already be populated in the Export dropdown list. If
you wish to export more than one publication, click 'AddObjects' and addmore publications.

2. Nothing else needs to be done on the Select Objects screen, as all other options are grayed out when
Publication Objects is selected for export. ClickNext.

Note: Though the option exists on this screen to choose a publication Version, there is no need to do so since
the sheet contains information that applies to all versions in the publication.
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3. On the Select Format screen, choosePublication Excel from the dropdown list. then clickNext.

Note: The Include Unique Keys as IDs is relevant for standard 'drag and drop' publications if the following
conditions apply: 1) Objects have been linked to the publication sections to organize them for mounting, and 2)
Unique keys have been used instead of STEP IDs to identify them. However, since it ismore common practice
to link objects to sections in AutoPage publications, the instructions on how to work with the unique key option
are provided in theExporting and importing AutoPage Publications in Excel section of theAutoPage
documentation.

4. Since data does not need to bemapped for the Publication Excel format, theMapData screen will be skipped.

5. On the Advanced screen, choose aContext if you have dimension-dependent data section names, page
names , or metadata attribute values that you would like to see in a particular language. All other settingsmay
be ignored. ClickNext.

Note: If metadata attributes attached to publication or section objects are populated using Inline References,
unchecking 'Resolve Inline References' will not cause the values to export as unresolved.
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6. Choose File as the DeliveryMethod in Step 6, then clickFinish.
7. On theSave Export Configuration screen, check 'SaveOptions' if you would like to save the Export

configuration.

8. ClickOK, then retrieve the Excel file.

Considerations and Limitations

l Thoughmultiple publicationsmay be exported in a single Publication Excel file, multiple publicationsmay not be
imported in the Publication Excel format. To import multiple publications at once, the STEPXML format must be
used. For information on importing publications in STEPXML, see theExporting and Importing
Publications in STEPXML topic.

l Support for Publication Excel export is currently unavailable in theWebUI.

Importing Publications in Excel
Publications can be imported in an Excel format calledPublication Excel. All objects required for a publication in
the green Publication hierarchy can be created with a Publication Excel import, with the exception of publication
group objects. The Publication Excel format supports all publication types: standard STEP'n'design ('drag and
drop'), Flatplanner, and AutoPage.

The typical first step in importing a publication in the Publication Excel format is to export a pre-existing publication.
This exported Publication Excel file can then be used as a 'template' sheet for new publications, i.e., existing
information on the export sheet will be replaced with new information for the subsequent import. For more
information on the Publication Excel export process, seeExporting Publications in Excel.
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The following screenshots show a sample Publication Excel spreadsheet that could be used to create a two-
version publication with multiple sections and subsections. In addition, this sheet is populated with data that will link
product and asset objects to the sections, populatemetadata attributes that exist on the publication and sections,
and create pagination rules for the publication and sections. Note that the ID fields have been left blank for
PublicationID, VersionID, and SectionID, as the intention is for the system to autogenerate these IDs upon import.

Note: It is strongly recommended that the STEP ID is set to autogenerate (by use of an ID Pattern) for the
'Publication Version' BasicObject Type and all object types used to create publications and sections (typically
'Default publication type' and 'Section'). If not, youmust provide these IDs in the Publication Excel import sheet. If
a Publication ID on the import sheet matches the ID of an existing publication in STEP, the import will simply
update the existing publication. For information on autogenerating STEP IDs, seeAutogenerate Using Name
Pattern and ID Pattern in theSystem Setup / Super User documentation.
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Mandatory and Optional Information for Publication Excel Imports
The following table outlines the contents of aPublication Excel import spreadsheet and whether the fields are
mandatory or optional. The columns are ordered from top to bottom as theywould appear left to right when
exported fromSTEP. Columns can be reordered or removed before import as long as there is only one object per
row. Columnsmay be reordered or removed if, for example, you find that a certain order ismore intuitive or if you
would like to work with amore compact spreadsheet that contains only the columns that you need.

Though a publication template and product template(s) are required tomanually create a publication in STEP, this
is not the case for Publication Excel imports. The fields for PublicationTemplateID and ProductTemplateID are
listed as optional in the following table because templates can be linked to publication(s) in STEP after the
publication is created. In addition, a Publication Excel import can create sectionswithout a designated version,
hence the optional designation for VersionID. This functionality is useful if you would like to quickly create the
structure of a publication before deciding which templates or versions you will need. The bareminimumamount of
information that is required to create a publication with a Publication Excel import is the object type ID of the
publication and the object type ID(s) of the section objects.

Note: Even though the systemwill allow a Publication Excel import to create a publication without a version, it is
not recommended to do so. A versionmust still be created before the publication can actually be used for
production, as actual pages cannot be built in InDesign without a version.

Column Header Description Mandatory?

PublicationID STEP ID of imported publication No

(Yes if the STEP ID of the publication
object type is not set to autogenerate)

PublicationName STEP Name of imported publication No

PublicationType Object type ID of imported
publication

Yes

PublicationTemplateID STEP ID of publication template
linked to the imported publication

No, but it is strongly recommended to
provide this information.

If not provided in the import, a publication
templatemust bemanually linked to the
publication before it can be used for
production.

PublicationInheritedUnit Unit applied to the publication group
that contains the publication (mm,
inches, points, or picas)

No, but it is strongly recommended to
provide this information.

If not provided in the import, the unit will
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Column Header Description Mandatory?

default to mm, regardless of what unit is set
on the existing publication group.

VersionID STEP ID of the publication version
(s) of the imported publication

No

(Yes if the STEP ID of the publication
version object type is not set to
autogenerate)

VersionName STEP Name of the publication
version(s) of the imported
publication

No

VersionContextID STEP ID of the Context(s) used in
the publication version(s) of the
imported publication

No, but it is strongly recommended to
provide this information.

If not provided in the import, the version
context ID must bemanually added to the
publication before it can be used for
production.

VersionWorkspaceID STEP ID of the workspace(s) used
in the publication version(s) of the
imported publication

No, but it is strongly recommended to
provide this information.

If not provided in the import, the version
workspace ID must bemanually added to
the publication before it can be used for
production.

LayerMappingTemplate Name of the document layers in the
templates (Publication, Product, and
InDesign-created Page templates)

No

LayerMappingDocument Name of the corresponding
document layers in the Publication
Document (mounting page)

No

LayerMappingOwner Whether the publication version to
which the layer ismapped is the
owner of the layer ('true' for yes,
'false' for no)

No
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Column Header Description Mandatory?

SectionLevel A number that represents whether
the section is a top-level section (1)
or a subsection (2, 3, 4, etc.)

No

(Yes if you do not want all sections to
import as top-level sections)

SectionID STEP ID of the imported publication
section(s)

No

(Yes if the STEP ID of the section object
type is not set to autogenerate)

SectionName STEP Name of the imported
publication section(s)

No

SectionTypeID Object type ID of the imported
publication section(s)

Yes

MetaDataAttributeID STEP ID of metadata (description)
attributes linked to the publication or
section

No

MetaDataAttributeValue Value of metadata (description)
attributes linked to the publication or
section

No

ProductTemplateID STEP ID of the product template(s)
linked to the imported publication

No, but it is strongly recommended to
provide this information.

If not provided in the import, a product
templatemust bemanually linked to the
publication before it can be used for
production.

Importing a Publication Excel Sheet

1. Right-click on the publication group object in which you would like to create your publication, then select Import
Publication.
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2. In theSelect Excel file dialog that displays, navigate to the desired Publication Excel file, then clickOpen.
3. In theSave Import Configuration dialog that displays, selectStart Import Process, then clickOK. The file

will import with no additional prompts, as columns do not need to bemapped for Publication Excel imports.
STEP automatically recognizes the file format, which is pre-mapped.

Importing a Publication Excel Sheet – Alternate Methods
Alternately, youmay import a Publication Excel sheet by the followingmethods:

l Import Manager (File > Import > Data)

l Hotfolders (IIEP)

l PublishingWebUI (Import Publication XLS Action)

Importing Publication Excel Files in the Import Manager (File > Import > Data)

The File > Import > Datamethod launches the Import Manager wizard, which involvesmore screens to click
through but providesmore control over what happenswhen the Publication Excel file is imported. Some standard
options in the Import Manager wizard are available for the Publication Excel import format just as they are for other
formats, including the ability to perform a test-only import and run business rules on import.
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Note: The imported publication will be created beneath the top (root) node of the Publication hierarchy if this
option is chosen.

The following steps presume that a new import configuration is being created.

1. InStep 1 (Select Configuration), choose Create New Import. Click Next.

2. InStep 2 (Select Data Source), choose the Publication Excel file that you would like to import. Click Next.
3. InStep 3 (Select Format), the Publication Excel format will already be selected and the Import Manager will

display a preview of the file. This visual representation of the file may prove useful as a 'final check' on the
import sheet's contents before proceeding with the import. Click Next. Steps 4 and 5 will be skipped.
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4. InStep 6 (Identify Destination), all settingsmay be ignored, as none of them apply to publication objects.
However, youmay checkTest Only Import if you would like to run the import as test only. Click Next.

5. InStep 7 (Select BusinessRules), business conditions and/or actionsmay be selected if workflows have been
configured for publication and/or section objects. ClickNext.

6. InStep 8 (Advanced Settings), all settingsmay be ignored. ClickFinish.
7. CheckSave Options on the Save Import Configuration screen if you would like to save the Publication Excel

import configuration. ClickOK to complete.

Importing Publication Excel Files Via Hotfolders

Publication Excel filesmay also be uploaded via hotfolders, which are configured through Inbound Integration
Endpoints (IIEPs). Configuring an IIEP for Publication Excel imports is similar to configuring a Publication Excel
import using the standard Import Manager.

Note: The imported publication will be created beneath the top (root) node of the Publication hierarchy if this
option is chosen.

For more information on configuring hotfolders and IIEPs, seeCreating an Inbound Integration Endpoint in
theData Exchange documentation.

Importing Publication Excel Files in Web UI

In theWebUI, Publication Excel import functionality is available through the Import Publication XLS Action, which
can be added as a button on a Node Details component. It is intended to be used from a publication group details
screen, as publicationsmust be imported into a publication group folder.
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For information on the PublishingWebUI, SeeSTEP Publishing Web UI in theWeb User Interfaces
documentation.

Considerations and Limitations

l Thoughmultiple publicationsmay be exported in a single Publication Excel file, multiple publicationsmay not
be imported in the Publication Excel format. To import multiple publications at once, the STEPXML format
must be used. For more information, see theExporting and Importing Publications in STEPXML topic.

Linking Objects to the Publication Hierarchy by Excel Import
Product, classification, and asset objectsmay be linked to publication sections in the Publication (green) hierarchy
by using aPublication Excel import sheet.

Though the Publication Excel format can be used to create entire publications on import, it can also be used to link
objects into the sections of existing publications.

Note: The Publication Excel format will only link objects to publication sections. If you need to link objects to a
publication, this linkingmust be performedmanually. See the Linking and Unlinking Publication Products,
Assets, and Classifications section of theGetting Started / STEP User Guide.
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To obtain the 'template' spreadsheet that you will use for your import, you should first export the publication into
which you would like to link your objects. To export the publication, follow the steps outlined in theExporting a
Publication Excel Sheet section of theSTEP'n'design documentation.

Once you have the Publication Excel sheet, follow these steps to link objects to the sectionswithin your
publication. The first two steps are optional, as columns do not actually need to be removed for the sheet to
function correctly. However, removing extraneous columnsmakes the sheet easier to manage.

1. Delete all columns betweenPublicationID andSectionLevel (in this example, columnsB through J).

2. Delete all columns after SectionTypeID (in this example, F through H).

3. Add two columns at the end with these headers: LinkedObjectID and LinkedObjectType.

4. Insert blank rows beneath eachSection into which you would like to link products, assets, and/or
classifications. Then, enter the STEP IDs of the linked objects in the LinkedObjectID column, starting with the
row directly beneath the appropriate Section row.
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A list of STEP IDs of products, assets, and/or classificationsmay be obtained by exporting the relevant
objects—in Excel format—from their respective hierarchies in STEP or from aCollection. These IDs can then
be pasted into the LinkedObjectID column of the Publication Excel sheet where needed. See theExcel
Format section of theData Exchange documentation for more information.

5. If you use unique keys instead of STEP IDs as identifiers for the objects that you are linking, you will need to
also include a column called LinkedObjectKeyID and populate it with the ID of the relevant unique key. In the
LinkedObjectID column, the value of the unique key should appear instead of the STEP ID. See theUnique
Keys topic in theSystem Setup / Super User Guide documentation for more information on setting up and
using unique keys.

6. In the LinkedObjectType column, enter 'Product', 'Asset', or 'Classification', depending on what type of object
is being linked.

Note: The generic terms 'Product', 'Asset', and 'Classification' are required; the actual object types of the
linked items should not be specified.
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7. Repeat the above steps for each additional section into which you would like to link objects.

Importing the Sheet
Once all STEP IDs and object type designations have been added to the sheet, import it into your publication by
following these steps:

1. Right-click on the publication group that contains your publication and select Import Publication....
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2. In theSelect Excel file dialog that displays, navigate to the desired Publication Excel file, then clickOpen.
3. In theSave Import Configuration dialog that displays, selectStart Import Process, then clickOK. The file

will import with no additional prompts, as columns do not need to bemapped for Publication Excel imports.
STEP automatically recognizes the file format, which is pre-mapped.

4. When the background process successfully completes, the product, asset, and/or classification objects will be
linked into the publication sections.

For more information on other ways to import a Publication Excel sheet (for example, by using the Import Manager
or inWebUI), see the Importing a Publication Excel Sheet topic.

Exporting and Importing Publications in STEPXML
Publications and publication hierarchies can be exported and imported using the STEPXML file format.
STEPXML supports publications created with any STEP publisher component: STEP'n'design (standard 'drag
and drop'), Flatplanner, and AutoPage. The STEPXML format is available when exporting from any node in the
publication hierarchy—publication group, publication, or section.

This topic explains themanual process for exporting publications in STEPXML using theExport Manager in the
STEPWorkbench, the outbound parameters available for publications, a sample XML file, and a description of the
tags inside the resulting STEPXML file.
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The STEPXML format can also be used to import and export publications using inbound integration endpoints
(IIEP) and outbound integration endpoints (OIEP), respectively.

Importing a Publication in STEPXML
Publications and publication structures can be created by importing a STEPXML file. This same file can also be
used to link the relevant publication template and product templates to the publication, populatemetadata
attributes on the publication objects, andmore. An example of a STEPXML file that can be used to import a
publication is provided later in this topic in the 'File Example' section. Multiple publications can be imported at once
using STEPXML, which is an advantage that the STEPXML format has over the Publication Excel format.

Instructions on how to import the STEPXML file itself are not detailed in this topic since the steps are the same as
those for importing any other type of data into STEP using STEPXML. Publications can be importedmanually
using the Import Manager or automatically using an inbound integration endpoint (IIEP).

For more information, see the Import Manager and Inbound Integration Endpoints sections of theData
Exchange documentation.

Exporting a Publication in STEPXML
Instructions on how to export a publication in STEPXML using anOIEP are not detailed in this topic since a
publication STEPXML file is used in anOIEP just like any other STEPXML file. For more information, see the
Outbound Integration Endpoints section of theData Exchange documentation.

The overall steps to export a publication in the STEPXML format using the Export Manager are the same as those
used in exporting any other type of data fromSTEP. The following steps describe the additional publication-
specific options that must be chosen, such as the outbound parameters that are chosen in the Select Format step
of the wizard.

1. To initiate the export, follow the initial steps outlined in theCreating a Data Export topic in theExport
Manager documentation.

2. On the Select Objects screen, add the publication hierarchy object(s) that you would like to export by following
the steps outlined in theExport Manager - Select Objects topic in theExport Manager documentation. You
can also initiate the export by right-clicking on a publication group, publication, or section object in the
publication hierarchy and selecting 'Export Data Below.'

3. ChoosePublication Objects from the 'Export' dropdown in the lower right corner of the wizard, then click
Next.

l If the publication containsmore than one version, a version can be selected from the dropdown list in the
Version column. Typically, the contents of the export will be the same regardless of which version is
selected. However, in some cases it may be necessary to select a version if there are differences on actual
pages saved to STEP. For example, a different product or asset may bemounted to an English version but
not a French version.
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4. On the Select Format screen (step 3), chooseSTEPXML from the dropdown list.

5. The STEPXML outbound parameters that apply to publication objects are highlighted in the below screenshot.
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Choose the relevant information that you want to include in your export, then clickNext. All other default
options can be left as-is (for example, 'Include Products' = Minimum).

Note: The only options available for publication parameters are 'All' or 'None.' Youmay need to experiment
with the combination of objects selected in the Select Objects step and the 'All' settings chosen in the Select
Format step to ensure that you do not get toomuch or too little information in your export. For instance, if you
export from a publication object and select 'All' for 'Include Publication Groups' but 'None' for 'Include
Publications,' the export will include all publication groups that exist in your STEP system aswell as the single
publication selected, even though 'None' was selected for publications.

l The following publication parameters are relevant for all types of publications (standard STEP'n'design,
Flatplanner, and AutoPage):

l Include Publications

l Include Publication Groups

l Include Publication Sections

l Include Actual Page Data: relevant if you have savedmounted DTP documents into your publication

l The following options are valid for Flatplanner publications. For more information, seeExporting and
Importing Flatplanner Publications in STEPXML in the Flatplanner documentation.

l Include Planned Pages

l Include Baskets

l Include Pagination Rules

l The following options are valid for AutoPage publications. For more information, seeExporting and
Importing AutoPage Publications in STEPXML in theAutoPage documentation.

l Include Autopage References

l Include Pagination Rules

Note: Include Autopage References is also relevant for standard 'drag and drop' publications if objects have
been linked to the publication sections to organize them for mounting. However, since it ismore common
practice to link objects to sections in AutoPage publications, this option is instead detailed inExporting and
Importing AutoPage Publications in STEPXML in theAutoPage documentation.

6. TheMapData step is skipped aswith any other STEPXML export, since data is not mapped in the STEPXML
format.

7. The options in the Advanced step and the Select DeliveryMethod step are the same as those available for any
other type of STEPXML export. SeeExport Manager - Advanced andExport Manager - Select Delivery
Method in theExport Manager documentation for more information.

Note: Though the Select version used to resolve tables option references publication versions, this
setting is only relevant if the 'Include Tables' parameter is set to 'Yes' in the Select Objects step. This setting
has no impact on publication-only exports. For more information, see theExporting Resolved Tables topic
in the Tables documentation.
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File Example
The following STEPXML sample shows an export from a standard publication that contains two versions, three
sections, andmetadata attributes on the publication and section objects.

Note: This example does not contain code for Actual Page Data, since that information is only of value for
exports. It cannot be imported into STEP to create actual pages. See the 'Include Actual Page Data' section
below in this topic for a code sample.

<STEP-ProductInformation ExportContext="Context1" ContextID="Context1" WorkspaceID="Main"
UseContextLocale="false">

<PublicationGroups>

<PublicationGroup UserTypeID="Publication group root" ParentID="108372" ID="115722">

<Name>Standard Publications</Name>

<Publication UserTypeID="Default publication type" MasterDocumentID="107822"
DTPType="InDesign" ParentID="108372" ID="111508">

<Name>Beta Tools</Name>

<MetaData>

<Value AttributeID="LastPageNumber" Derived="true">0</Value>

</MetaData>

<Version ContextID="Context1" WorkspaceID="Main" ID="111511">

<Name>English US</Name>

</Version>

<Version ContextID="Context2" WorkspaceID="Main" ID="111510">

<Name>France FR</Name>

</Version>

<ProductTemplateLink ProductTemplateID="107821"/>

<PublicationSection ID="111512" UserTypeID="Section">

<Name>Power Tools</Name>

<MetaData>

<Value AttributeID="LastPageNumber" Derived="true">0</Value>

<Value AttributeID="FirstPageNumber" Derived="true">0</Value>

</MetaData>

</PublicationSection>

<PublicationSection ID="111513" UserTypeID="Section">

<Name>Hand Tools</Name>

<MetaData>

<Value AttributeID="LastPageNumber" Derived="true">0</Value>

<Value AttributeID="FirstPageNumber" Derived="true">0</Value>

</MetaData>

</PublicationSection>

<PublicationSection ID="111514" UserTypeID="Section">
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<Name>Toolboxes</Name>

<MetaData>

<Value AttributeID="LastPageNumber" Derived="true">0</Value>

<Value AttributeID="FirstPageNumber" Derived="true">0</Value>

</MetaData>

</PublicationSection>

</Publication>

</PublicationGroup>

</PublicationGroups>

</STEP-ProductInformation>

Information Included in the Export
The following sections explain the data included in the STEPXML file in the order in which it appears in the file.

Include Publication Groups

Tag Description

<PublicationGroup> Returns the following information:

l UserTypeID: The object type of the publication group

l ParentID: The ID of the parent publication group

l ID: The STEP ID of the publication group

l UnitID: The ID of the default unit set on the publication group
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Tag Description

<Name> Returns the STEP name of the publication group

<MetaData> Parent tag for <Value> tags

<Value> Returns the ID (AttributeID) and value of the description (metadata)
attributes present on the publication group. If an attribute is calculated,
Derived="true".

Include Publications & Include Publication Sections
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Publication Information

Tag Description

<Publication> Returns the following information:

l UserTypeID: The object type of the publication

l MasterDocumentID: The ID of the publication template linked to the publication

l DTPType: The DTP (desktop publishing) platform used in the publication, which
will always be InDesign. This is a backward-compatible tag from previous
versions of STEP where there could have been a choice between InDesign and
Quark as the DTP type.

l ParentID: The ID of the publication's parent publication group

l ID: The ID of the publication

<Name> Returns the STEP name of the publication

<MetaData> Parent tag for <Value>
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Tag Description

<Value> Returns the ID and value of the description (metadata) attributes present on the
publication. If an attribute is calculated (as shown in the above example), Derived
="true".

<Version> Returns the following information:

l ContextID: The ID of the context used in the publication version

l WorkspaceID: The ID of the workspace used in the publication version

l ID: The ID of the publication version

<Name> When nested inside the <Version> tag, returns the STEP name of the publication
version

<ProductTemplateLink> Returns the ID of the product template(s) linked to the publication
(ProductTemplateID=)

Section Information

Tag Description

<PublicationSection> Returns the ID and object type ID (UserTypeID) of the publication section(s) contained
within the publication

<Name> Returns the STEP name of the publication section

<MetaData> Parent tag for <Value>

<Value> Returns the ID and value of the description (metadata) attributes present on the
publication section. If an attribute is calculated (as shown in the above example),
Derived="true".

Include Actual Page Data
When actual mounted InDesign pages are saved into STEP, they appear in the STEPXML file as <Assets>.

Note: Actual page assets are not nested within the publications that contain them but appear in a separate
section in the XML file. TheVersionID indicateswhich publication version the assets are stored in. To determine
the publication, the version should bematched to the publication that contains it. The VersionID for the pageswill
typicallymatch the publication version is chosen in the Select Objects step of the Export Manager.
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Tag Description

<Asset> Returns the ID and the UserTypeID (object type) of the InDesign
document, which will always be 'InDesign Document.'

<Name> Returns the STEP name of the InDesign document. This can be different
from the file name returned within the <Value> tag.

<Value> Returns the values of the systemmetadata attributes 'asset.size' and
'asset.filename'
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Tag Description

<Page> Returns the following information:

l ID of the page

l VersionID: The ID of the publication in which the page is stored

l PageNumber: The page number of the individual pageswithin the
InDesign document. InDesign documents typically havemultiple pages.

<ProductCrossReference> Returns the following information:

l ID of the productsmounted onto the page

l The 'reference type' of the product 'link' (Type="MountedProduct")

l The status of whether the product is actually on the page
(MountLocation="true"). The value is false if the product is not actually
on the page and is just referenced; for example, in a STEP table listing
product accessories. If MountLocation="false", then the product will not
be included in an index export.

Note: No actual reference or link types are used to link products onto
pages. They are linked onto pages by beingmounted in InDesign.

<AssetCrossReference> Returns the following information:

l ID of the assetsmounted onto the page

l The 'reference type' of the asset 'link' (Type="MountedAsset").

Note: No actual reference or link types are used to link assets onto pages.
They are linked onto pages by beingmounted in InDesign.
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Creating an InDesign Package in STEP
Once all InDesign pages have been created and saved back into a publication in STEP, you can generate an
InDesign package from the publication fromwithin the workbench. An InDesign package contains all of the
InDesign files, fonts, and images (links) associated with the publication. Once created, an InDesign package can
be sent to a printer.

Note: An InDesign package is not the same thing as a publication transfer package. For more information, see
theWorking with Publication Transfer Packages topic.

This topic assumes that your STEP system is connected to an InDesign server. An InDesign server is required to
create InDesign packages. If your system is not connected to an InDesign server, contact your Stibo Systems
account manager for assistance.

Follow these steps to create an InDesign package:

1. In the Tree, locate the publication fromwhich you would like to export the InDesign package. Note that a
package can also be pulled from the section level if you do not want to generate a package for the entire
publication at one time.

2. Select the publication, then right-click and selectCreate InDesign Package from documents.
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3. A 'Starting process' dialog displays. ClickGo to process.
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4. The systemwill automatically redirect to theBG Processes tab and display the progress of the package
creation. The Execution Report section of the screen includes information on what InDesign documents are
being extracted aswell as what InDesign server renderer the job(s) are being sent to. If errors are
encountered, they are also displayed here.

5. When the process is done, click on the target.zip icon in the lower right corner of the interface and save the
.ZIP file to a location on your hard drive.
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6. The .ZIP package contains all InDesign files from the publication / section, as well as a 'Document fonts' and
'Links' folder. These files are located in the .ZIP package in a folder namedwith the ID of the background
process (e.g. BGP_233996).
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The following screenshots show sample contents of the 'Document fonts' and 'Links' folders:

Considerations

l If asset links do not appear in the package, the document contains broken links and the imageswill need to be
relinked before they can be extracted. For information on how to relink assets, see theRelinking Assets in
STEP'n'design topic.

l InDesign pageswill appear in the package just as theywere saved in STEP. If a single InDesign file is desired
that contains all pages, the filesmust be combined into the single document locally.
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Working with Publication Transfer Packages
Publications and their accompanying templates can be exported from one STEP system and imported into
another through the use of publication transfer packages.

Publication transfer packages enable the exporting of entire STEP publications and their associated templates
into a .ZIP folder, which can in turn be easily imported to STEP in a single operation. These transfer packages
contain the following items:

l Publication Excel spreadsheet

l Publication STEPXML file

l Publication templates

l Product templates

l Page templates (for Flatplanner publications only)

l XMLmapping files that link the STEP names of all templates to STEP IDs

l Export configuration property file

Note: Your STEP systemmust be connected to an InDesign server in order to import publication transfer
packages. If your system is not connected to an InDesign server, contact Stibo Systems for assistance.

Exporting a Publication Transfer Package
To create a transfer package for export, follow these steps:

1. In the Tree, navigate to the publication that you would like to export.

2. Right-click on the publication and selectExport to Transfer Package.

3. A background process starts and the 'Starting process Export to Transfer Package' dialog displays. ClickGo
to process in order to view the background process on the BGProcesses tab.
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4. When the export process is complete, click on the file icon (located at the bottom right corner of the
Background Processes tab screen), then save the .ZIP file to a location on your computer.

5. There is no need to extract the contents of the .ZIP file, as the .ZIP file itself is the transfer package that will be
used to import the publication and templates into STEP. The folders contained in the .ZIP file are as follows:

l pageTemplates:Contains all page templates associated with the publication and an XML file
(TemplateNameIDMapping.xml) that maps the file names of the templates to their corresponding STEP IDs.
The pageTemplates folder is always included but will only contain content when a Flatplanner publication is
exported.
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l productTemplates:Contains all product templates associated with the publication plus an XML file
(TemplateNameIDMapping.xml) that maps the file names of the templates to their corresponding STEP IDs.

l publication:Contains a Publication Excel sheet, a publication export STEPXML file (PUBLICATION_
EXPORTED.xml), and an export configuration file (ExportConfiguration.tmp).

l publicationTemplate: Contains the publication template associated with the publication plus an XML file
(TemplateNameIDMapping.xml) that maps the file name of the template to its corresponding STEP ID.

Importing a Publication Transfer Package
To import a publication transfer package, follow these steps:
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1. In the Tree, navigate to the publication group into which you would like to import the transfer package.

2. Right-click on the publication group and select Import Transfer Package.

3. The 'Select Zip File' dialog displays. Navigate to the publication transfer package .ZIP file that you would like to
import, then clickOpen.

4. In the 'Import Transfer Package' dialog that displays, check theCreate Group for Templates box if you
would like to create a new publication group to house the templates contained within the transfer package. This
new group will be created inside of the publication group that you have selected.

Enter an ID and a name for the new publication group, then clickOk. If you leave the box unchecked, then the
templateswill be imported directly into the publication group that you have selected.

5. A background process starts and the 'Starting process Import Transfer Package' dialog displays. ClickGo to
process to view the background process on the BGProcesses tab.
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6. When the background process completes, the publication and its associated templates are now created on the
destination system. If you checked theCreate Group for Templates box in step 4, this new publication group
is also created.

Note: If the Publication Excel / Publication STEPXML files in your transfer package contain the IDs of products,
classifications, or assets that do not exist on the destination system, these objects will not be created in the
destination system.

Generating Proof Views
Proof views can be generated for a single page or single spread in the STEPWorkbench using the Proof View
tab on product objects (blue Primary Product Hierarchy nodes). Proof views display a close representation of
how a product will lookwhenmounted onto a page.

Note: An InDesign server must be connected to your STEP system to enable proof view functionality, as it is the
InDesign server that generates proofs. For more information on the deployment of an InDesign server, contact
your Stibo Systems account manager.

Proof views are also available from theWebUI, but this topic only explains how to access proof views in the
workbench. See the Proof View topic in theWeb User Interfaces documentation for more information.

To generate a proof view in the workbench:
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1. In the Tree, navigate to the product object that you would like to preview, then click on theProof View tab.

2. In theSelect version dropdown, choose the publication version that you would like to use to preview the
product. By choosing the version, you are also selecting the publication and using its associated publication
template as the backdrop of the proof view.

3. If the version you are looking for is not on the initial dropdown list, clickOther to open theSelect Publication
Version dialog.

4. Browse to or search for the publication version that you would like to use, then clickSelect.

Note: If the context of the selected publication version does not match the context in which you are currently
viewing the workbench, the words 'Select version' will appear in red to provide you with a visual indicator that
the language displayed in the proof view will be different than that of the language displayed in the workbench.
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5. To select the product template that you would like to use to view the product, click the ellipsis button to the right
of the Template field. If a default product template has already been assigned to the product, it will display in
this field.

6. In theSelect Template dialog that displays, there are three tabs. By default, the dialog opens on theProduct
Templates tab.

l Product Templates: The product templates linked to the publication you chose from the 'Select version'
dialog display here. Only one can be chosen.

l Browse:Displays the publication hierarchy. Only product templates are available for selection.
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l Search:Displays a field where product templates can be located through typeahead search.

7. Once you have selected a product template, you canmake it the default product template for your product by
clickingSet as default.

l To confirm that the default template selection is successful, click on theProduct tab and check that the
template displays in theDefault InDesign template field.
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Note: If there is already a default product template assigned to the product, clickingSet as default on the
Proof View tab will overwrite the previously chosen template.

8. If you do not want to select a product template, and instead would like to pick up a layout from a publication in
which the product was previouslymounted, check thePickup Layout box.

Note: The Pickup Layout option is only available for systems that use the Flatplanner component.

l When Pickup Layout is checked, the Template field is replaced with aPickup field.

l Click the ellipsis button (…)to the right of the Pickup field to launch thePickup page layout for dialog.
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l Select the publication fromwhich you would like to pick up your product's layout. The bottom of the dialog
displays a preview of the actual page as it appears in the selected publication, with your product's layout
highlighted, and the rest of the page in gray.

l ClickUse selected to select the layout and close the dialog.

9. ClickEvaluate Pagination Rules to evaluate pagination rules that will affect the layout. This feature ismost
commonly used for product objects linked to AutoPage publications.When a pagination rule exists in the
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publication that you are using to view the proof, you can use this option to ensure that the pagination rule is
causing the product to display correctly.

10. ClickGet Proof to fetch the proof view from the InDesign server.

11. ClickZoom to zoom in or out of the proof. Zoom ranges from 25% to 400%. Alternatively, you can zoom in and
out by using the scroll wheel on your mouse.

12. ClickGet PDF to have STEP automatically generate a PDF of the proof view. This is considered a foreground
task of the InDesign server, as a background process is not kicked off. The PDF will automatically display in the
default PDF application once generated.

13. In thePDF Profile dropdown, the default selection isDefault.
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Note: PDF profiles are system dependent. Therefore, the PDF profile is set to Default if no special PDF
profiles have been configured for the system.

14. CheckUse workspace from version to view the proof using the workspace from the publication version,
which will be either Main or Approved. This option exists because proof views automatically display using the
workspace that you are currently using in the workbench, not the workspace attached to the publication
version.

Considerations for Proof Views
l For users who only use 'drag-and-drop' functionality to build InDesign pages, a 'dummy' publication template
may be linked to a publication in STEP instead of the actual 'mounting page.' This 'dummy' template (whichmay
be a blank page with no graphical elements) can be used solely to generate proof views in the workbench, while
actual pages are built in the InDesign client by dragging and dropping products onto themore fully developed
mounting page.

l The same fonts used in your publication and product templatesmust be installed on your InDesign server in
order for the pages to render accurately. If the fonts are not available, then a generic font (such asMinion Pro)
will be used for the rendering.

l If your system does not return proof views, one or more of the following issues could be the cause:

l Youmay not be connected to an InDesign server

l Your InDesign server may be offline, or one or more renderers on your InDesign server may be offline

l The InDesign templates stored on your STEP server were created with a higher version of InDesign
than that of your InDesign server. For example, if you are using templates that were created using a
CC 2017 version of InDesign but your InDesign server is running on CC 2014, then proof viewswill not
be fetched because the server cannot open the templates.

See the InDesign Queues topic for more information onmonitoring and troubleshooting the InDesign server.
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Updating Documents From InDesign
A key feature in STEP’n’design is the ability to update previously created page(s) with the latest content changes
fromSTEP. This functionality allows the page-building process to begin even when product data is not yet
complete or approved. The update featureswithin STEP'n'design ensure that the contents of your pages always
match the corresponding content in STEP.

STEP’n’design supports three ways of updating documents fromwithin InDesign:

l Checking the STEP database for updates

l Selectively choosing which data structure to update

l Direct update, where specific elements on the page are chosen for updates

This section describes how to check the content of the document against the corresponding content in STEP—
fromwithin InDesign—and how to update previously created pageswith the latest changes fromSTEP.

For information on how to update documents fromwithin the workbench without going into InDesign, see
Updating Documents From the Workbench. Note that youmust have an Adobe InDesign server (IDS) set up
and integrated with your STEP application server in order to update documents fromwithin the workbench. If you
do not have an IDS, youmust update all documents fromwithin InDesign, by themethods detailed within this
topic.

Checking Database Update
Because pages can be built before product data is complete or approved, it is possible, and often necessary, to
check the database for updates and update the InDesign pages accordingly throughout the publication production
cycle.

1. Open the page that you would like to update, then navigate to STEP > Check DB Update ....
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1. TheDatabase updates since place dialog displays. This dialog shows a list of elements placed on the page
(such as attributes) where the content no longer matcheswhat is currently in STEP.
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2. Check the relevant boxes on the right side of the dialog tomake updates to specific content only. Checking the
parent-level change will automatically select everything underneath. To select all boxes at once, check the
Select / Deselect All checkbox.

3. If a table is chosen for update, check theObtain values from transformed tables, preserve local table
styling and structure box in order to retain the existing table structure and only update the values. For
example, local stylingmight have been applied to the table on the InDesign page after its original mount, such
as the alteration of row / column sizes or the addition of color shading (either manually or through a previous
table transformation). Checking this box ensures that the table structure and formatting remain as-is and only
the values are updated. If the box is not checked, the entire table is re-sent from the database (force updated)
and any local updatesmade to the table are lost.

Note: If actual table structural changes have beenmade to the table in STEP, such as the addition or removal
of rows or columns, then the table will remount regardless of whether you have checked the 'Obtain values
from transformed tables' box.

There are twomethods to avoid remounting entire tables. An alternate way of updating a table is to update only
the attributeswithin the table using theUpdate Document Data feature. This feature is detailed in the next
section. Also, usersmay perform a direct data update on the table, which is detailed in the 'Direct Data Update'
section.

4. From the dropdown list in the lower left corner, select Frame Perspective orObject Perspective to change
how the list of update candidates is displayed. The previous screenshot in this topic shows how potential DB
updates look in the Frame Perspective, which identifies the frame(s) on the InDesign page that contain out-of-
date content. TheObject Perspective view lists the changes by object, as pictured in the following screenshot.
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5. Select theShow Object lists checkbox to split the dialog box into two areas, with the lower area showing
object lists. If repeated areas or template sections have a different object list, then items are shown in the object
list.

6. ClickOK to start the update process, orCancel to exit the dialog.

Updating by Type
You can selectively choose which elements on the page to update if you know that a certain category of data (such
as image references, attributes, tables, or commercial data values) have been changed in STEP and you want to
update your page to reflect those changes only. You can update either a small set of data, such as one individual
attribute, or you can update an entire group of attributes, images, tables, and so forth.

1. With the relevant InDesign page opened, navigate to STEP > Update Document Data .... TheDocument
Update dialog displays.

2. Check the relevant boxes on the right side of the dialog tomake updates to specific content only. Checking the
highest level will automatically select everything underneath. To select all boxes at once, check the Select /
Deselect All box. Note that boxeswill appear for all data categories whether or not they contain changed
content. The Document Update feature does not run a check on the page data first to see what needs
updating—the dialog simply provides a list of all data that can be updated.
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3. Check theUpdate Template Section box to compare the list of objects applicable to a template section to the
objectsmounted on the page (ignoring order). Additional objects are placed at the end of the list unless deleted
items are also found, in which case added items replace the deleted items until there are nomore deleted items
and the remaining items are then placed at the end of the list. When the Force Update checkbox is selected,
the template section is removed from the page and replaced with the original gap, etc. settings, causing the
objects to appear in the order of the database. This will refresh the selected sectionswith the current data that
is in the database.

4. Check theUpdate Repeat Area box to compare the list of objects applicable to a repeat area to the objects
mounted on the page (ignoring order). Additional objects are placed at the end of the list unless deleted items
are also found, in which case added items replace the deleted items until there are nomore deleted items and
the remaining items are then placed at the end of the list. When the Force Update checkbox is selected, the
repeat area is removed from the page and replaced with the original gap, etc. settings, causing the objects to
appear in the order of the database.

5. If a table is chosen for update, check theObtain values from transformed tables, preserve local table
styling and structure box in order to retain the existing table structure and only update the values. For
example, local stylingmight have been applied to the table on the InDesign page after its original mount, such
as the alteration of row / column sizes or the addition of color shading (either manually or through a previous
table transformation). Checking this box ensures that the table structure and formatting remain as-is and only
the values are updated. If the box is not checked, the entire table is re-sent from the database (force updated)
and any local updatesmade to the table are lost.

Note: If actual table structural changes have beenmade to the table in STEP, such as the addition or removal
of rows or columns, then the table will remount regardless of whether you have checked the 'Obtain values
from transformed tables' box.

An alternative way to avoid entire table remounts is to not update the table at all, but to instead update only the
attributeswithin the table (by checking a box for an attribute or attribute group in the Document Update dialog)
or by performing a direct data update on the table (detailed later in this topic in the 'Direct Data Update'
section).

6. Check the Force Update box to have all selected values re-sent fromSTEP and overwrite all associated local
changes on the InDesign page. If not selected, the content is only updated if the current value is different to the
value when it wasmounted. Choosing force update will completely re-push the information fromSTEP,
whether it is different to what is on the page or not. This option could cause amuch longer update time if there
is a large volume of data being updated since the system is re-pushing all data and not just data that has
changed.

7. Select theUpdate Attribute Groups checkbox to update the sequence and number of visible attributeswithin
a referenced attribute group.

8. ClickOK to update the document to match the content in STEP. ClickCancel to exit the dialog.

Direct Data Update
Data can be updated directly from the page—an attribute or a table at a time—using the direct data update
features in STEP'n'design, which are available through right-clickmenu options.
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Direct Data Update of Attribute Text
Two options are available for direct data updates of attributes:Update Page Selection and Force Update Page
Selection.

1. Place the cursor within the tagmarkers ([ ]) of the relevant element on the InDesign page, then right-click. (If
the tagmarkers are not visible, click View > Structure > Show Tag Markers.)

2. On the popupmenu that displays, the data update options appear toward the bottom. (Note that the entire
popupmenu is not displayed in the below screenshot.)

3. ChooseUpdate Page Section to update the attribute value if it is different in STEP sincemounted on the
page.

4. Choose Force Update Page Selection to force the attribute value to be updated. (This will update the value
whether or not it is different fromwhat is in STEP.)

Direct Data Update in Tables
Four options are available for direct data updates of tables:Update Table, Force Update Table,Update Table
Content, and Force Update Table Content.

1. Place the cursor anywhere within the relevant table and right-click.

2. On the popupmenu that displays, the table data update options appear toward the bottom: (Note that the
entire popupmenu is not displayed in the below screenshot.)
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3. ChooseUpdate Table to update the valueswithin the table that have changed since the table wasmounted.
4. Choose Force Update Table to completely remount the table, which will not only update the valueswithin the

table that have changed since the table wasmounted, but will update any structural changes and remove any
local formatting that was applied to the table since it was last mounted.

5. ChooseUpdate Table Content to update every attribute in the table if the table structurematches. The
update only takes place if the attribute value is different to that when it wasmounted.

l If both structural changes and changes to content have beenmade, then aSTEP Alert dialog box appears.
Otherwise, only the content is updated.

l ClickDB Attribute to update the content of the table. To update the structural changes aswell, clickDB
Table.

6. Choose Force Update Table Content to force update the table content with the current values fromSTEP.
This causes all values to be overwritten whether or not they are different than the values in STEP. This option
is useful for complex tables, such as tables that contain images.

l If both structural changes and changes to content have beenmade, then aSTEP Alert dialog box appears.
Otherwise, only the content is updated.
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l ClickDB Attribute to force update the content of the table. To force update the structural changes aswell,
clickDB Table.

Updating Documents From the Workbench
One advantage of using STEP to automate page building in InDesign is the ability to automatically update the
contents of previously built pageswithout having to rebuild them from scratch.

When pages are built (mounted) using STEP'n'design (or an associated STEP component such as AutoPage or
Flatplanner), content fromSTEP is placed onto the page. The placed content accurately reflects how the content
existed in STEP at that moment in time. If changes aremade later to the corresponding content in STEP (for
example, attributes values or referenced images), the pages become out of syncwith the latest content.

When this content mismatch occurs, there are several options available within STEP'n'design and STEP
Workbench for updating page contents. This topic describes how to use the update options available in STEP
Workbench. Methods for updating pages fromwithin InDesign are explained in theUpdating Documents From
InDesign topic.

Additionally, this topic only describes updatemethods that apply across all STEP Publisher licenses. For more
information on how to update pages using STEP AutoPage or STEP Flatplanner, see the following topics:

l Updating Documents in AutoPage in theSTEP AutoPage documentation
l Updating Documents in Flatplanner in theSTEP Flatplanner documentation

Note: Two important prerequisitesmust bemet before actual pages can be updated from the workbench:

l The pagesmust be saved into a publication in STEP

l Youmust have an Adobe InDesign server (IDS server) set up and integrated with your STEP application
server. The IDS server is what enables STEP to run bulk updates on the pageswithout requiring you to
open the pages from an InDesign client. Contact Stibo Systems for assistance if you do not have an
InDesign server.

Methods for Updating Documents from the Workbench
Mounted (actual) pages saved back to STEP can be updated from the workbench by the followingmethods for
users of any STEP Publisher license:Update andBulk Update. Bothmethodswork in a near-identical fashion,
butUpdate is the simplest. As such,Update is themethod detailed in this topic.

(Themethods are near-identical because the same dialog detailed in the next section of this topic can be accessed
from the Bulk Update wizard. For information on Bulk Update operations for STEP publication documents, see
Publishing Operations for Bulk Updates in theGetting Started / STEP User Guide documentation.)

Using the 'Update' Feature to Update Documents

1. Navigate to the relevant publication, section, or DTP document object in the Tree, then right-click and choose
Update....
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2. The 'Update contents of document(s)' dialog displays.

3. To update all contents on the pageswithout narrowing your selections (for example, to update all attributes, all
image references, and all tables at once), selectUpdate all contents of selection.

4. To narrow your selections and choose specific content areas to update, chooseUpdate only the following
items of the selection, then clickAdd. TheAdd Items dialog displays.
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5. Eight options are available from theSelect type of item(s) to add dropdown. Click 'Select' (pictured in the
below screenshot) to add the item types to the 'Update contents' dialog. The chosen options apply to all pages
in the selected publication / section / DTP document.

The options and their functionality are as follows:

l Image References:Updates all images. No additional options are available to narrow the selection down to
specific image reference types.

l Attributes: This option allows you to choose specific attributeswhose values should be updated. Only
individual attributes can be chosen, not attribute groups. However, attributesmay bemulti-selected by
holding Shift or Ctrl whenmaking your selections.

l Attribute Groups: Updates all attributes on all pages. No additional options are available to narrow the
selection down to specific attribute groups.

l Commercial Terms:Updates all values of the selected commercial terms lists.
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l Object Name:Updates the STEP names of all product objects, classification objects, attributes, and
publication section objects.

l Tables:Updates the values contained within all STEP tables.

l Table Types:Updates the values contained within all STEP tables of the selected table types.

l Export data:Updates valueswithin indexes built using AutoPage.

6. In addition to the dropdown options, a checkbox titledObtain values from transformed tables, preserve
local table styling and structure is available on the 'Update contents' dialog. This box is relevant for updates
in which STEP tables are updated, which is when 'Update all contents of selection' is chosen or when 'Update
only the following items of the selection' is chosen and either the 'Tables' or 'Table Types' option is selected
from the 'Add items' dropdown.

This box is checked by default. If left checked, only the valueswithin the tables will update and the tables
themselveswill not be remounted. If the box is unchecked, not only will the values be updated, but the tables
will remount and all local formatting, cell shading from table transformations, and so forth will be lost. In other
words, unticking the box causes a 'force update' on the tables.

7. Once your selections have beenmade, clickUpdate to start the update process. If you would like to remove
any of your selections before updating, highlight them in the dialog window and clickRemove (optionsmay be
multi-selected by holding Shift or Ctrl).

8. A background process is started that calls the InDesign server. The InDesign server then does the actual page
update. When completed, the InDesign server saves a new version of the paginated pages to STEP.
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Writing Data Back to STEP
This section describes how to write certain types of data from an InDesign page back to STEP without having to
launch the STEPWorkbench to first locate the product and attribute.

As the InDesign page is not really designed as a database front end, a range of restrictions apply to the writeback
function.

The restrictions are as follows:

l Youmust have the required user privileges to write data back to STEP, e.g. the ability to modify attribute values

l Data can never be written back to theApprovedworkspace
l Calculated attributes or attributes that have undergone a data transformation (for instance, in a table) cannot be
written back to STEP

l Invalid tags or special characters not defined in STEP cannot be written back

l Graphical formatting such as bold, italic, or underscoremight be written back to the database if youmanage the
styles carefully (that is, if this formatting is tied to InDesign character styles that have corresponding style tags in
STEP), but is not recommended

STEP’n’design supports two ways of writing data back from document to database:

l Writeback to DB: A general writeback option involving a dialog box that shows all items on the document that
can be written back. Users can choose which items should be written back.

l Write Page Selection back to DB: A direct writeback option where the specific element that you want to
write back to the database is chosen.

General Data Writeback: Writeback to DB
To perform a general STEP data writeback operation after you have changed some attribute text on the InDesign
page, follow these steps.

1. In the STEPmenu, clickWriteback to DB. TheWriteback to DB dialog box appears.
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2. From the list at the bottom of the dialog box, click either Frame Perspective orObject Perspective
depending on how you want your changes to be presented. The above screenshot shows the frame
perspective. The below shows object perspective.
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1. Select the relevant check boxes to the right for the data you want to write back to STEP.

2. Select / deselect theSelect / Deselect All checkbox if you want to allow selection / deselection of all items
within the tree. The checkbox indicates how many items have been selected, and the total amount of items.

3. SelectWrite inherited value to owner object if you are writing an attribute value back to STEP from a
mounted 'child' object in InDesign. Checking this boxwill write the locally updated attribute value back to the
owner (parent / grandparent) object.

4. In theWriteback workspace list, click the workspace you want to write back to. The list displays all created
workspaces. If not selecting a workspace, the default value isMain.

Note: It is extremely rare that an option other thanMain will be present, asmost systems only use theMain
and Approved workspaces. Approved will never be an option, as data cannot be written back to the Approved
workspace.
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5. ClickOK. The contents of your attribute on the InDesign page will now be written back to STEP, provided that
STEP allows it.

6. AWriteback to DB Results dialog box displays. If no errors have been encountered during the writeback
process, youmay clickOK to close the window. Users who do not have privileges tomake changes in STEP,
such as changing attribute values, may receive errors in theWriteback to DB Results dialog when
attempting a data writeback.

Additional issues that can cause data writeback to fail include:

l Read-only attributes, which cannot be updated

l Attribute validation base typemismatch. For example, an attribute with a number validation has an original
value of 112, but a user changes it to a text value (11-2). Another example is date attributes.

l Input mask on attributemismatch. For example, in STEP, an attribute has an input mask set to (00.00) but
an InDesign user attempts to write back a value of 11.222.

l List of valuesmismatch. If a user tries to update a value with an entry that is not in the list, then writebackwill
fail.

l Unit of measuremismatch. For example, an attribute uses cm as its unit but a user tries to update the value
to km.

l Inherited attribute values (see the 'Writeback Errors for Inherited Values' section below for more
information)

9. After the writeback operation has been performed, STEP will take a few seconds to update.

Direct Data Writeback
To perform a direct STEP database writeback operation after you have changed some attribute text on the
InDesign page, follow these steps.
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1. Place the text cursor within the item to be written back.

2. Right-click and selectWrite Page Selection back to DB, which appears near the bottom of the popupmenu.

Writeback Errors for Inherited Values
IfWrite inherited value to owner object is left unchecked in theWriteback to DB dialog box, even users with
Super User privileges—who are granted All Setup Actions and All User Actions—will receive a permission error in
theWriteback to DB Results dialog when attempting to locally update an inherited attribute value fromwithin
InDesign. This error occurs because inherited attribute valuesmay not be locally overwritten fromwithin InDesign
by anyone. Inherited attribute valuesmay only be locally overwritten in the workbench.

When this error appears, the value(s) contained in the error message have not written back to STEP at all. Thus,
the only option to update an inherited attribute value fromwithin InDesign is to write back to the owner object.

Considerations and Limitations for Writeback to Owner

l Writing a value back to an owner (parent / grandparent) object that exists in the Approved workspace will
cause this object to become unapproved. Users should take care to ensure that data writeback from
InDesign does not impact other processes (such asOutbound Integration Endpoints) that rely exclusively on
products in the Approved workspace.
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l A dialog containing theWrite inherited value to owner object checkboxwill not appear when writing data
back to STEP using theWrite Page Selection back to DB option. Users will only receive theWriteback
to DB Results dialog, containing the Permission error(s).

l ThePermission errorswarning is not associated with user privileges as defined underUsers & Groups
in SystemSetup. 'Permissions' here refers to core functionality of STEP'n'design itself, in which no users
have the authority to overwrite inherited values fromwithin InDesign.

Relinking Assets in STEP'n'design
Two functions exist within STEP'n'design to relink broken asset links (typically images) onmounted pages:Relink
Assets (which is run via the InDesign Client on an open document) andDocument-Asset Re-link (which is
launched in STEP and causes a background process to run).

Although the standard InDesign function of relinking assetsmay be done via the Links panel, that method can be
cumbersome because it requires users tomanually search for or navigate to image locations. If links are broken on
hundreds upon hundreds of pages, relinking assets by thismethod could become an extremely time-consuming
task. As such, thismethod is not recommended.

The STEP functions ofRelink Assets andDocument-Asset Re-link automate this taskwhen users are
connected to a shared image location.

About Broken Links
Image links become broken when a document contains images that are no longer linked to the original location of
the actual image files. Though images appear on the page, they are only screen-resolution renderings of the
original files. Broken links can occur if the original file has been deleted or moved to a different folder or server after
it was originally imported into the document. They can also occur if client machines are not connected to the
shared image drive in exactly the samemanner, or if users change themanner in which the shared drive is
connected from one day to the next.

When opening a document in InDesign that contains unlinked images, the following warning dialog displays:

Unlinked images display a red questionmark to indicate that InDesign can no longer locate the original image:
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The Links panel displays the same red questionmark for missing image links and aStatus of 'Missing.' The
displayedPath indicateswhere InDesign is expecting to find the image. This location is where the current user
must be connected in order for InDesign to find the image.

Common Causes of Broken Links for STEP'n'design Users

Missing Asset Location
One cause of broken linksmay be if there was noAsset Location set in the STEP > Preferences menu in
InDesign when the pageswere originallymounted (this refers to pages generated either manually or by creating a
document from a Flatplan). If no asset location is set here, images are downloaded directly fromSTEP into a 'tmp'
folder inside theProcess Folder (designated in the STEP Preferencesmenu, pictured below). Once the
InDesign client is closed, the tmp folder is emptied, causing broken links.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 382



For information on how to determine what file path to place into the Asset Location field, see the Linking to an
Asset Location documentation.

Changes to How the Shared Image Drive is Connected
Themost frequent cause of missing images is when themethod bywhich the shared drive is connected to the
client or the location of the InDesign server changes.

For example, broken links can be caused if users connect too far up or too far down in the shared image folder
structure. In the following screenshot, the correct image location is highlighted (the 'images' folder). A user who
connects to, for example, the 'assetpush' folder or the 'raw-approved' folder will experience broken links when
opening amounted page that contains images that are linked to the correct location ('images'), which is being used
by the InDesign server.
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OnWindowsmachines, the drive letter of themapped network drive that is used to connect to the asset location
can also cause broken links if other users are connecting to the asset location using a different drive letter. In the
below screenshots, an Asset Location of 'I:\' is being used. The top screenshot shows how the Asset Location
looks in the STEP Preferencesmenu. The bottom screenshot shows a sample, extended file path using the I
drive. If another user is connecting to the asset location using, say, drive A, then their links will be broken when
opening documents that use the 'drive I' file paths.

For information on how to connect to an Asset Location, see the Linking to an Asset Location topic.

Mixed Windows and Mac Platforms
Another—less frequent—cause of broken image links is when there is amix of PC andMac platforms being used
in the same STEP'n'design production environment. Thismix commonly involves one or both of the following:
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l An InDesign server is running on aWindows platformwhile end users are usingMac InDesign clients

l End users themselves are working on a combination of Mac and PC InDesign clients

Even though end users are accessing images from the same shared location as the InDesign server, the
differences betweenMac andWindows file path formats cause broken links. For example, when an InDesign
document is saved back into STEP from aMac, InDesign saves the image path in a 'Mac-like' format, as such:

Volumes:images:raw-main:std.lang.all:44:05:4405.tif

When an InDesign document is saved back into STEP from a PC, the same image path is in a 'PC-like' format:

E:\images\raw-main\std.lang.all\44\05\4405.tif

If aWindows user opens a document that was saved back to STEP from aMac, the imageswill not be found.
Likewise, if a document that was saved back to STEP from a PC (or was created by aWindows InDesign server
and saved to STEP) is opened from aMac, the imageswill not be found.

A 'standard' installation is when clients and the InDesign server are both on the same platform (either Windows or
Mac). In these cases, there is no conflict in Mac versus PC drive and path names.

Correcting Broken Links

Relinking Assets from InDesign
Missing assets can be relinked fromwithin InDesign by using theRelink Assets function. (An InDesign server is
not required to perform this action.) Provided that the Asset Location is set correctly and connection to the shared
drive (asset push images folder) is established, STEP'n'design will be able to locate the images and change the
path in the document so the images are no longer 'Missing' and their status in the Links panel reads 'OK.'

To relink assets on a page:

1. In InDesign, open theSTEP menu and selectRelink Assets.
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2. STEP automatically searches in the specified asset location andmatches the IDs of the images in the
document to those of the images in the asset location.

3. Once the relink is complete, an Adobe InDesign dialog appears that displays the number of assets that were
relinked.

If the relink fails, an error message displays to explain which images could not be relinked. 'ProblemAsset IDs'
may occur if an incorrect image path is specified in the Asset Location field in the STEP Preferencesmenu or if
there is no connection to the shared image drive.
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4. An unbroken link icon now appears on the relinked images, and their status shows as 'OK' in the InDesign
Links panel. In addition, the updated file path is now displayed.

Relinking Assets from STEP
A Document-Asset Re-link operation is performed fromwithin the STEPWorkbench and requires an InDesign
server.

Document Asset Re-link enables a one-click relinking of assets throughout an entire publication or section. As
mentioned in previous sections of this topic, image links can break onmounted pageswhen saved back to STEP
fromMac clients but are opened by an InDesign server that is running on aWindows platform. The broken links
become problematic when a user needs to perform an action on these document(s) within STEP that requires an
InDesign server, such as 'Generate PDF.'

In this scenario, if the saved documents contain Mac-style image paths (which cause broken links for theWindows
InDesign server), the Document-Asset Re-link function will correct all the links by locating the images and
converting the image paths toWindows-style paths.

As long as the dtp-server.properties file has the AssetPushRoot parameter set correctly and a connection to the
shared drive is established, the InDesign server will be able to open the InDesign documents that are in STEP,
locate the images, and change the path in the documents so that all images are no longer 'Missing.' The InDesign
documents are then saved back. Once completed, the InDesign server will be capable of, for example, generating
a PDF that contains high-resolution images using the 'Generate PDF' function.

To relink all assets in a publication or section:

1. In the workbench, navigate to the relevant publication or section, then right-click and selectDocument-Asset
Re-link.
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2. A background process launches. Click 'Go to process' to monitor the relink progress.

3. If the process is successful, a list of relinked asset IDs appears in the Execution report on the Background
Process tab. If unsuccessful, error messageswill appear to indicate the problem.

Space Usage in STEP
When an InDesign document is saved back to the database, STEP calculates the space usage for each object
mounted on the page. Calculation of space usage is important to merchandisers and catalog coordinators, as it
makes it possible to determine if a product has enough space on the page to increase sales. This topic provides an
overview of where space usage data can be located in STEP and how STEP calculates space usage on pages.

Space usage can be viewed in the following locations in STEP:
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l Under the 'Products' flipper on thePage data tab when viewing DTP documents

l Under the 'Used on Page' flipper on theReferenced By tab for product, asset, and classification objects
l On the Financial Summary tab and within the Financial Report (Flatplanner publications only)

Note: By default, space usage in STEP is calculated inmillimeters (mm). To change themeasurements to
another unit (such as inches), contact your Stibo Systems account manager.

Locations of Space Usage Data in STEP

Page Data Tab
ThePage data tab contains space usage information about objectsmounted on InDesign pages, from a page
perspective. In the below example, space usage is displayed for three product objects on a single InDesign page.
To view page data:

1. In the Tree, navigate to a publication section that containsmounted pages, then expand theDTP Documents
node.

2. Expand the InDesign file (in the below example, 'Party Hats'), then click on one of the individual InDesign
pages contained within the file.

3. Select the Page data tab (if not automatically directed when selecting the DTP page), then expand the
Products flipper. Space usage for mounted classification objects can be viewed by expanding the
Classifications flipper.

4. Space usage is located in theSpace Used column.
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Referenced By Tab
TheReferenced By tab contains space usage information about objectsmounted on InDesign pages, from an
object perspective. Space usage data for mounted objects is located under theUsed on Page flipper. This flipper
is available for product, classification, and asset objects. In the below example, the '1st BirthdayGirl Cake Kit'
product is shown to bemounted on three different InDesign pages stored in STEP. The space usage data is
available in theArea Used column.

Financial Summary and Financial Report
Space usage for mounted objects in Flatplanner publications can be viewed on the Financial Summary tab for
publication and section objects and within the Financial Report Excel sheet that can be pulled from a publication
or section.

For more information, see theSpace Usage in Financial Reports topic in the Flatplanner documentation.

How STEP Calculates Space Usage
The standard space usage setup calculates the space usage for a product presentation based on the raw data on
a page. It does not include the white space of the product presentation in the calculation. For example, if you
increase the font size of a product title, the space usage increases. However, if you increase the size of a frame
without increasing the size of the content of the space, the space usage does not increase.

Alternatively, you can configure STEP to calculate both the elements of the product presentation aswell as the
white space surrounding the elements. This is achieved by configuring the 'Enable calculation of border rectangle
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space usage for actual pages' system setting, which is located under Users & Groups > SystemSettings > DTP
Settings.

'Enable calculation of border rectangle space usage for actual pages' tells the systemwhether to calculate the
space that is taken up by each individual mounted element (product, classification, or asset object) on the page, or
if the white space surrounding these elements should also be calculated.

When 'Enable calculation of border rectangle space usage for actual pages' is set toY, the system draws an
imaginary bounding box (border rectangle) around all of the elements and takes the total area from that bounding
box’s width and height, including white space.

The above example shows the difference between the twomethods of measuring space usage. On the left, each
of the four elements’ individual areaswill be used to create the total space usage. On the right, the bounding box is
the smallest box that could be drawn to encompass all the individual elements. It is the area of this imaginary box
that shows as the space usage.

If 'Enable calculation of border rectangle space usage for actual pages' is set toN, the space calculation includes
the total area of the individual elements only and does not include white space.

Note: This setting is global for all publications and the decision to set it to Y or N should bemade before building a
publication. Changing the setting during production could cause space usage to be calculated differently on
different pages.

STEP'n'design XML Hierarchy and Attributes
This topic provides a listing of the XML hierarchy elements and XML attributes that appear on product templates
and in the XMLStructure view onmounted InDesign pages. Common XML elements include STEPPLACE,
STEPREF, and STEPTABLE. Common XML attributes include A (Attribute), DB / DA (Delete Before / Delete

© Stibo Systems - Confidential - STEP Trailblazer 8.2 391



After), andO (Object ID). The below screenshots show the XMLStructure (left) and a sample product template
(right).

The following tables contain a full listing of STEP'n'design XML hierarchy elements and XML attributes. For more
information on these elements / attributes and for detailed information on the STEP'n'design scripting API, see the
STEP'n'design Scripting API Guide in theSTEP API documentation.

XML Hierarchy Elements

Element Description

STEPPLACE The STEPPLACEelement is created when products aremounted using a template (which includeseach cell of a Flatplanmount).
The children of the element are the itemsmounted.
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Element Description

STEPREF The STEPREF element marks itemson the page that correspond to an attribute value in the database. Applied to a range of text or
a cell in a table.

STEPTABLE The STEPTABLEelement marksplaceson the page that correspond to a table in the database. This is normally an InDesign table,
but can be a range of text in a text frame if the table is referenced but isn’t defined for the object and the reference hasdelete
before/after/fail text applied.

STEPREPEAT The STEPREPEAT element marks the range of text produced asa result of a repeat setting from the template.

STEPOBJ The STEPOBJelement marks the range of text produced for each object within a STEPREPEAT element.

STEPCOND The STEPCOND element marks the range of text (including other STEP tag types) onto which a condition (delete before / delete
after / fail text) hasbeen applied.

STEPGROUP The STEPGROUPelement marks the range of text (including STEPAGOBJ tag types) that correspond to an attribute group.

STEPAGOBJ The STEPAGOBJelement marks the range of text (including STEPREF tag types) that correspond to an attribute within the
attribute group.

XML Attribute Descriptions

Attribute Definition Description

A Attribute The ID of the attribute linked to the element.

AG Attribute Group The ID of the attribute group.

AI Above Inset The default Above Inset setting for line styles.

AMB AlignMount
Bottom

Whether themount wasaligned to the bottom or not.

AMO AutoPage
Mount Object
ID

If the object wasmounted using AutoPage then this is the ID of the object.

AMOT AutoPage
Mount Object
Type ID

If the object wasmounted using AutoPage then this is the ID of the object type.

AMS Asset Max
Scale

Themaxscale setting for the asset mount. As set through the template palette.
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Attribute Definition Description

AR Attribute
Reference ID

If the attribute is an attribute of a reference, this is the reference ID.

AS Asset Scale As set through the template palette.

ASO Asset Size
Option

Asset through the template palette.

BI Below Inset The default Below Inset setting for line styles.

C Context The ID of the context applied from the database. This is amanually applied ‘override’ context.

CB Cell Bottom The bottom coordinate of the cell (to the nearest mm) on the plan for which the product wasmounted.

CELLORIGINS CellOrigins Contains the STEPPAGEDATAdetailing the cell origins of a cell in a table.

CID Cell ID The ID of the cell on the plan for which the product wasmounted.

CL Cell Left The left coordinate of the cell (to the nearest mm) on the plan for which the product wasmounted.

COL Color The Color attribute for line styles.

CR CellRight The right coordinate of the cell (to the nearest mm) on the plan for which the product wasmounted.

CS Can Split As set through the template palette.

CT Cell Top The top coordinate of the cell (to the nearest mm) on the plan for which the product wasmounted.

Ct Color Tint The Color Tint setting for line styles.

D Delete No
Content

Indicates that the frame from a template should be deleted if it hasno resolved STEP content whenmounted
(as set through the template palette).

DA Delete After The (integer) number of characters to delete after element if no database content is found.

DB Delete Before The (integer) number of characters to delete before element if no database content is found.

DELT Deleted Text When an attribute reference hasbeen hidden from the user asa result of a delete before/after condition with no
resolved content, the text deleted from the page is recorded in the Deleted Text attribute.

DS Data Source The data source as set through the template palette.
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Attribute Definition Description

DV Drop Version The list of versionsapplied when objects are dragged onto the document from the structure view.

DL Data Level Records the set of information the user last requested to be saved to STEP from the document (1 =Product
Template, 2 =Page information, 3 =Document and Page information, 4 =Page Template, 5 =Author
Template, and 6 =Master Document).

ELS Even Line Style The style name to apply to even lines in a repeat area.

FH Fit Height to
Content

As set through the template palette.

FID Frame ID Asset through the template palette.

FO FrameOrder As set through the template palette.

FT Frame Type Asset through the template palette: 1 =Static, 2

=GalleyText, 3 =KeyLetter, 4 = Image, 5 =Module, 6 =Text, and 7 =Object.

GA Group Align Asset through the template palette

GAP Gap Asset through the template palette, the gap between template section items.

Gc GapColor TheGapColor settings for line styles.

Gt Gap Tint TheGap Tint settings for line styles.

IA Image
Alignment

As set through the template palette. Valid valuesare 0 = Left Align, 1 =Centre Align, and 2 =Right Align.

IL Is Locked Whether the item is locked or not. Currently not used.

KWN KeepWith Next As set through the template palette.

L1S LineOne Style The style name to apply to the first line of a repeat area.

LI Left Inset The default left Inset setting for line styles.

LLES Last Line Even
Style

The style name to apply to the last line of a repeat area if the last line is an even line.

LLOS Last Line Odd
Style

The style name to apply to the last line of a repeat area if the last line is an odd line.
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Attribute Definition Description

LS Line Styles An XML formatted string with the line styles defined in the document. The XML format is the "IN" element
defined in STEPDOCDATA.

LT Line Type The Line Type setting for line styles.

MAA Multi Across Asset through the template palette.

MAX MaxDistance Asset through the template palette, themaximum distance for a template section before starting another row /
column.

MC Master Version
Context

The context assigned to the version.

MO Master Version
ID

The version ID linked to the frame.

MT Mount Type Linked to the T attribute, shows the type of item recorded in the T attribute (1 =Template name, 2 = template
database object id, 3 = layout database object id).

NA Name TheName setting for line styles.

NF Source Node
Filter

The data filter as specified on the template palette.

NID Note ID Record of the database ID applicable to a Note frame.

NS Nth in Section For AutoPage items, this is the nth object within the publication section.

Nth Nth For objectswith multiple asset referencesof a type, which of the ‘n’ applies to this frame.

O Object ID The ID of the object linked to the element.

OLS Odd Line Style The style name to apply to odd lines in a repeat area.

OT Object Type ID The ID of the object type linked to the element.

OW Override
Workspace

The ID of the workspace that should be used instead of the version workspace.

PL PlanObject ID The object ID of the plan fromwhich the object wasmounted.

PN Commercial
Term (Price)
n’th Value

Allowsselection of which particular term frommultiple in a commercial list for the object that is used; 1 is the first,
2 second, etc.
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Attribute Definition Description

PO Parent Object The ID of the parent object in the database for documents that have been saved to STEP.

POT Parent Object
Type

The object type of the parent object in the database for documents that have been saved to STEP.

PS Plugin State Stores the plugin state for a tablemounted using the tablemount plugin.

PV Placed Value A record of the database value placed by the element. Used during update, etc., to check if the database value
has changed.

RA Require All As set through the template palette.

RI Right Inset The default Right Inset setting for line styles.

RO Reference
Object

The object ID targeted by the asset reference type from the object.

ROT Reference 
Object Type

The object type ID targeted by the asset reference type from the object.

RS Repeat
Separator

The string to use when separatingmultiple values (either a repeat area or amulti-value attribute).

RT CELLREF
Reference
Type

The reference type in a cell. Valuesare 0 (Unspecified type), 1 (Attribute Value), 2 (Asset Reference), 3 (Node
Reference), 4 (CommercialData).

RTL Right to Left Specifieswhether the data should bemounted right to left instead of the default left to right.

RV Reference
Object Revision

The revision targeted by the asset reference type from the object.

S Section ID For AutoPage items, the publication section that thismount is part of.

SI Section Index Records the next section index to be assigned to template sectionswhenmounting from a template that uses
them.

SID Section ID Record of which template section this frame applies to.

SR Source
Reference

The ID of the reference type applied to the element (i.e. for the applied ‘object’, locate the target of its ‘source
reference’ and resolve its ‘attribute’).

T Mount
Template /
Layout

The object ID or template name that wasused to generate the frames, etc., that make up themounted product
presentation.
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Attribute Definition Description

Tah TemplateMax
Height

Specifies theMaxHeight of the Product Template.

Taw TemplateMax
Width

Specifies theMaxWidth of the Product Template.

TF Fail Text The string to use if no database content is found (overridesdelete before/after).

TFM Transformation Asset through the template palette.

Tih TemplateMin
Height

Specifies theMin Height of the Product Template.

Tiw TemplateMin
Width

Specifies theMinWidth of the Product Template.

TN Transformation
Name

The transformation applied to the attribute.

TO Target Object For attributesof references, the target object ID of the object that is being referenced.

TOT Target Object
Type

For attributesof references, the target object type of the object that is being referenced.

TP Commercial
Term (Price)
Property

Allowsselection of which particular commercial term property.

TT Table Type The ID of the table.

V Version ID The ID of themaster versionmounted on this document.

VC Version
Context

The ID of the context applied to the version in the database.

VM ValueMode The valuemode of the attribute.

VO Version Object The ID of the version object applied from the database.

W Workspace ID The ID of the workspace applied from the database.

WT Weight TheWeight setting for line styles.
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Attribute Definition Description

X XCoordinate The X coordinate that the itemwasmounted at.

Xd XDelta The distance from the left margin of the template to the left-most frame on the template when the product was
mounted.

Y YCoordinate The Y coordinate that the itemwasmounted at.

Yd YDelta The distance from the topmargin of the template to the top-most frame on the template when the product was
mounted.

Organizing Publication Sections in STEP
Sections and subsections in publications can bemanually organized in the Tree through simple drag-and-drop
operations as long as the following object types are set toManually Sorted = Yes:

l Publication Group (typically, the object type with the STEP ID 'Publication group root')

l Publication (typically, the object type with the STEP ID 'Default publication type')

l Section (typically, the object type with the STEP ID 'Section')

Subsectionsmay be dragged and dropped out of their parent sections and promoted to higher-level subsections
or top-level sections. Likewise, sectionsmay be dragged and dropped into other sections, enabling the 'demotion'
of sections to subsections.

This functionality simplifies themaintenance of more complex publicationswheremultiple levels of organization
are needed.
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The following screenshots shows a 'before' and 'after' example of sections and subsections rearranged in the Tree
through drag and drop. The 'before' image (left screenshot below) shows two top-level sections ('Safety' and
'Safety Equipment') with three subsections below the 'Safety Equipment' section. The 'after' image (right
screenshot below) shows an updated order, with 'Safety' as the parent section andmultiple levels of subsections
beneath.

Note: Sectionsmay still be rearranged by drag and drop in the Tree ifManually Sorted is set toNo on
publication group, publication, and section objects, but the sectionswill automatically arrange themselves in
alphabetical order.

Templates (Publication, Product, and Page) may also bemanually sorted in the Tree ifManually Sorted is set to
Yes on the publication group object type. See theSorting Templates in STEP section of the STEP'n'Design
documentation for more information.

For more information about object type sorting in STEP, see theManually Sorted section of theSystem Setup /
Super User Guide documentation.

InDesign Queues
Multiple InDesign queuesmay be created in STEP in order to sequence and prioritize jobs that are sent from
STEP to an InDesign server, such as autopagination and proof view requests. InDesign queues allow jobs to be
queued in the STEP server instead of within the InDesign server, allowingmore control and prioritization of job
requests. Such prioritization can ensure that foreground tasks (smaller tasks that do not use a background
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process, such as product proof views and Flatplanner page previews) are handled before background tasks
(larger tasks that use background processes, such as autopagination) so users do not have to wait for a large job
to finish before starting another.

Note: InDesign queues are not relevant unless your STEP system is linked to at least one InDesign server
sidecar. For more information on deploying an InDesign server sidecar, contact Stibo Systems.

Use cases for needing different InDesign queues include:

1. Your creative department may be international. In this case, users in one country will use one queue, and users
in another country will use a different queue. Users in each country will then have their own set of InDesign
server resources and will not be 'delayed' if users in the other country are sending large jobs to the InDesign
server (such as the autopagination of a publication with hundreds of pages).

2. Your creative department may have a temporary need to runmultiple versions of InDesign. In this case, for
example, you would use one queue for InDesign CS6 and another for InDesign CC. By allocating a publication
to the CS6 queue, you will ensure that all of its documents use CS6, which will help control the ability to
transition from one version to another.

Setting up the InDesign Queue
InDesign queues in STEP are created under SystemSetup > InDesign Queue.

In the above screenshot, the last two columns display the InDesign server renderers that are running, the port
numbers to which they are connected (for example, 10090), and the version of InDesign they are running (for
example, CS6).

Queues designated as 'default' (for example, Default Queue (CS6)) are created automatically for any InDesign
server renderers that are not assigned to a user-defined queue. A system-generated 'default' queue, however, is
not necessarily the 'main' queue. Themain queue is used when a specific queue has not been assigned to the
publication fromwhich you are generating pages. Any queue can be selected as themain queue, depending on
your business needs. There is no limit to the number of InDesign queues that can be created.
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Note: The initial connection of InDesign servers to your STEP systemmust be performed by Stibo Systems.
However, once the servers are connected, end usersmay create InDesign queues to prioritize the order in which
pagination and proof view jobs are sent to these servers.

To create a new InDesign queue, follow these steps:

1. On the SystemSetup tab, navigate to InDesign Queue.
2. On the InDesignQueue tab, expand DTP Queue Definition, then click 'Manage the queues' to display theDTP

Queue Editor.

3. In the DTP Queue Editor dialog, click 'Add New Queue.'

4. In the UniqueQueue Name dialog, enter a name for the queue, then clickOK.
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5. In theReserved for Foreground column, enter a number to designate the number or renderers that should
be reserved for foreground tasks, which are smaller tasks that do not use a background process (for example,
product proof views and Flatplanner page previews). For a server with two renderers, for example, the number
1 would be entered to ensure that one of the two renderers is always reserved for foreground tasks. (Note that
a queue cannot consist solely of foreground renderers.)

By default, all new queues are set to 0. Leaving a value of 0means that a foreground taskmay have to wait
until a renderer has finished processing a background task before the foreground task can complete. (If a
background and foreground task are both waiting for a free renderer, the foreground task always get the first
free one. However, not reserving a renderer for foreground tasksmeans that the possibility exists for all
renderers to be busywith background tasks, causing a wait for a foreground task.)

6. To designate a queue as the 'main' queue, select the radio button underMain Queue for that queue.When
designating a queue asmain, at least one server renderer must be assigned to it. Not assigning at least one
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server renderer will result in a configuration error and the changes cannot be saved, as illustrated by the red 'X'
displayed in the Config column in the following screenshot.

7. ClickOK to complete the queue setup.

Queue Operation

Prioritization
Foreground tasks are given higher priority over background tasks—otherwise the oldest task has higher priority.

Parallel Processing
Some background jobs are able to run in parallel—for example, generating a PDF of a large publication section
can retrievemultiple documents in parallel and stitch them into a single PDF as each document is returned.

Queue Status
When requests are sent to the queues, the InDesignQueue screen displays the jobs in progress for each queue.
The following screenshot shows an autopagination task that is being handled by the 'Default Queue (cs6)' queue.
To view the associated background process as the task is in progress, click on the Background Process button.
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InDesign Renderer Background Processes and Logging
Background processes for jobs sent to the InDesign server appear in theAutopage Batch Service queues on
the BGProcesses tab. The Execution Report for these processes displays the IP address of the InDesign server
and the port number of the renderer that is processing the job.

For more information on background processes, see theBackground Process Queues section of theSystem
Setup / Super User Guide documentation.

Each time a job is sent to an InDesign renderer, log files are generated and stored on the InDesign server in a
'logs' folder for that renderer. The below screenshot shows a standard 'logs' location on aWindows-based
InDesign server (for example, E:\step\stepindesign.sidecar\indesign-10091\logs). However, you do not need to
log in to the IDS to view and/or download these logs, as they are easily accessed from the IDS Logging tab in the
Admin Portal. For more information, see the IDS Logging topic in theAdministration Portal documentation.
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Assigning Queues to Publications
Publications and publication groups can be set to use a particular queue via theDTP Queue list, which, for
publications is located on thePublication tab and for publication groups is located on thePublication Group
tab. If only one queue exists, or if no queue is specified on the publication or publication group, the queue
designated as theMain Queue in the DTP Queue Editor will be used.

Queues set at the publication group level will inherit to all publications inside the group. This selection can be
overridden at the individual publication level by selecting a different DTP queue for the publication, or by selecting
no queue at all, in which case themain queue will be used for that publication.
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The publications assigned to each queue are displayed on thePublications tab in the InDesignQueue editor:

Configuring InDesign Server Instances
InDesign server instances are controlled via the sidecar, which uses the following information from the
sharedconfig.properties file on the STEP application server. (Note that these settings are typically configured by
Stibo technical support rather than super users or system administrators.)

1. Space-separated list of hosts running InDesign servers.Example: InDesign.Instances=ids_host1 ids_host2

2. The number of instances (renderers) to create on each host.Example: InDesign.Renderers=3

3. The version of InDesign.Example: InDesign.Version=cs6

4. The port number for the first instance.Example: InDesign.Port=12222
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5. Overrides of the above settings for individual sidecars.Examples: InDesign. ids_host2.Port=9090; InDesign.
ids_host2.Version=cs6

The following screenshot shows a sample configuration for aWindows- based InDesign server instance:
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